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Chapter 1 – Course Introduction 

Video: Welcome and Overview 

Cindy: Hi there. Welcome to PowerPoint 2016. My name is Cindy and I’m going to help walk 

you through these series of videos on PowerPoint. Now this is going to be the new version, 

version 2016. So if you’ve used PowerPoint before you might see some things that are a little 

different and I’ll just point those out as we go along.  

So we’re not going to start above anyone’s head. I want you to know that we’re going to start at 

the very beginning and we’re going to go through the screen and get you familiar with things 

before we actually get started. We’re going to take it all the way through the end so hopefully 

you’ll learn a lot when you go through these series of videos. Make sure you take them one at a 

time because if you don’t take them in order you might get a little confused. 

Let me give you some high level topics that we’re going to be covering and obviously a lot more 

than just this. 

So here’s what I want to expect from going through this course. We’re going to start off by 

creating a presentation. Now each file that you create in PowerPoint is called a Presentation. I 

want to show you how to start from the very beginning because a lot of times I work with 

students who work with PowerPoint but it’s a presentation someone else created and they’re just 

kind of editing slides. But I want you to know how to do this from scratch. 

We’re going to look at some slide best practices. Those are going to be things like what size 

should the text be, how many bullets should I have, so a lot of things like that that you want to 

make sure you use consistently throughout your presentation. 

We’ll be adding and editing a lot of slides as we go through and here’s where it’s going to get 

fun. When we start working with the graphics and the animation and the video it’s really a lot of 

fun to do these type of things. So I’m going to show you all kinds of cool things with this.  

We’re going to wrap it up at the end by showing you how to actually present your presentation to 

your audience. So if you’re giving that sales pitch or you’re actually presenting at this particular 

meeting you want to make sure yours looks very professional and you know what you’re doing. 

So at this point let’s go ahead and get started. Why don’t you go ahead and head over to the next 

video and I will see you there. 
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Video: New Features in PowerPoint 2016 

Cindy: Hey there. This is Cindy again. We’re just getting started with PowerPoint 2016. And 

before we actually start getting into these videos I wanted to go over some of the new features 

that you’re going to find in the PowerPoint 2016 version.  

Now some of these are available only in Office 365. If you’re not familiar with what that is 

Microsoft has an online version of Microsoft Office basically called Office 365. You do have to 

subscribe to it. But what you’ll get is a scaled down version of all the Microsoft Office products. 

So as we go through here I’ll point out some that are new just to the 365 versus the 2016. So let’s 

go ahead and get started here. 

So the first thing I want to go ahead and show you are the new Office Themes. Now you might 

have noticed that in prior versions of Microsoft Office it was kind of hard to read everything up 

at the top because it was a very light color. And sometimes you would even see your desktop 

icons through your title bar here because the color was so light. So let me show you what the 

new options are and how to change those. 

So all you’re going to do is you’re going to go to the File Tab, you’re going to go down to 

Account and currently I’m using a theme called Colorful. But notice I can now use dark gray, 

white or colorful again. And I’m going to stick with colorful. But that’s where you go to change 

those Office themes. 

Now I’m going to go ahead and go back and I wanted to just show you that the Office 365 

actually has one more theme that’s very vibrant as far as the colors are concerned because it has 

a dark black background like you’ll see here. So that’s pretty cool but that’s just in the 365. 

Okay next thing over here are your Ink Annotations. This is something again that’s only 

available if you have a touchscreen. So what they’ve done is on touchscreen enabled devices 

you’re going to see this Draw Tab on the Ribbon now and you’re going to see it in Word, Excel 

and PowerPoint. And you’re going to be able to select different inking styles, start making ink 

annotations directly into your files. You can also in PowerPoint convert those ink drawings to 

shapes. And you would do that just by selecting them and selecting the Convert to Shape option. 

So it’s pretty cool how that works as well. 

Now let me go over to the next one here which is the fact that there are some new design themes 

and variants. Now let me show you what I’m talking about here.  

If I go up under the Design Tab these are the Design Themes. And if I click the down arrow here 

to scroll you’ll see there are quite a few that I can pick from. So a lot of different ones than they 

had in previous versions. Also now you have different variants. So whichever theme you happen 

to be working with you can also now pick different variants which allow you to change the 
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colors, the fonts, background styles, special effects. You can kind of see the list here. So that’s 

fairly new where they have a lot more of those that you’re going to be able to pick from. 

Okay the next one down that I want to mention is a feature called Tell Me which is actually 

available in all of the Microsoft Office products. So here’s how Tell Me works. 

No matter which tab you happen to be on you’re going to see right here it says Tell me what you 

want me to do. And I can type anything I want here. So let’s say that I want to know how to 

print. So if I type Print here it’s going to give me some options as far as Print is concerned. And 

if I want to just print I choose the option or if I wanted to look at the options I click on Options. 

But I can get to everything right from here. Instead of me trying to figure out which tab to click 

on and how to get to Print I can do it right from here. So that’s pretty cool how that works. 

As far as charts are concerned you have six new chart types. Now you can see them here but I’m 

going to give you a bigger visual of this. If I go up to Insert and I say that I want to put in a chart 

right here, here you’re going to see all your different Chart options. Now from Tree Map down 

to Waterfall these are the new ones that you’re going to see. So you’re going to see that there is 

in Histogram there’s a new one within there. That’s why I say there are six. But those are the 

new ones you have available to pick from now. So that’s kind of cool when you start playing 

with those. 

Alright let me close that out.  

Ink equations. So this is fairly new. You have the ability to actually turn your mouse into a pen 

and write some math equations here. And when you do this it’ll actually convert your math 

equations for you. Where you would find these is when you go to the Insert Tab you’re going to 

see way over here it says Equation and this is where you’re going to be able to actually set up 

those equations. So like I said, if you write them in here, especially if you have like a touch 

screen for example, then you’re going to be able to use that stylus to write those math equations 

and it will convert them to text or a math or whatever it needs to do here. So that’s pretty cool as 

well. 

Okay a couple more things here. You have Screen Recording which is new. So you’ll notice that 

under the Insert Tab here’s your Screen Recording. So you’ll see it right over here. And basically 

what it does is it’s going to record the screen and the audio, anything like that related to your 

presentation. So a lot of times nowadays to record, like this video I’m recording right now, I’m 

using a different software to do that in. But I can do some basic things now in PowerPoint with 

that feature. 

Okay there’s also a new Format Options Pane. Basically if you have a graphic or a picture or 

some sort of object in your presentation you’re going to see on the right this new what they call 

Options Pane appear. So it’s going to have several different options on it. You’re going to be 
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able to click from different formatting options and so forth here. So we’ll be going through a lot 

of that as we go through as well. 

They’ve also redesigned the Animation Pane. So when you work with the Animation, this is the 

Animation Pane over here on the right. They’ve actually added some new options to this. So as 

you’re going through and you click on different animated effects you’ll see those options down 

here at the bottom and you can choose different things a little bit easier than you could 

previously. 

Okay a couple more quick things here. I did want to show you the new PowerPoint Designer. 

This is only available in Office 365. Sorry guys because this is a really cool little feature. What 

basically happens here is let’s say you’ve gone ahead and setup a design and you’ve kind of 

setup your presentation then it will actually give you some design ideas over here. So it’s pretty 

cool how you can see like this one, flip the picture and put it on the background. So a lot of neat 

things like that. But again not available for us for the desktop version. 

And the last thing I’m going to mention is they have a new improved Presenter View. So when 

you’re actually running through your slideshow that’s now called the Presenter View and there’s 

several different things you can do in this screen. So it looks totally different. You can see your 

speaker notes, you can see the upcoming slides, all of your slides down here at the bottom like 

this. So we’ll actually be spending time on that as well as we go through here. 

So quite a few new things they’ve got in 2016 and I think you’re really going to like it a lot. So 

why don’t we go ahead and wrap up this video and we’re going to go ahead and go over to the 

next section. I will see you shortly. 
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Video: New Features in PowerPoint 2016 for MAC 

Cindy: Okay so we’re working in module one and this is section three where we’re going to talk 

briefly about some of the new features they’ve designed for the PowerPoint 2016 for MAC. Now 

in section two we talked about new features that were pertinent to PC. There’s a couple of 

features that are pertinent to both and I’ll show you a couple as we go along here but let’s go 

ahead and dive in and see what they’ve got new for MAC. 

Okay so the first thing is what they call Theme Variants. Now let me go ahead and zoon in a 

little bit so you can see this. What you’re going to notice is that when you click the Design Tab 

you’ve got these different designs you’re going to be able to pick from. And if you’ve chosen 

those different designs you’ve got different variants you can pick from as well.  

So let’s say you like this particular theme and it has a yellow background. Notice that I can keep 

the theme but I can have a blue background, a kind of tan or brown one right here and a green 

one. There’s also other color options or font options or background styles you can pick from as 

well. So that’s kind of neat that you can start with a design and kind of edit it a little bit. 

Alright let’s see. Let’s go on to the next one which is a new Format Options Pane. Now here’s 

what this is. Over on the right here you’re going to notice that you now have a whole pane like 

we’ve always had on PC for formatting objects. So when you’re clicked on a particular object in 

your slide you can now change the color, the size, if you want a glow, soft edges, all those really 

cool things we’ve been able to do the PC for a while you’ve now got a pane that you can work 

with that shows up right next to your slide. So that’s kind of cool how that works. 

Alright next we have the redesigned Animation Pane. So if you’ve decided to work with some 

different animations here then you’re going to be able to pick some of the more advanced options 

for that particular animated option you chose. So this is the Animation Pane over here and you 

can see that we can actually go through and whatever object I have selected I can see the 

corresponding animation options over on the right. So if it’s number one here then I can come 

over here and click on number one and see the different options for that one as well.  

Okay the new Comments Pane. That’s going to show up here on the right. Now gone are the 

days when if you wanted to comment you placed a bubble inside your slide and you pointed to 

the particular object you want to make a comment on. Now that you have the collaboration that’s 

available in Office 2016 and some of the previous versions if two of you happen to be working 

on a shared file you can actually be talking to each other and making comments at the same time. 

So you’ll see on the Comments Pane over here that when I zoom in a little bit you can see 

comments here for the two different people that are working on the file and you can type your 

comment right down here as well and see live all the comments that are being made. And that’s 

really cool how that works. 
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Alright they’ve got a new and improved Presenter View. And we’ve got this in the PC version as 

well. So you’re going to see that when we click to run a slideshow and look at Presenters View 

we’re going to be able to see the slide we’re on here and there’s easy ways to move back and 

forth between our slides. We’re going to see the speaker notes over on the right and down at the 

bottom we’re going to see what slides upcoming or which ones we’ve just seen. So this is really 

a big improvement when you’re looking at the Presenter View. And that’s something else we’ll 

be spending time on a little bit later. 

So that’s kind of some of the new things they’ve got for the MAC version. Let’s go ahead and 

head into section two now and I want to really get started with PowerPoint, go through an 

existing presentation just to show you how it works and then we’ll create one from scratch. So I 

will see you over in module two. 
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Chapter 2 – Overview 

Video: Navigate a PowerPoint Presentation 

Cindy: Alright. So welcome to module two which is the overview module and we’re in section 

one. I want to start off talking to you a little bit about how to actually navigate through an 

existing PowerPoint presentation. 

So you’ll notice I’ve actually pulled one up here and we’re going to go through the screen and all 

that stuff a little bit later. So for right now just kind of notice that I’m working in a view in which 

I see several things at once. I see the slide here. I see a mini copy of the slides over here. But 

what I want to do right now is actually run through what we call running the slideshow. This is 

what your audience would see if you were actually presenting because you really don’t want 

your audience to see this view. Okay?  

So you can do this a couple of ways. First of all notice there is a tab called Slide Show at the top. 

And you can run your slideshow from the beginning of the presentation, the slide you’re on 

which is the current slide. Also I want you to kind of notice that in the olden days we had to 

actually use these buttons way down here at the bottom. These are your different views as well. 

This last one is Slideshow. So that’s the same thing as clicking on one of these two here.  

Now I’m just going to click on From the beginning. Now this is one of the features that I 

mentioned they’ve really, really changed a lot because in the older versions you’ll be launched 

right into just what the audience would see. Here you have some choices that you can work with. 

And one of the things I’m going to do is I’m using a dual monitor system. I know you can’t see 

the one over on the right but let me go ahead and choose Display Settings and I’m going to swap 

the different views here and this is really what running the slideshow looks like. 

Alright so this is what you’d want the audience to see. Now a couple things as we go through 

here. I want to actually present this in a way that I can tell you some of the things we’re going to 

be doing as we go through these different videos. And right now we happen to be on what we 

call the title slide. Now if you think about it a book always has a cover. Right? So your 

PowerPoint presentation should always have a title slide or a cover as well. And that’s what this 

is. It introduces your topic. You can see a title slide has a title and it can also have a subtitle. You 

don’t have to have the subtitle but they do in this particular case. 

Now notice as we go through the presentation some consistency with colors. So you’re not going 

to see pink on one, green on another and red on another. It doesn’t flow very well that way. 

You’re going to notice also consistency with your font. You’re not going to have 15 different 

fonts in your presentation. You might have some different sizes but you’re going to have a good 

font that flows well. 
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Now when you want to move to the next slide you can do a couple of different things. What I see 

most people do is they have their mouse here and they click and that takes them to the next slide. 

Well that works fine except it’s not very professional. So if you want to hide your mouse then 

just kind of move it out of the way and use your keyboard. You can use N for next or P for 

previous. You can use your arrow keys to go left or right. Any of that’s going to work and it’s a 

lot more professional than just clicking the mouse.  

So I’m on the second slide and I want you to notice that most all of the slides there’s going to be 

a title at the top of that particular slide. Now you don’t have to have a title. You’ll see one 

coming up shortly where we don’t have one but think about this. When you’re presenting people 

go to sleep, they chitchat, they might be taking notes, and when they look up you want them to 

know exactly what you’re talking about. So that’s why you want to have a title on most every 

slide. 

Now this particular slide is a bulleted slide. So you can see there’s different bullets here. These 

are what we call first level bullets. You can have up to five levels. So you’ll see on the next slide 

I’m going to show you what a second level looks like. Now I’m just going to use the mouse in 

this case because I’m trying to point to some different things here. 

This is my third slide and here again are my first level bullets. This is a second level. It talks 

about the first one. You can have up to five levels. So one of the things that we’re going to be 

talking about later on is how to create the different levels of bullets. 

Alright. My next slide is one where I’ve got some really basic little drawings that I’ve done. So 

you’ll notice this one doesn’t have a title even though it could. But I had mentioned earlier that 

you don’t have to and this was just an example of that. So notice when you draw different things 

you can actually have text in there or nothing, pictures. You’ll see a little bit of that a later on. 

Alright. This particular slide has some actual photographs or pictures and we’ll talk about putting 

those in.  

Here’s one that has what we call an animated GIF or an animated BIT map file. So I’m going to 

show you how to find those and put those in as well.  

Alright here’s an example of charts. So if you’ve done charts in Excel before then this should be 

somewhat familiar to you because you can actually put them in PowerPoint as well. And we’ll be 

doing that. 

This particular one is an example of what we call SmartArt. So I’m going to show you how to 

setup different levels. So let’s say your organization has a president at the top and then you want 

to have some vice presidents below and maybe some managers below that. There’s different 

types of SmartArt that you can create and this is just one example.  
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Now all presentations should have an ending slide for a couple of different reasons. Number one, 

it’s your clue not to click again because if you do you’re going to see a black slide. I’m going to 

show you that in a second. It’s also the audience’s clue that you’re getting ready to wrap things 

up. So a lot of times an ending slide will have the word Questions. I’ve seen that before. So if the 

presenter is ready to let the audience ask questions that’s a good way for them to know it’s time. 

You can see in this particular case it’s just saying Hurry up and get registered. So it’s a lot of 

different things you can put on your ending slide. It really doesn’t matter but make sure you have 

the title slide to open with and an ending slide to end with. 

Now if you’re finished your presentation what you don’t want to do is click again like I’m 

getting ready to do because then you’re going to see a black slide. And in older versions it 

actually said at the top, “Click here to end slideshow”. Now this is kind of tacky because you 

know just kind of leaves this black slide here. Notice if I click again I end up with this view. So 

that’s why you want to have the ending slide so you know exactly when to stop clicking.  

So that’s just a quick way to kind of move around if you happen to be working in your 

slideshow. If you happen to be working in this view, notice I can click on the left on whichever 

slide I’d like to work on. That’s one way to move around. And we’re going to be seeing some 

other ones as we actually go through and look at some of these different videos.  

So let’s go ahead and wrap this particular section up and let’s move to section two where we get 

an overview of this desktop screen that you’re looking at here.  
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Video: Overview of the Desktop Screen and Views 

Cindy: Okay welcome back. So this is module two, the overview module, and we’re in section 

two. And we’re going to take a quick look at the desktop screen here so you’ll kind of know 

what you’re looking at and some terminology and stuff like that. So let’s start at the very top.  

So first of all in your title bar you’re going to have the name of the particular file that you happen 

to be working in. Now remember that PowerPoint files are called Presentations. And that’s why 

you see the extension .pptx. Okay? Now what you’re going to notice on the left over here is 

you’ve got some quick launch options. Now what happened is they got rid of the toolbars in the 

Microsoft Office products a couple versions back and they left this one which is the Quick 

Launch Toolbar and they give you some basic tools or buttons you can work with and you can 

customize this if you want. So this one here is your Save, this is your Undo, this one here’s going 

to be your Redo, and this is going to be your Print. Now if you some other options that you want 

to use you can see you can customize your Quick Launch Toolbar. So if I like to use the Email 

option often I’ll just click on Email. Just a little FYI with this email button. This has been around 

since the beginning of time in the Microsoft Office products but if you happen to use Outlook for 

your email instead of saving this file and closing it and flipping over to Outlook and attaching a 

file there’s like about eight steps there. Just go ahead and click this button. It’ll pop up an 

Outlook message with this already attached and you just address it and put in whatever text you 

want and send it on. So that’s really cool. 

Alright the next thing is if you go way over to the right on your title bar you now have a new 

button that you had before but it was in a different place. This is the Ribbon Display Option. So 

basically what that is is when you’re clicked on a particular tab, and I just clicked on File which 

took me into this, so if you ever do that just hit the Back button to get out. But when you click 

the tabs Home, Insert and so forth this is the ribbon below. These are the buttons that have to do 

with Insert, for example. We used to be able to use these option, the Ribbon Display Options, 

they used to be located right underneath the ribbon here. So they just really moved this. But this 

allows you to have the ribbon auto-hide and that means it only shows up if you actually go up 

and point to it. You can actually show just the tabs if you want or you can show the tabs and the 

commands. Now keep this in mind too. If you happen to double click any tab you’re actually 

going to hide the ribbon. That’s something that normally people do and they don’t realize 

they’ve done it and they don’t know how to get out of it. So you can double click a tab again or 

you can go back and use your Ribbon Display Options to show the tabs and the commands. 

Okay?  

So those are your tabs. Remember this is your ribbon all the way across. And they’ve actually 

got groups of buttons on your ribbon. So each grouping has a name. Like this ones called 

Clipboard, this ones called Slide, and so forth. And some of your groupings have a little arrow on 

the bottom right. So if you ever see that you can click the arrow to see what your additional 

choices would be. And in this case if you click it you get the clipboard. Notice also if you happen 
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to have that open and click the little arrow again it just kind of slides and hides. See that? So 

that’s pretty cool how that works. 

Alright now here’s where it gets a little different because this stuff here is pertinent to Office in 

general. This whole screen is in what we call the Normal View. See this little button right down 

here at the bottom? That’s your normal view. So if you ever want to get back to it just click on 

that. Now the normal view consists of your slide, over on the left you see a little mini copy of 

your slides. So if you wanted to go to a particular slide you can click on it. You can also do 

things like move your slides. If I happen to click slide four and drag it up notice I can drop it off 

wherever I want that particular slide to end up. So that is one way to change the order of your 

slides. 

Now the other thing you see in the normal view is what we call the Notes section. Now it’s at the 

very bottom of your screen and right now I can’t see it because I have to pull it up. So see how if 

I move the mouse way down here I get the double arrows. I can just drag like this and now my 

Notes section appears. So the way this works is you can type any notes that you want down here 

at the bottom. Now these notes are not going to show up when you run the slideshow. So let me 

tell you how you would actually use these. 

Number one, you can actually print a view that will show you on a piece of paper the slide at the 

top and your notes at the bottom. And that’s very helpful for you as a presenter so that you know 

what to say when you have a particular slide pulled up on the overhead. You might also print it 

out and hand it out to your audience with the notes here for them so they’ll know what kind of 

notes go with this particular slide. 

The other thing you’ll see is when we talk about printing way down the list here then you’re 

going to notice that you can leave this blank and still print it and that way it gives your audience 

somewhere to write their own notes. So several ways you can do that. So we’ll talk more about 

that later. Right now I’m just going to pull it back down and that way we make the slide a little 

bit bigger. 

Okay now down at the bottom if you notice on the bottom left it says Slide Number. So this tells 

you which slide you’re clicked on and how many slides you have. And then moving on over we 

just saw the notes. Another way to pull that up is to click on it like this.  

Also comments. So if you wanted to open up the Comments Pane on the right hand side you just 

click on that and then you can put a new comment in if you want. Now remember what this is for 

is when you’re collaborating with someone else then you have the ability to actually type notes 

in and if you’re working on the same file at the same time you can both create comments and see 

what each other is saying at that particular point. So I’m just going to close that right now. 

http://www.simonsezit.com/


Learn PowerPoint 2016 

© Copyright 2008-2013 Simon Sez IT, LLC. All Rights Reserved. 

Alright so the Views. I’ve mentioned a couple of these. Remember this first one is called 

Normal. So I was telling you that if you ever happen to get into a different screen and you want 

to see this again just click the Normal View.  

Now let me mention the next one, Slide Sorter. I’m going to click on that. This shows you a little 

mini copy of each one of your slides. So some things you can do with this is just like we saw 

before we can actually change the order of our slides by dragging one left or right. But you’ll see 

later when we start applying transitions and doing animations and things like that or adding 

timings you’re going to see all those below the slide. So we’ll be working in this view a little bit 

later when we start doing some of those particular options. 

Now your next view at the bottom here is called Reading View and Reading View kind of looks 

like this. So notice you could use this view and hit these arrows to go left or right to move back 

and forth between your slides.  

And then we talked about the last one which is running your slideshow. And later we’re going to 

through and actually look at all of these different options here because you have the ability to 

move back and forth between the slides. You can actually do some things like you can un-black a 

slideshow which I’ll show you how to do that. You can actually zoom in around. You saw me 

doing some of that earlier. A lot of different things you can do here. 

Now if you want to end at the slideshow you can hit Escape or hit End Slideshow and that takes 

you back to your previous view. 

So I’m actually going to go back to the normal view at the beginning. Now I also told you that 

you can use the View Tab at the top to go through these same views. Okay? So here’s your slide 

sorter, here’s notes pages and a couple of these other ones we’re going to look at in a little bit. So 

here’s your main way to get into normal and slide sorter and then like I said the others are down 

at the bottom.  

So that’s going to give you a quick overview of what you see here. One more quick thing. At the 

very bottom on the right you can zoom in or out a little bit by using your slider. You should be 

familiar with that from previous versions. And also just kind of notice if you want to fit the slide 

to the current window there’s a little box in the bottom right and you’re going to be able to do 

that. Okay? 

Alright. So I think that kind of covers everything on the screen here. So let’s go ahead and wrap 

up section two here. And there is an exercise I’d like you to go through for this particular 

module. Basically all you’re going to do is you’re going to open the file that’s attached and just 

use slide sorter in some of the different ways that we talked about moving around just to get 

familiar with it before we move on. So the next module is module three, Getting Started, and as 

soon as you go ahead and finish that exercise I will see you in module three. 
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Video: Exercise 01 

Cindy: Okay so this is going to wrap up module two which is the overview module. So all I 

want you to do for this exercise if you’re going to open this file that you see right here. It’s called 

Welcome New Students. And go ahead and just run the slideshow and look at the different slides 

and pay real close attention to some of the things like bulleted items or you can see some of the 

different slide layouts, things like that that we’re going to be talking about in upcoming videos.  

So I’m going to see you over in module three which is Getting Started. 
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Chapter 3 – Getting Started 

Video: Presentation Tips and Guidelines 

Cindy: Okay we’re down in module three now and this is the Getting Started module. Before we 

start talking about how to create a new presentation let’s take time in this first section and go 

over some tips and guidelines that will make your presentation look a lot nicer.  

Now I want to go ahead and start with colors. Your subtle colors which are blues, blacks, 

browns, your audience tends to kind of go with the flow. They say it creates a trust with your 

audience. If you’re presenting to a new customer, you’ve not met them before, stick with the 

subtle colors because you really don’t know their personality and that sort of thing. Your bright 

colors tend to create an impact. So if your presentation is to someone in your company about 

how much money your department lost last year you might want to use a bright color if you’re 

trying to make an impact with that. If you’re not, if you’re trying to kind of slide on past that 

then you’d probably want to use one of your subtle colors.  

Also think about if you’re going to present in a room on an overhead projector. You want to 

think about the lighting that’s currently in the room. So if you’ve got a lot of windows in that 

room you might want to have a darker background. The opposite could also be true whereas if 

you have no windows you want a lighter background to put light in the room. So it’s always 

good if you know you’re going to be presenting on an overhead that you go and check out the 

room first. Obviously if you’re just on a laptop and you’re going to sit down with someone it’s 

probably not that big of a deal.  

Never put red and green right next to each other. You don’t know who’s color blind and they say 

that depending on their degree of colorblindness they could either not distinguish the colors at 

all, they say them as shades of brown or they just can’t separate the two colors. So I know that’s 

hard to do at Christmastime but use the same slide with red and green but don’t put them right 

next to each other. 

And keep your colors consistent throughout your presentation. You don’t want to have one slide 

that has pink on it, another is black, another is yellow. It just doesn’t flow very well. So just 

make sure your colors flow. 

Okay let’s talk about your fonts a little bit. Now typically you want titles to be size 44, subtitles 

to be 32 and regular text to be 28. Now that’s not to say that all presentations should have titles 

size 44. It just depends on the particular template you’re using. Remember in PowerPoint bigger 

is better. So if you’re presenting like at a conference, for example, and you know you’re going to 

have an audience that’s way in the back of the room you can make it even bigger because if they 

can’t see they’re going to chitchat or go to sleep. Stay away from size 12 like you would type 

text in Microsoft Word, for example, because no one can read that.  
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Also limit your fonts to three per presentation. So usually what you’ll see is the titles are all the 

same font, maybe the text below it on your slide is the same font and sometimes people throw 

one more in here or there. But don’t have totally different fonts on every single slide. It just 

doesn’t flow very well that way. 

Alright let’s talk about words. You want to limit the words per line to six to eight. And the 

reason for that is because if you’ve got 12, 13, 14 words and you’re trying to put them all on one 

line you’ve got to make the font smaller. Remember bigger is better. So if you’ve got a lot of text 

you want to break it down into a couple of different lines. Keep in mind though that the less text 

you have on a slide the better. No one wants to read paragraphs of text, especially slide after 

slide after slide. So you can always use handouts if you have more text you want your audience 

to kind of note. Put your text on those handouts and pass those out. And again less is better. 

Okay some rules with your bullets. Four to six bulleted items per slide. And again that’s for the 

same reason we talked about with the fonts. If you’re trying to cram 12 or 13 bullets on a slide 

you’ve got to make them a lot smaller and people in the back of the room aren’t going to be able 

to see it. So break your slides up into several if you need more than four to six per slide. Now if 

you only had seven it’s not a big deal. But if you’ve got 10-12 you need to have two different 

slides. 

You’re going to be able to have up to five levels of bullets. So you’re going to be able to have 

first levels, second levels which talk about first levels all the way down the line. Later we’ll be 

talking about pictures because you can have different pictures for your bullets. And if you do that 

use the same picture for each level. So all the first levels would have the same picture, second 

level is the same picture and so forth. 

Okay your templates. You’re going to use simple templates and you’re actually going to enhance 

them by using some graphics, clipart or chart, things like that. You want to really limit the 

number of textures and affects and things like that. There is a fine line between having a nice 

looking presentation versus one where people going, “Ooo. Aw. How’d you do that?” and 

they’re not paying attention to what you’re saying. So you have to kind of find that line there. 

When you have text slides try not to use more than three in a row because it gets really boring. 

So every three or four slides put in a picture or something funny, a graph, something to break the 

monotony. So what I’m saying is don’t have a presentation that has just a title slide and 

everything else is bullets because people are going to go to sleep. 

So that’s all I want you to know right now. Let’s go ahead and keep those in mind when we go 

into section two, Creating a New Presentation, because we’re going to be picking templates kind 

of based on these guidelines. 
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Video: Creating a New Presentation 

Cindy: Okay so we’re in module three and this is section two where we’re going to talk about 

creating a new presentation.  

Now I know a lot of you may have worked in PowerPoint before and you may have actually 

edited a presentation someone else created but I want to show you how to create one from 

scratch just so you know how to do it. So what I’m going to do is flip over to PowerPoint now 

and show you how to create a new blank presentation. So hold on a second. 

Okay. Normally when you open PowerPoint it opens you to a new blank presentation. You can 

see that it’s white paper, black text. So I do have the ability to apply a design which I’ll show 

you in a second or if you were creating a new one from scratch here you could go to File and 

then go down to New this way and here you can see all of your themes or templates. So if you 

wanted to start with one of these you certainly could. Remember all those guidelines we talked 

about as far as colors and text? Think about those when you’re picking your particular theme. 

So if you look at this one, for example, Main Event, that looks like something you’d use if you 

were trying to actually make a statement or something you want people to remember. Whereas 

one of these like Mesh or Damask those are a little more subtle. So just kind of keep that in 

mind. 

Now let’s say this. Let’s say we did have a blank presentation, which by the way I could have 

chosen right here but because we’re already in one I’m just going to hit the Back button up at the 

top.  

So we’re on this blank presentation and let’s say that I’ve got ten slides. It really doesn’t matter 

how many slides you have in here. When you go up to the tab that says Design at the top here are 

your designs or your themes you can pick from. Make sure to click the scroll bar to make sure 

you can see all of them.  

Now let’s say you pick one. I’ll just start with this one. And let’s say you like this one but you 

really wish the background was a different color. Notice now you’ve got the Variants over to the 

right. Now this is a new feature in 2016. But you see how there are several different variants I 

can pick from? So let’s say I click on the blue and now I’ve changed that.  

Now keep this in mind. If you’ve already put several slides in your presentation and let’s say you 

had changed your fonts for some reason. Maybe you made them larger or a different color, 

moved them to the right or left. Anything you had manually changed you’re going to see that a 

design or a theme may override that. So it’s best to pick your design or themes up front so you 

don’t have to go back through the whole presentation and look through all those things and make 

sure it looks correct. 
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So that’s how you’re going to do it. You can start with white paper, black text or pick a design 

and go from there. 

So what we’re going to do is I want to move into section three and talk to you a little bit about 

actually working with the slides. 
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Video: Working with Slides 

Cindy: Okay so we’re in module three, Getting Started, and this is section three where we’re 

going to talk a little bit about working with slides.  

So we had in the previous section created a new presentation and we had one slide because it 

gave it to us automatically. But now we want to see how to add some additional slides. So let me 

flip over to that presentation and we’ll just keep going with it. 

Okay so we’re back in our presentation and remember we’re on what’s called a title slide. Now 

you always get a title slide in the beginning and remember that you want to have that because 

that’s like a cover for the book. It’s the same thing for PowerPoint. It’s introducing your topic. 

Now you can have multiple title slides in your presentation if you like. So for example, what if 

you were going to talk all morning and you had three different topics you were going to talk 

about? Instead of having three PowerPoint presentations you could have a new title slide at the 

beginning of your second topic and the same thing with your third. But at least have one at the 

very beginning. 

So we’re going to go ahead and put our text in here and we’re going to say, “Welcome New 

Students”. Now remember that you don’t have to have a subtitle but we’re going to put one in 

here. We’re going to say this is an, “Overview of Campus Life”. Okay. When you get ready to 

put a new slide in you’re going to click up here on New Slide. Now real quick let me just 

mention that new slides are always the next slide. So if you happen to be clicked on slide ten the 

new one would be slide eleven.  

Now when you choose a new slide you’re going to have to pick from these different layouts that 

are available. So we’re on the title slide now but let me just mention some of these others to you. 

Here’s title and content. This is probably the most common one other than the title slide and 

we’ll choose that in a moment. But notice I’ve got one for section headers. I’ve got one for two 

content. And two contents like having two columns basically where you can put something in 

each side. And this one here, comparison, is just like the two content but it has a place for a title 

at the top of each of the columns as well. Here’s one that has just the title. So you could use that 

if you wanted to draw something or put a clipart picture or something at the bottom. Here’s a 

blank one. Here’s content with caption. Here’s picture with caption. You’ve got panoramic 

pictures. You’ve got quotes, title and caption. Just know as well that some of these at the top are 

your basic layouts and depending on which theme you choose you may have some additional 

ones. Like these down here, some of these you won’t see unless you’re in this layout, for 

example. So we’ll see some of those layouts as we go along. So I’m going to choose title and 

content. 

Now let me go ahead and click and put our title in here. We’re going to say, “Why Choose Us?” 

Okay. Now if you’ll notice down at the bottom here it says, “Click to add text” and you’ve got a 
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bullet. So this is where you can start a bulleted list. But if you don’t want bullets just go right up 

here and click this bullet option and that’ll just turn it off. Or if you’d rather have numbers you 

can do that. But for now we’re going to use our bullets. 

So we’re going to say it’s a “Beautiful campus”. Alright notice how when I enter I got the 

second bullet. We’re going to say, “Experienced professors”. The next one we’re going to say, 

“Low cost for attendance”. And you can have as many bullets in there as you’d like. Just keep in 

mind those guidelines we talked about. 

Now I want to put another slide in here. We’re going to have another bulleted one so I can show 

you how the levels work. So I’m going to go back to New Slide and I’m going to choose the 

same one, title and content. Now this time we’re going to say, “Here’s the benefits of campus 

life”. So we’re going to say, “Campus Life Benefits”. Alright we’ll say, “New modern co ed 

dorms. Now here’s what I want to show you. Notice when I hit the Enter key I got a second first 

level bullet. The way you’re going to get the next level, and remember you can have five levels 

down, is you’re going to hit the Tab key. So Enter always keeps you on the same level. Tab will 

move you to the right or give you a lower level. I’m going to say, “Recently renovated”. Now 

notice that when I hit the Enter key I stay on the same level. The way I go up to a first level 

bullet again is Shift-Tab. So Tab goes to the right, Shift-Tab goes to the left. So we’re going to 

say, “Best food cooked by top chefs”. Alright. I want to have a second level about this. We’re 

going to say, “Designed to cultivate your dining experience”. Makes me hungry. Okay. Let’s 

make a first level bullet again and we’re going to say, “Easy walking distance to parks” and 

we’re going to say, one more second level. We’re going to say, “No car needed”. Yay. And we 

can work with the spacing a little bit later but you see how you get this in. So remember that if 

you want to go from a first to a second level bullet you’re going to hit the Enter key first and 

then the Tab key. To go from a second level to a first level you’re going to hit the Enter key first 

and then Shift-Tab. 

Okay. So I wanted to go over one more quick thing I forgot to mention. When you go to put in a 

new slide and let’s just say you picked title and content but it could be any of these of these little 

pictures that you see here. What I want to tell you is what these little pictures represent. So 

instead of putting bullets here it could be you want to put in a Microsoft Word table. This one 

represents a chart. This one represents a SmartArt graphic. So this would be like, for example, an 

organizational chart. Then you can put in pictures. You can put pictures in from the web or just 

pictures that are on your computer. And the last one lets you insert a video. So we’re going to be 

doing all of that as we go through these videos. I just wanted you to know what those little 

buttons meant. 

So what we’re going to do now is we’re going to go ahead and move over to section four and 

talk about saving this because I’d hate to lost all this work that we just did. 
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Video: Saving a Presentation 

Cindy: Okay. So this is section four of module three, Getting Started, and we need to go ahead 

and talk real quick about saving our presentation. 

Now this is going to work like it pretty much does in Word or Excel, if you’re familiar with that. 

But I would say frequently in PowerPoint, as a matter of fact I’d probably start saving right away 

especially as you start putting graphics in here because you’d hate to lose all that work that you 

did. So let me flip over to our presentation and we’ll go ahead and get it saved. 

Okay so here we are in our presentation we’ve been working on. And I want you to notice that 

when we left off we actually put an extra slide in here because I was talking to you about what 

these little buttons here meant. Now I want to show you real quick how to delete a slide if you 

don’t want it. The easiest thing is over here on the left if you just select it you can actually just 

hit Delete on the keyboard and it’s gone. Now I could have left it there because I’d probably use 

it but I just wanted to show you how to delete it.  

So what we’re going to do is we’re going to go up to our File tab, we’re going to choose Save 

As. Now we’ve got several places we can save this to and the first option is OneDrive. And if 

you don’t know what that is, you know everything is going online now. You’ve probably heard 

people talk about working in the Cloud. Well Microsoft, Google, everybody’s got their own 

version of saving something on their network or in the Cloud. And OneDrive is just Microsoft’s 

version of that. So you just need an account with Microsoft’s OneDrive and then you can 

actually save it to the web and then you can go anywhere in the whole wide world and pull it up 

as long as you have your internet access. 

Now I can also save it to this PC, I can add a place or browse. So I’m just going to hit Browse 

here and then I’ll just save it to my desktop. And we can call this anything we want to call it. So 

I’m just going to say, “My Presentation”. Notice that it saved as a .pptx. That’s your extension 

for PowerPoint files. I do want you to look at the Save As types because you’ve got all these 

other types you can save.  

Notice this one, the PowerPoint Template. One of the things we’ll talk about way down the line 

is creating your own templates or your own designs and that’s how you would save it. I could 

save it as an Office Theme. So there’s lots of different ways I can save this. But for now I’ll just 

leave it as a PowerPoint presentation. I’m going to go ahead and click Save and now you can see 

it says, “My Presentation” right in the title bar there. So that’s how you’re going to save this. 

Alright? So that’s going to wrap up module three. Now there is an exercise for module three that 

I want you to do. So if you go ahead and open that next video which is section five I’ll tell you 

what I want you to do in that particular exercise just to make sure you’re okay with things. 
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Video: Exercise 02 

Cindy: Okay so we’re going to wrap up module three with an exercise and I’ve actually got 

some instructions here so you’ll know what to do. So here’s what I’m going to have you do for 

me. 

We’re actually go ahead and create a PowerPoint presentation from scratch. Now remember 

when you open PowerPoint you’re going to get a blank presentation. And what you’re going to 

do from there is if you wanted to actually just go up to the tab that says Design you can choose 

the theme called Berlin or if you wanted to go File, New and do it that way that might be a little 

bit easier for you. 

You’re going to start off adding the title Sales Presentation and the subtitle 2014 Sales and 

Expenses. Now after you get your title slide set up you’re going to add a second slide and it’s 

going to be the layout Two Content. You’re going to realize you have the wrong layout and then 

you’re going to change it to the Title and Content layout.  

Now I’m going to have you add three first level bullets. You’re going to add Sales, Expenses and 

Profits and then you’re going to go back underneath your Sales and you’re going to add a second 

level bullet called New southeastern region. Then you’re going to save the file and call it My 

Presentation. And that’s going to be it for now. 

So that should be pretty easy for you to do. Just go back and follow the video if you forget how 

to do something. But we’re going to take it from there into module four once you get done. 
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Chapter 4 – Text and Bullet Editing Options 

Video: Formatting Text 

Cindy: Okay so we’ve made it down to module four now and this is where we’re going to talk 

about the text and the bullet editing options. 

So you probably notice when you typed your text in or your bullets that you got some default 

ones automatically. So I want to show you how to change some of that stuff in this particular 

module. Now this is the first section, Formatting the Text, so we’re going to talk a little bit about 

how to change the color of the text, the size, things like that, anything having to do with the text 

right now. So let me flip back over to our exercise we were working with and we’ll go ahead and 

see how this works. 

Okay so we’re back in My Presentation and if you remember when we left off in module three 

we were actually talking a little bit about putting some bullets in. So I’m back on slide one here. 

Now any time you click inside of an object, I’ll take the title for example, you’re going to get 

what’s called a placeholder or a box that pops up around your object. Now this object is called a 

placeholder because it holds the place for whatever is inside of the object. It might be text, it 

could be a picture, who knows. But right now we’re working with text.  

Now you’ll also notice that when you’re working with an object you’ve got these control handles 

or sizing handles those sometimes are called in the corners and on the edges here. And these just 

allow you to change the size of the object. So remember it doesn’t actually change the font size. 

It changes the size of the object. 

Now we’re used to dragging across the text when we want to actually change the text and that 

will work here in PowerPoint but one of the things I’m going to say a hundred times is click on 

the placeholder itself when you want to change something within the object. Now what I mean 

by that is see how if you place your mouse right on the line you can click. That’s how you select 

your placeholder. Notice there’s no cursor in there for typing. Now any changes I make will only 

affect what’s inside of this placeholder. If you’d only selected one word then sometimes when 

you do other things they won’t work. So you’re going to see that as we go along.  

Now let’s go up and talk a little bit about your font options. And I’m sure you’re familiar with a 

lot of these if you’ve worked in other Microsoft Office products. So let’s start with your actual 

font itself. Now this is the list of fonts you get in PowerPoint. You can see if you just move your 

mouse over any one particular font that it shows you what it’s going to look like. And if you like 

that one go ahead and click on it. 

Also you’re going to see the size. So you’re used to text being in size 12 if you work in Word for 

example. But in PowerPoint remember bigger is better. So we had talked about some of the 

generic sizes you get and remember that 48, 54, those are some generic sizes. This ones actually 
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got 72 automatically and that’s fine in this case. But if you want to change it just pick a different 

number here. Now also remember that if you want a size that’s not in this list you can type it. So 

if I wanted I don’t know, let’s say 65.5 see how I can type it here. And if I hit the Enter key then 

that’s the size that I get.  

Also see this large A and small A right here? So if you’re playing with this list and you say 36 is 

too small and then you pick another size that’s too big then play with the large A which will 

increase your font size by one or the small A which will decrease your font size by one. So you 

can always do it this way and it’s more of a visual. You can see if that’s the particular size that 

you like. 

Now down here you have B for Bold, I is for Italics and U is for Underline. Now if you’re 

underlining you’re underlining the text only. You’re not underlining the actual placeholder. So 

just kind of know that. 

Also this S is probably a new one to you. It’s a shadowed tool. So depending what color you’ve 

chosen you could see a little shadowed effect when you turn it on or off.  

Now this is going to be your strikethrough. You’re probably not going to use it here but if you 

had something that you had edited then you might want to leave the original text. You can strike 

through it. 

Alright your next one over is going to work with the spacing between the letters. So if you 

choose a tight or a very tight your text will look like it’s very close together whereas a loose or a 

very loose will allow you to have more space between your letters. This one’s just set on normal 

so I’ll leave it there. 

Now this one here where it says Change Case. So you probably notice that in some of the 

templates no matter if you type with uppercase or lowercase that it’s going to make the letters 

uppercase automatically and that’s true in this particular template we started with. But sometimes 

you may need to change the case. So Sentence Case allows you to have the first letter capital and 

everything else is small. You’re also going to have a period at the end of that particular one. 

Lowercase is all small letters. Uppercase is all uppercase letters like we have here. You can also 

choose to capitalize each word. They used to call that title case. And then the last one is where 

you toggle. So you’ve probably seen before where you accidently has the Caps Lock key on and 

the first letter was small and everything else was capital. This just kind of flips it. 

Okay so those are some of your generic options right there for font. Here’s your color. I forgot to 

tell you that. You can change the color of the text, any color you’d like it to be. 

Now I’m going to go ahead and click this little arrow and see if we have any additional options. 

So if we wanted to go ahead and change our text font here we could. Here’s our bold and our 

italics we talked about, here’s size. Let’s make it a little bit smaller. How about 70? Let’s go 
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down to 75, let’s just say. Remember how I said you could type it in here? Here’s your font color 

and your underlined style. Now there’s a couple new things here.  

With the underline button up on your ribbon here, this one, you could only pick a straight 

underline. Here you’ve got dotted underlines, you’ve got dashed underlines, you’ve got different 

styles of underlines you can choose from. And by the way if you do pick an underline you can 

pick a color for your underline as well but I’m going to go ahead and take that back off and say 

none.  

We saw strikethrough already. Here’s a double strikethrough. And then super and subscript. And 

if you don’t know what those are a good example of superscript is if you’ve seen Mattel toys 

before and they have that little trademark, the little TM that’s up, that’s superscript. Subscript is 

like H2O where the two is down below. 

Your last couple checkboxes here. You’ve got small caps. So those will be capital letters but 

they’ll be a little smaller. You’ve got all caps or you can equalize the character height. Now what 

this last one does here is it’s going to retain the fact that you have upper and lowercase letters but 

they’re all going to be the same height.  

Here’s some options for character spacing here as well. You can actually do what’s called 

kerning. So if you wanted to say it’s more or less points above can do that. So normally we’d just 

leave this on normal. 

Alright let me click OK here and now you can see all the choices that you picked. 

Now let’s talk about your Format Painter tool for just a second. Let’s say that I wanted my 

subtitle down here, Overview of Campus Life, to look exactly like my title as far as the 

formatting. I want the same color, same size. I really don’t remember everything I picked. So let 

me show you how this works because this tool here, Format Painter, is going to copy all of your 

formatting from wherever you tell it, in this case our title, to the subtitle in this case.  

So here’s how it’s going to work. You want to select where you’re copying from. So notice I 

selected the placeholder around my title. I’m going to click Format Painter just one time. Notice 

the little paintbrush attached to it. And now I’m going to click inside the subtitle. And you can 

see now they are the exact same size. Now obviously this looks very funny like this so I could 

actually just make it a little bit smaller and then it would have the same characteristics except the 

size. So a lot of times that works great and you don’t have to manually pick all those options.  

Now I want to show you one thing that’s going to happen. I’m going to undo this for a moment, 

all the way back here. Remember how I said select the placeholder? Well here’s a good example 

of when you don’t select it what happens. Notice that I’m clicked inside of this word Welcome 

or I could just select just this one word. Now if I click Format Painter now and click inside the 

subtitle notice it only changed one word because PowerPoint thinks I only want to affect one 
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word because I only had one word selected. So I’m going to go ahead and undo that but I just 

want you to kind of know that. Okay? 

Let me go ahead and make this the color I want and I’m going to copy the formatting to my 

subtitle, make it a lot smaller here and then it looks a lot nicer. 

Alright so remember all of that when you’re formatting your text.  

Now one last quick thing I’ll tell you. You do have the ability to take all of your formatting off 

and that’s going to be this one here. So whatever you have selected that’s going to affect.  

And then the last quick thing I want to mention is this. I don’t want you to change any more 

formatting as we go forward. And that’s because we’re going to be talking about the masters in a 

later module. And a master is a place you can go to globally make any changes as far as 

formatting. But it won’t override the ones you manually changed. So just kind of keep that in the 

back of your mind for now until we get to the master section a little bit later. Okay? 

So that’s a little bit about how the formatting works. So let’s go ahead and go over into section 

two and talk about doing some formatting with your bullets or changing the bullets there. 
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Video: Working with Bullets 

Cindy: Hey. Welcome back. We’re in module four and we’re talking about text and bullet 

editing options in this particular module. Now we’re down on section two now and we’re 

actually going to talk about how to change those bullets. If you need them to be a different color 

or a different size, things like that. Also numbers because numbers kind of go right along with 

bullets. So let’s go ahead and move into our presentation and we’ll go ahead and see how that 

works. 

Okay so we’re back in My Presentation. And when we left off in the first section we were talking 

about the title slide. So let’s go over to slide two and there’s our bullets. Now if you remember 

we had some first level bullets on slide two and on slide three we had some first and second level 

bullets. So a real quick recap and we’ll go back to slide two.  

Remember with your bullets that if you want to have one of the different levels and I told you 

there are five different levels you can have. You’re going to hit the Enter key first, you’re going 

to hit the Tab key to get the next level down. And remember that if I keep hitting Tab I’ll go 

down to the five levels. Shift-Tab goes back up. So remember Tab demotes and Shift-Tab 

promotes. 

Now we’ve got these bullets here and you probably noticed that these just came along 

automatically with the particular template that we were clicked on. Now if we wanted to change 

those we could. We could also change the spacing between the bullet and the text or we can 

change the spacing as far as for the bullet lines up at this line itself. So let me just show you that 

real quick. 

Now I’m clicked inside the first level here and if you look up on your ruler, see these indents? 

Now if you’re familiar with those in Word they’re very similar. The way they’re going to work 

in PowerPoint is the top one controls the bullet and the bottom one that points up controls the 

text next to the bullet. So if I need more space between my bullet and my text, I want to move 

the text over to the right a little bit, I’m going to grab the one that points up, drag it over and 

wherever I let it go that’s where the text will line up. If I move it back the other way then I can 

put it back the way it was. And also remember I just said if you wanted to change where the 

bullets located. So if I take the top one here I can move it over to the right a little bit and that 

moves the bullet or vice versa. So that’s a quick way just to change the spacing between the 

bullets if you need to do that. Now let’s talk a little bit about changing the actual bullets 

themselves. 

Okay. So if you notice where I’m pointing this is your Bullets button. And I clicked the little 

down arrow to the right of it so you could see some of the different styles of bullets that you can 

pick from. Now you get some generic ones here. And you’ll notice as I move my mouse over 

these you can see it actually changing the first bullet. Now I can also tell it I don’t want bullets at 
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all by choosing None. But what if I didn’t like any of these? Then I could go to the Bullets and 

Numbering. Now before I click on that the reason I’m only changing one level here or one bullet 

is because I’m clicked in that one level only. So I’m going to go back out and choose the 

placeholder first and then I’m going to click the down arrow. Now you’ll see that when I move 

over one of the bullets that I’m actually changing all of the ones that are on this particular slide.  

Now I’m going to go down to Bullets and Numbering. 

Now here’s the same ones we saw a few minutes ago and let me show you some of the additional 

options before we actually go and change the picture here. You can change the size of the bullet 

in relation to the text. So 100, size 100 would be the exact size as the first character of text. So I 

can always move this up or down to whatever number that I like. I can also change the color of 

the bullet here. So if I wanted red bullets I could change it.  

Okay as far as changing the bullet itself I can get a picture or customize. Now let me start with 

customize just for a moment. 

Now if you’ve used previous versions of PowerPoint this whole little bullet section is very 

different because it used to be that when you clicked on Customize you were in the same 

window but you had a whole bunch of different fonts you could pick from in this list. Notice 

now you get Normal text or Latin text and that’s pretty much it. Now no matter which one of the 

fonts that you choose here you can also choose a subset. And they’ve got several that you can 

pick from here as well. Whatever font or subset you choose make sure you scroll down to see all 

the different types of bulleted items that you could have. So for example, if I went down to 

Miscellaneous Symbols then you’ll see I can have the sun or a smiley face, any of those could be 

my bullet. So let’s just say I pick the smiley face right here and I click OK and let’s say I click 

all the way out of it. Now notice I have these red smiley faces right here.  

So let me go ahead and go back in there again. We’re going back to Bullets and Numbering. 

Now the other thing I can do is I can choose a picture. Now when you choose picture you can 

choose to pick a picture that is a file in your computer already or you can do a Bing Image 

Search. Let me browse and show you the first one. And I’m just going to randomly pick some 

picture from my computer. Let’s say I go down this list here and I pick, let’s say I pick this one 

that says Clear Skin. I know that’s going to be weird looking but. You can see back here that 

now that picture I had saved is actually my bullet. So you can always do that.  

Now the other thing is, let me go back into the bullets here. I might decide from this picture 

option to pick, to do a Bing search. So let’s say that I want these pictures to be dogs or I could 

even look up the word Bullets. It doesn’t really matter. You can look up anything you want. I’ll 

look up bullets. How about that? And I’m just going to go and Enter and it’s doing a Bing search 

for bullets. And any of these that come up I can use. So let’s say I like one, for example. I’m 

going to click on it and I’m going to choose Insert. And now you’ll see that that’s my new bullet. 

So I can pretty much make the bullets look any way I like. 
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Now what if you didn’t want bullets you wanted numbers instead? All you’d have to do is come 

up here to the Numbering button. There’s several different numbering styles you can pick from. 

If you like one you just click on it. But let’s go down to Bullets and Number and again if I’m 

clicked on a particular number style here I can make the number 100% or whatever percent I 

want of my text. It’ll be the same size. And then again I can pick my colors here. So I’m going to 

click OK and now you can see it’s numbered. And like you just saw if you didn’t want 1, 2, 3 

then you might choose to have A, B, C’s or Roman Numerals. That’s kind of up to you. But you 

can have any numbering style that you like.  

Now let me show you this. When you’re over on bullets that have more than one level and you 

choose numbers, for example, you’re going to see that your second number looks like an outline. 

And so you’ve got different styles you can pick from for that as well. And when I go to Bullets 

and Numbering I can go down and pick whatever bullet or number I want it to look like. And 

notice that if I wanted bullets I’d just go back to the bullets over here. I don’t have to actually get 

all the way out of it. Okay? 

So that’s kind of how your bullets and your numbers are going to work. So you can just look 

through and pick any kind of bullets or numbers you want. Now keep in mind something I told 

you in section one at the very end. Again, when we look at the masters in a later module and we 

want to change the bullets for every slide in our presentation it’s not going to override these two 

we were just playing with because I manually changed those. So just kind of keep that in mind. 

Okay? 

Alright so that’s going to wrap up module four, Text and Bullet Editing Options. I’ve got a little 

exercise I want you to do over in this third section here. So if you go ahead and open that video 

I’m going to give you some instructions on what we’re going to do just to make sure you’re okay 

with how to change text and bullets.  
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Video: Exercise 03 

Cindy: Okay we’ve made it through module four so we’re on the practice exercise now. And I’ll 

just want to know in this exercise that you can do a couple of different things. I want to make 

sure you know how to change the bullets to whatever picture you like. I want to make sure you 

know how to change them to numbers if you prefer. And also with the bullets how do you get the 

different levels in there? 

So here’s what I’m going to get you to do for me. You’re going to open a file called Practice 

Presentation 4. You’re going to start off on slide two and I want you to actually change the 

bullets that are currently there to numbers. And I’ve got 1, 2, 3 here but if you want to play with 

different numbering styles feel free.  

You’re going to go to slide three and there’s going to be six bullets there currently and they’re all 

first level bullets. I’m going to have you change these three that you see here to second level 

bullets. And then if you want to change the pictures to whatever you like feel free. 

And once you get done with that and you feel like you’re comfortable go ahead and save and 

close the file for me. And then that’s it. So pretty easy. I just want to say great job. You’re doing 

great. So let me go ahead and meet you over in module five and I’ll see you there. 
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Chapter 5 – Adding Graphics to Your Presentation 

Video: Inserting Shapes 

Cindy: Okay so we’ve made it down to module five now and this is where we’re going to talk a 

lot about how to add graphics to your presentation. 

Now this is section one where we’re going to talk about inserting shapes but let me just mention 

that graphics might be a picture you’ve inserted, it could be a star that you drew, it could be 

some kind of cartoon picture you got from the internet. All of that’s considered a graphic and I 

wanted to show you how to add each one of those to your presentation and then we’ll talk about 

working with them a little bit later. 

Okay so we’re back in our presentation we’ve been working with and what I want to do now is 

show you how to add a new slide that’s going to be blank so that we can actually insert some 

shapes. Now remember new slides are always the next slide so I’m clicked on the third slide and 

I’m going to New Slide and this time I’m going to pick the blank layout. 

Now this ones pretty blank. The only background graphic it actually has on it is this little thing 

right up here. And it wouldn’t hurt us to leave it there but just something real quick I want to 

show you. Sometimes you might be working with designs or templates that have a lot of 

background graphics going on. And if you want to draw and add graphics or shapes to those you 

can actually take the background graphics off so it doesn’t look quite so busy. Here’s how you 

do that.  

If you went up to the Design tab and you go all the way to the right of your ribbon you’ll see a 

button that says Format Background. Now there’s a lot of different things you can do here. We’ll 

be getting into all of this later. But do you see this little checkbox here, Hide background 

graphics from master? You’ll notice when you check it that little thing is gone from there. So 

you don’t have to worry about it now. But notice it’s still on the other slides if you look over 

here. If you wanted to take it off of all of your slides notice there is an Apply to all at the bottom. 

But as long as you don’t check that, as long as you just check this one here and you close then 

you’ll notice this one does not have the background graphics so it’s a little bit easier to work 

with. 

Okay so let me show you how to insert shapes. Now I’m going to go back to the Home tab and I 

want you to notice that you have a Drawing grouping right here and these are your shapes. 

You’re going to see these same shapes on several different tabs. So you don’t always have to 

come back to the Home tab to draw these. Matter of fact if you went up to the Insert tab you’re 

going to see shapes right here. So you can use the shapes from wherever you happen to find 

them. 
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Now shapes are just different things that you draw and I want to show you how they’re set up 

because they’re set up by categories to make it easier for you to find something you’re looking 

for. Now what they do put at the top here are your recently used shapes. So if you wanted to go 

back to one a little more easily you can find it there. But notice they’ve got it broken down by 

lines. They’ve got rectangles, basic shapes which has things like smiley faces and lightning bolts 

and things in there. They’ve got block arrows. So if you needed arrows of any kind. They’ve got 

equation shapes that have to do with math. Flow chart shapes and then stars and banners. Now 

the callouts down here at the bottom these are, if you think about the comics on Sunday where 

they have the little piece out to the side with the words that the person was saying, that’s what 

that is.  

And then let me just mention the Action buttons. These are hyperlinks. So if you wanted to be 

able to click a button and move to an Excel file, for example, or click a button and go to a 

particular slide you can do that. We’re going to talk about Action buttons in another module so 

just kind of hold that thought. 

Now let’s go back up to the top where the lines are so I can show you something easy.  

Let me show you how to actually draw any shape. I’m just going to start with a basic line. Notice 

I’m going to click the line and then my mouse looks like this black crosshairs. So I’m just going 

to hold the mouse the whole time and draw my line. Wherever I let go that’s where the lines 

going to stop.  

Now you’re going to notice that because this is an object it has the control handles on either side 

like we’ve been talking about. So if you deselect by clicking away and then you can click back 

on the object to select it again. 

Now let’s go back up and look at some other shapes. I’m going to go back to Shapes over here. 

Now you’ll notice it’s in a different place this time because you’re actually on what Office calls 

a contextual tab. Because I clicked on my object I have a new Drawing Tools contextual tab that 

has options just for this line I drew. If I click away from this notice I would have to go back to 

Home or Insert to access that list of shapes again. 

Now when you’re looking under lines you’re going to see some of these squiggly lines here. And 

some of these are just ways to freely draw something. So you’ll notice that this one is scribble. If 

I click on that I can just randomly scribble or draw something here. It does take a little bit of 

practice though.  

Notice also objects can layer on top of others. See how this one happens to be on top of this one? 

And we’re going to talk about that a little bit later too but right now we’re just drawing. Alright.  

Let me go ahead and click on the squiggly line here and I’m just going to hit Delete on the 

keyboard to get rid of it.  
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Okay so let me go back to Insert, Shapes. Now you have rectangles which are the next set of 

shapes. So notice that you can draw any of these rectangles that you would like. Another shape 

that I’m going to have are under basic shapes. You’ve got things like the smiley face. A lot of 

people like this old smiley face right here. Or you might have seen the lightning bolt. See that? 

Okay so then we talked about you’ve got arrows. I’m not going to draw all of these. But if you 

were going to draw a block arrow it would look something like this. You could make it point 

wherever you like.  

I mentioned you have equations, you have flow charts, and then stars and banners. I want to 

mention a couple things.  

I’m going to draw the star that has a 16 inside of it, that’s a 16 point star, because I want to show 

you something with stars. You might notice that some shapes, not all, are going to have this little 

it looks like a control handle. See that one right there? What that’s going to do is if I drag it in, in 

this case towards the center, I get more of a spiked star depending on how far in I drag it or vice 

versa. The smiley face had one as well. So you might not have noticed but on his mouth piece 

here you could drag this up and he would actually frown. 

Alright let me show you a couple of other ones. The banners are kind of cool. Banners look like 

this.  

And then one more I just want to mention. I told you about the callouts. So I’ve got this smiley 

face here and I’m just going to move him over a little bit so we can see this. But I’m going to 

draw one of the callouts. I’ll just pick this one. And I’m going to draw it right over here. 

Remember how I just talked about the button you can click on that will actually let you move? 

See how this will move the little mouth piece here. See that? It changes what the shape looks 

like. So I can actually make this point to his mouth.  

Now by the way you can type inside of any object. So if you select the object and just start 

typing then your text will be in there. 

So I just wanted to bring those to your attention because those are the different types of objects 

that you can draw. And obviously you want to get in there and play with these so that you’re 

familiar with what’s here. Like I said we’ll be talking about the Action buttons in a later module 

because they’re a little bit different here. But go through and play with this and get real familiar 

with it. 

Now one more I didn’t mention. I want to mention this one that has an A right here. That’s called 

a text box. So what happens with a text box is I can click wherever I want a text box to be and I 

can type some text in here. And basically what happens is that it looks like if you make this a 

little bit wider or if you want it small or whatever, you can see that it just looks like you have 

random text just sitting out on your slide here. Actually it’s an object and you can put the lines 
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around it and all that stuff. But see how it just looks like a random text? So that’s kind of what a 

text box is. You do not have to draw an object like we did here and then put a text box inside of 

that. So just go ahead and select an object and type and that’ll let you put text in there.  

So go ahead and play with those, get really familiar with those because we’re going to be 

drawing and doing a lot of things with them as we kind of move on here. Okay? 

Alright so what I want to next is we’re going to move over into section two and I’m going to 

show you how to insert some graphic objects. 
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Video: Inserting Graphics 

Cindy: Okay we’re working in module five, Adding Graphics to Your Presentation.  

So if you think about it graphics really just make your presentation a little more visually 

appealing because your slides can get kind of boring if you just have bullet points or text on 

them. So we’ve talked about adding shapes. That was section one. And now we’re in section 

two. Let’s talk about adding those graphics. 

Okay we’re here on slide three of our presentation and let’s say that we want to add a little 

clipart picture over on the right here because this is actually kind of boring. We’ve got some 

bullets but it’s kind of dead over on the right. So here’s how you’re going to do that. 

If you go to the Insert tab you’re going to go to online pictures. Now this is going to do a Bing 

Image Search. So you can actually type in anything you want. Let’s put in College Clipart and 

let’s just see what comes up when we hit the Enter key. Now you’ll see several different clipart 

pictures popped up and there’s also a yellow ribbon here. I just want to tell you what this is very 

quickly. It says Search engine results are images licensed under creative commons. Now if you 

don’t know what creative commons is when someone actually puts a picture out on the internet 

or a YouTube video is another good example then that person actually owns that picture or that 

video. So you just can’t go grab it and put it on your website or whatever you’re doing. They do 

have the ability when they actually put that picture or video out there to give it a license called 

Creative Commons. That means that you do have permission to go ahead and take those pictures 

and actually use them. And that’s all this is saying is that all these came up under creative 

common so you can use them. So I’m going to go ahead and just close out of that. And you can 

see here there are several different little pictures that you could use. 

So let’s just say I want to use this one. I’m just going to double click on it or you can click once 

and Insert, whatever works. And there it just put it back into your slide for you.  

Now I can move this by clicking right in the middle of it and dragging the object over to the 

right. And I kind of like this size so I’m going to leave it. But if I didn’t like it I could use the 

control handles we talked about to change the size of the object. 

Now people really like clipart pictures. They’re just fun. They add a little fun insert to your 

presentation. But let me show you something a little more fun you can do with clipart pictures. 

Now let’s go slide two. Let’s say for some reason that I want to add a clipart picture but I want it 

to be an animated clipart picture. And animated ones are ones that actually move. So what you’re 

going to do is when you go to Insert, Online Pictures. Again it’s going to do that Image Search 

but this time I’m going to type in Animated GIF College and let’s see what we get. Now 

animated GIFs are the animated files.  
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Now the thing about these is you can’t really see the animation until you actually put them into 

your slide and then run slideshow. So let’s see if we can find a really good one here. I think I saw 

a really good one up here. Yeah this guy here. He’s running to class. So I’m going to go ahead 

and put him in. So I’m going to choose Insert and let me go ahead and make him a little bit 

bigger real quick. Now he’s not animated right now but if you go ahead and run the slideshow, 

and remember that’s your last button down here at the bottom, then you’re going to see that he is 

animated and you can see him running there. So that’s kind of how that works. Okay? I’m going 

to go ahead and get out of the slideshow here. So you can always put in an animated GIF just to 

give it a little more interest there. 

So we’ve talked about shapes. We’ve now talked about graphics. So let’s move on to the next 

section which is section three and talk about putting in pictures. 
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Video: Inserting Pictures 

Cindy: Okay we’re running down the list here. We’re in module five and we’re talking about 

adding graphics to your presentation to create a visual interest. So we’ve already talked about 

shapes, that was section one of this module. We talked about graphics. That was section two of 

this module. And now we’re in section three and we’re going to talk about putting in pictures or 

photograph type things. So pretty easy to do so let me show you how this works. 

So we’re back in our presentation here and we’re on slide two where we had previously put in 

this animated GIF. I want to take him out now. I’m just going to delete that. Let’s say that 

instead we’ve decided we want to use an actual picture here over on the right. Now when we first 

put in this slide we actually had gone to New Slide and we chose the layout Title and Content. I 

want to change this layout. So I’m going to go up here to Layout and I’m going to choose Two 

Content. Now this way it allows me to put something on the left or something on the right. Just 

wherever I click I’m going to get that placeholder that pops up. 

Now what you’re going to notice here is that you have a button right here that says Pictures. This 

would be the online pictures. So let’s say that I’ve got a picture already saved on my computer. 

I’m just going to click on that and then I navigate to wherever that file is located. Now let’s say 

that in this case I want to put in this one called Graduate. So I’m going to either double click or 

choose it once and insert it. And now you’ll see it’s inserted in my slide. Notice it took on the 

exact size of my object there. So if I wanted it bigger or smaller I can certainly move it if I want 

and change the size of it. Whatever I want to do with it. 

Now that picture is actually sitting on top of the slide. What do you do if you want to put a 

picture in and you don’t have a little button that tells you to click here to put the picture in? Well 

you can still do that. 

So let’s do this I’m going to go over to slide four and click on it and I want to add a new slide 

and I want to add a blank slide. We’ll pretend that later on this would be the last slide in our 

presentation.  

Now all I want to do on this slide is just put a picture of our college campus let’s say. And that’s 

really all I’m going to want here. Now if I do it the same way I’m going to go to Insert, Picture. 

And let’s say this time I choose this one, campus life let’s say. Now you’ll notice the picture is a 

little bit bigger this time and it sits on top of my slide like we just mentioned. So if I wanted it to 

be the exact same size as the slide so I don’t see this blue back here what I would end up doing is 

I would be grabbing the picture and I’d be actually adjusting it using these control handles we’ve 

talked about several times now. And I could eventually make it look decent. But let me tell you 

the problem you’re going to have with this.  

If you’ve got multiple slides in your presentation and multiple slides have pictures on them like 

this the size of your file is going to get really large because this picture is not part of the slide. 
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It’s sitting on top of it. And if you have a lot of slides in here like this it could even slow down 

how fast your presentation runs when you’re running the slideshow. So here’s another option. 

I’m going to go ahead and just delete this picture. I can actually make the picture the actual 

background of this slide and here’s how you do this. 

I’m going to go up to the Design tab and I’m going all the way to the right where it says Format 

Background. Now here the background of the slide itself can be a solid fill. And just to tell you 

what your choices are real quick with this. I can choose a different color if I want or I can choose 

a transparency, meaning it’s a little lighter, a little darker, a little easier to see through kind of 

thing. I might want a gradient. And if you have a gradient chosen you can choose some of the 

presets they’ve got. And gradients are just a mixture of different colors and you can change 

gradient stops and things like that which we’ll discuss a little bit later. But right now I’m trying 

to put in a picture. 

Now the colors or the texture fill that you see here these are part of the particular design that we 

chose when we put our presentation together to begin with. So I want to Insert picture from file. 

Now I’m going to choose the same picture and insert it but this time notice it’s the background of 

the entire slide. It’s not a picture on top of the slide. So therefore your file doesn’t get that much 

larger. Now remember if you wanted to take this little thing off just choose Hide background 

graphics and it’s gone.  

Now let me just show you one other way you might use pictures. I’m going to go to slide one. 

This is our title slide and again it’s kind of boring. It’s just got the title and the subtitle. But what 

if we put a picture of our campus right at the top here? So I’m going to go ahead and take this 

thing off. I’ll hide the background graphics. And this time when I insert the picture I’m going to 

do it this way because I don’t want it to fill up the background of the slide. I just want to put this 

on the slide. But I’m going to go to Pictures and I’m going to choose Our School this time and 

insert it. Now what I can do if I want is I can go ahead and move some of these placeholders 

around, where we had our title and our subtitle already. And I can also make the picture a little 

bit smaller. I can crop it out. There’s just a bunch of different things I can do just to work with 

this picture. So let’s just leave it there for now. I’m going to show you in a little bit how to make 

these words lay on top of the grass here and things like that. But at least I got the picture in and 

we can work with it that way. 

Okay? So that gives you an idea of how to put these pictures in. 

So let’s go ahead and do a little exercise for module five just to make sure you know how to add 

these different things in. And then that’ll wrap up module five. So I’ll see you over in the 

exercise. 
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Video: Exercise 04 

Cindy: Okay so we’re at the module five exercise now which will go ahead and wrap up module 

five. So I want to go ahead and make sure that you’re okay with how to insert those shapes and 

graphics and pictures like we’ve been talking about in this module. So here’s what I want you to 

do.  

Go ahead and open a practice file here called Practice Presentation 5. You’re going to go ahead 

and go to slide two and change the layout to a two column. And then go ahead and use the little 

button over on the right to add a clipart picture using the Online Pictures option, just like we did. 

When you get through with that go to slide three and add a picture again using the Online 

Pictures option. So number two, slide two is going to have a clipart picture and slide three is just 

going to have a regular picture.  

When you get through with that go to the end of your presentation, that’ll be slide three, and add 

a brand new slide using the blank layout. And then you can go ahead and add a picture but don’t 

add it just by inserting it. Go ahead and use the background option we talked about under the 

Design tab to add a background to that particular slide. 

So once you get all that in there go ahead and save and close that file and then we’ll be good to 

go. So you got it. We’re going to go to module six and talk about all those objects we’ve been 

working with. How do you work with them? So I’ll see you over in module six. 
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Chapter 6 – Working with Objects 

Video: Selecting Objects 

Cindy: Hi it’s Cindy. Welcome to module six. We’re in PowerPoint 2016 and we’re talking in 

this module about how to work with objects. Now remember that objects can be things that you 

drew. So they could be drawings. They could be pictures you put in. Objects can be a lot of 

different things. So let’s talk a little bit about how you select those objects because that’s going 

to be very important when you start doing anything else with objects. 

Okay so we’re back in our presentation and we’re on slide four and this is the one where we had 

used our drawing tools right up here and we had drawn all these different shapes and things. 

Now we were just playing when we were on this slide so we have just objects and shapes all over 

the place. So let’s talk a little bit about how you actually select them. 

So first of all if you wanted to select one object just click on that object. And you can see when 

you do that that you get your placeholder that appears around the object. Also you’re going to 

see your control handles and then we’ll talk a little bit more about this here in a moment. But just 

remember to select one object, click on that object. Now if you have multiple objects you’d like 

to select and they’re just random on your screen hold down the Control key on the keyboard and 

just click on those additional objects you’d like to select. Now if you happen to get one you don’t 

want then just as long as you’re holding Control you can click back on that object and you’ll 

actually deselect that one. So just hold Control to randomly select objects. 

Now sometimes you’re going to want to select objects that are actually kind of hard if you’re 

holding down Control. So here’s what I mean by that. Let’s say that I wanted to select this star 

and this banner. I could hold Control and click on each one but I can also do what’s called 

drawing a net. And let me show you how that works. 

Now when you do this you can start in any corner. I’ll just start in the bottom right. And you’re 

not holding any keys on the keyboard. You’re just going to click the mouse. Now if I click the 

mouse and I just hold it the whole time and pretend like I’m drawing a box around these two 

objects like this then when I let go both objects are going to be selected. Now before I let go a 

couple quick things. Notice I am partially on the smiley face. That’s okay because as long as the 

total object is not included in your net then you’ll be fine. Also make sure you get every single 

piece of that object within your net. If I’m trying to select the star on the right here and I leave 

out the tip of one then it’s not going to be in my selection. Now I’m going to let go of the mouse 

and notice both of these objects are selected. Now deselecting is just clicking away from your 

object.  

So let me give you another example. If I come up to the top here and just hold the mouse and 

draw a big box around these just like this notice that I’m going to have my star on the bottom 

http://www.simonsezit.com/


Learn PowerPoint 2016 

© Copyright 2008-2013 Simon Sez IT, LLC. All Rights Reserved. 

right and the little lightning bolt on the top right in my selection. Also I’m going to have my “I 

am drawing objects” in my selection too. See that? So anything that was in that box is going to 

be part of my net and will be part of my selection. So just remember that. We’ll be using a lot of 

those selecting techniques as we go forward.  

So now that you know how to select objects let’s briefly talk about how to edit an object. So 

that’s going to be over in the second section. I’ll see you shortly. 
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Video: Editing Objects 

Cindy: Okay welcome back to PowerPoint 2016. This is module six where we’re talking about 

how to work with objects. Now this is section two where I’m going to show you a couple things 

about how to edit your objects. There’s going to be times when you want to change your size of 

your object. Maybe you want to rotate it, delete it, copy it. Those are things that are considered 

editing. So I want to show you how to work with those. 

Okay so first of all a real quick little selecting technique that we didn’t talk about in section one. 

But if you want to select everything this is your general across the board in any of your Office 

products how you select everything. Hold down the Control key and hit the letter A. That’s your 

select all. So just remember that. Anything you do now is going to affect all of your objects. So 

I’m going to go ahead and just deselect that. 

Now let’s talk first of all about deleting objects because I’ve got so many of them here that I 

want to go ahead and just get rid of a few of them.  

So all I’m going to do is select an object and just hit Delete on the keyboard. That’s all you have 

to do. That would the same thing for a slide by the way. So if you happen to be over here and 

you’re clicked on let’s just say slide two, for example. You could right click and then you have 

the option to delete a slide or you could just hit Delete on the keyboard. So just remember that. 

Alright I’m going back to slide four. So let me delete one more. I’m going to delete this line. So 

see how I select the line and I get the control handles on the end. I’m going to delete that one. 

And then I’ll go ahead and delete the smiley face here.  

Okay now we’ve got a few objects we can kind of work with. Now if I select and object you’re 

going to see the control handles we’ve been talking about on the corners and also on the sides 

here. And remember, those allow you to change the size of your object. So if you get in a corner 

you can move two borders at once. If you get on the top or the bottom you can make it look like 

this or like this. So really this object can become any size that you want it to be. And remember 

if you want to move an object just click in the middle of it and hold your mouse and just drag it. 

That’s going to allow you to move it. Now you might have also noticed there’s this little arrow 

right up here. It looks like a round swirly arrow. Now what that’s for is if you wanted to rotate 

your object. So see if you just put your mouse on it and hold you can drag and rotate this object. 

So you can rotate all the way round if that’s what you wanted to do. But it can be anywhere you 

want it to be. 

Now keep in mind when you have more than one object selected anything you do is going to 

affect both of those objects or all the ones you have selected. Okay? So if you’re trying to affect 

one just click on that one.  

Now let’s talk for a minute about copying objects. 
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I want to make a copy of this object right here and I could just draw another one but it’d be kind 

of hard for me to get it the exact same size. Now you can right click and copy is one of your 

choices. That’s certainly okay. Some people prefer to use the keyboard shortcuts. Control-C is 

your copy. Control-V is your paste, V as in Victor. But here’s a little trick that’ll help you out, a 

little faster sometimes. If you’re holding down the Control key on your keyboard and you click 

and drag your object. Let go of the mouse first and then you’ll have two of them exactly alike. 

So that’s very helpful. Hold the Control key, drag the object and let go of your mouse first. If 

you end up letting go of the Control key first you’ll end up just moving it. So just kind of know 

that. Now I’m going to delete this one that I just set up here. 

Okay now one more quick thing I want to show you and this looks really good with the star, for 

example. Let me move some of this other stuff out of the way and get rid of it.  

Now I’m going to show you how to do something called duplicating. And this will work with 

any object. If you hold the Control key and hit the letter D and you can hit the letter D as many 

times as you want. D stands for duplicate. Notice now I’ve duplicated these stars. Let me move 

this banner all the way here. So now if I wanted to do something like line these up and I want to 

put them straight across, maybe group them so they’re one object. I can do all of those things 

because I have multiple objects. 

Now back to something we talked about in the first section, the selecting. Remember how I 

showed you about drawing the net? If I wanted to line these stars up across I could but I’d have 

to select them all first. And it’s very hard to do just holding the Control key. So if you draw your 

net like this, notice when I let go that all of the start are going to be selected. So now whatever I 

do next I’ll do with all of the stars.  

So we’re going to talk about lining those up here in section four of this particular module so just 

kind of stay with me on that. But just kind of know how to duplicate any objects. I could 

duplicate this if I wanted to up here. Hold Control and hit the letter D. Okay? So just kind of 

know that. 

Alright. So that’s a little bit about editing your objects. So we’re going to move on and talk now 

about actually formatting those objects. 
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Video: Formatting Objects – Part 1 

Cindy: Hey. Welcome back. This is Cindy. We’re working in module six where we’re talking 

about how to work with objects. Now we’re down in section three where we’re taking about 

formatting your objects. And basically formatting just means taking the original characteristics 

of the objects you have and changing them. So if you didn’t like the color inside of an object you 

drew you could change that. If you wanted to give it a little shadowed effect you could change 

that. So all of that’s considered formatting.  

Now I just want you to know that there are two parts to this particular section so go ahead and 

make sure you watch both parts to this. There is a lot of different options here so don’t get 

overwhelmed. A lot of it you’ll just learn as you start playing with it. But at least you’ll kind of 

know where to go when you’re looking for some of these different objects. So let’s jump right in 

and you’ll see how fun some of this stuff. 

Okay so I took the liberty before we got started to go to slide four and go ahead and delete all of 

those objects. I wanted to put something in that looks a little bit nicer. So you already know how 

to draw your shapes. I’m going to come up here and I’m going to draw this one. And let’s say 

that I’d like to have three of these. So remember the quickest way to copy an object is to hold the 

Control key and just drag your object. And that way you end up with them all the exact same 

size. Now I purposely misaligned these because we’re going to talk in section four abut how to 

range your objects. 

Now I’m going to go ahead and grab a block arrow. We’ll say this is something like a little flow 

chart here. Okay? And let me put a couple more objects in. Let’s go ahead and put in a sun. So 

the sun looks a little bit like this. And one more. We’ll just put in what’s called a callout. We 

talked about those a little bit earlier as well. And there’s a callout. 

Okay. Now we also talked about the fact that you can type inside of any object. So you just 

select the object and start typing. So we’ll say the first one is welcome. This one will be all about 

our campus. And let’s say this one is about the graduates. Now if you have an object that is not 

wide enough you’re going to see that it will word wrap like this. You can always change the size 

of your object if you need to but remember that means that this one is a different size from these. 

So let me undo that and show you that if you have all three selected and you change one then 

they’re all three going to change. So that way you can keep it all the same size. Okay? 

Now if you wanted to change the color of the font go ahead and select the object and this is your 

font color. You already know this one. You don’t have to drag across the text. Just select the 

object change your font color. Okay? 

Alright. So let’s start talking a little bit about some of your drawing tools that are available. Now 

before I click on your Drawing Tools contextual tab, see how it’s there if you select your object 

and if it’s not if you click away from it? So before I talk about that I want you to know that some 
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of the more common options we’re going to be talking about are also listed here on your Home 

tab under this Drawing grouping. So I’m going to click on the Drawing Tools contextual tab. 

Now the first thing I want to show you is this. You may draw an object and later decide you want 

another one that’s similar to this one. Well you don’t have to delete your object and redraw it. 

You can change the shape. 

So you’ll notice up here where it says Edit Shape there’s a Change Shape option which shows all 

your shapes. You just click the shape that you want to change your current one into. So if I click 

this first one you see it now changed to the next shape and it took that little corner off. So I’m 

just going to undo that but you can always change your shape. 

Now the next thing I want to look at is the shape styles right here. Now these are what they call 

theme styles. So if you needed a quick way just to change the color, maybe the font, the line 

around the object, you can pick from some of these predesigned ones. So if you liked one of 

these you could just choose it and then it would take on all those characteristics. But if you really 

wanted to spend time working with your object then you’re going to want to use these three right 

here. You’ve got your shape fill which is changing the inside of the object. You’ve got your 

shape outline which lets you change the line around the object. And then you’ve got some 

effects. So let’s start with an outline in the middle here. 

You might not realize it but every object has a little line around it unless you’ve taken it off and 

you can barely see it in this case. But we’re going to change the color and then make it a little 

thicker so it stands out. 

So I’m going to Shape Outline and I’m going to pick a color. Now this is your theme colors. You 

can pick from these. These are your standard colors. Now what these represent are the colors that 

were part of the theme that you chose when you started your actual presentation. And the one 

that says Recent Colors, those are colors you’ve manually picked and it gives you an easy way to 

go back and choose them again.  

So let’s say that I want this one right here. Now you can barely see that it changed that color 

there but it did. So let’s make it a little bit thicker. See how if you get on to the weight you can 

choose a thickness. Now you can really see it when I pick that six point one there. So you can 

always change the line around your object.  

Now let’s talk about also what’s called the dashes. So if I don’t like that straight line around my 

object I can come down to where it says Dashes and I can choose a dotted line, I can choose a 

dash line. You can kind of see the different choices here as I move the mouse over them. So let’s 

say I pick round dot. And now you can see I have a different shape for the line around the object.  

Alright. So let’s move over to this next object and talk a little bit about your fill. And remember 

the fill is whatever is inside of your object. It could be a color, a picture, a texture who knows. So 
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we’re going to go back to Shape Fill and remember you’ve got these colors you can pick from. 

These are your theme colors. Now what I didn’t tell you earlier with the line because it’s kind of 

hard to see is that sometimes you don’t like any of these colors and you have the ability to create 

your own. So if you don’t like these colors go down to where it says More Fill Colors. And when 

you get in here you’re going to see a Standard tab and a Custom tab.  

Now starting with the Standard tab. If you liked one of these colors you could just choose it. This 

would always be your new color. If you pick a color and you need a little more transparent use 

the transparency slider at the bottom to change that color a little bit.  

Now let’s say that you don’t like any of these colors. If you go to Custom you can create your 

own color. The way this works is you just drag your mouse through the colors and generally you 

kind of have an idea before you start that you’re looking for a green or a red or whatever color 

you’re looking for. But let’s say this ones pretty close. Now over on this little slider you take 

your mouse and take this arrow and just point to the exact color that you want and that’s going to 

be your new color. Okay? Alright. 

Now when I go back to Shape Fill I want you to notice something. You can also take all of the 

color out. So let’s say that you wanted to show what was behind this particular object, whether 

it’s the slide or there’s another object back there. Then that just takes all the color out. That’s all 

that does. Okay. I’m actually going to leave this one.  

Now I’m going to come over here to this one that says Graduates and I want to show you how 

the eye dropper works. Now sometimes it might be that you want a color and you can’t find that 

color. You can’t make it yourself. You just can’t get the color. But maybe the color you wanted 

was in a clipart picture or in a photograph you had. So let me go ahead and just put a picture in. 

I’m just going to go up to Insert and I’m going to insert a picture that’s on my computer. And I’ll 

put in this one called School Pic. There you go. Now let me just change the size just a little bit 

and move it out of the way for a second. 

Okay. So let’s say there was a particular color in here that you wanted to be the background for 

this particular object. You can use the eye dropper to suck up that particular color. Now I’m 

going to go back to the Drawing Tools contextual tab, Shape Fill and I’m going to click on Eye 

Dropper. Now see how my mouse looks like a little eye dropper. And when I point to a certain 

color you’ll see that I’m going to be able to suck up that color. Let’s see if we grab this red here. 

And see how it put that color inside of my object? So you can always put a color inside of your 

object. 

Okay something else I wanted to show you as far as pictures are concerned. This picture that I 

put in over here I just inserted it onto the slide. So if I wanted to actually make it look like it’s 

inside of one of these objects I could drag it over like this and I can try to make it the same size. 

But you know it’s still an object on top of another one and it’s never going to be the exact same 
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size. I can’t cut this little corner off in this picture. So here’s what you want to do when you want 

to put a picture inside of your object. 

Select your object and you’re going to use the Shape Fill again. Don’t use Insert Picture because 

that will just put it over here like this one. So what you’re going to do is once you’ve clicked on 

your shape fill you’re going to go to the picture option. And then here you can pick your picture 

from a file or you can do a Bing search. And just choose it this way and choose Insert. And now 

the picture is actually inside of your object. You can see it took on the constraints of the object 

itself. So that’s kind of cool how that works. Now if I wanted to I could move this text. I could 

take it out, whatever I wanted to do. But we’ll leave it there for now. 

So that’s going to give you a good idea of how to work with the fill. So what I’d like to do now 

is wrap up this part of section three and let’s go over to the second part of section three and 

continue with some of these formatting options. I’ll see you over there. 
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Video: Formatting Objects – Part 2 

Cindy: Okay welcome back. We’re still in module six where we’re talking about formatting 

objects. And we’re in section three but now we’re in the second part. So I wanted to go ahead 

and finish up talking to you about all those different formatting options that you have. 

Okay. So when we left off we had actually put a picture inside of one of our objects. So let’s talk 

a little bit more about working with some of those different fills that we have. Now I’m going to 

go back to the one that says Campus here and I’m going to go back to Drawing Tools, Shape 

Fill. Now you might have noticed that you can also put a gradient inside of your object. Now a 

gradient is just a lighter or a darker variation of the particular color you already have chosen for 

your object. So you can see that some of these actually have a darker color in the middle and it 

gets lighter towards the outside or vice versa when you look at some of the darker variations. 

Notice also if you want to take it totally out you can say that you don’t want a gradient at all by 

choosing No Gradient.  

Now the last option you have under Shape Fill here is your textures. Now textures are these 

different looks that you can put inside of your object. They have a textured effect. You’ve got a 

paper bag effect which is kind of cool. You’ve got a fish fossil. This one here is a blue one. It’s 

called denim. So you can kind of see the different options you have. Now I’m just going to go 

ahead and leave it on the paper bag for now and you can see how it looks like a paper bag. 

So those are the quick, easy options you have under your Shape Fill. Now something I want you 

to know about all of these is you’re going to have additional options for each one. So just kind of 

hold that thought for just a few minutes.  

Now we talked about the fill. We talked about the outlining. Let’s talk a little bit about your 

shape effects.  

Now I’m going to go down and click on this particular object here. Now they have some preset 

ones you can choose from. Notice if you just move your mouse over the different presets here 

you’ve got different ones you can pick. I’ll pick this preset nine. You can also put a shadowed 

effect on your object. Now they have outer shadows which go on the outside of your object. You 

can kind of see a little shadowed effect right there. Also under shadows they’ve got the inner 

ones and then the perspective. The perspectives lie on the ground. And you can kind of see the 

shadow right back here.  

Now in addition to a shadow you can pick a reflection. So if you want to see a reflection of your 

object there’s different ones you can pick from. You can kind of see these here. And let me just 

move this over here to show you so you can really see it. I’ll move this out of the way. But see 

that’s a reflection of your object down here.  
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Alright you can also pick a glow. So if you wanted to have a soft glow you can have one around 

your object. And they come in different colors. Also if you wanted to have soft edges you can 

choose softer edges. You can see that you’ve got 10 points, you’ve got 25 point, just different 

point sizes for your edges. You can also have a beveled look. So you can kind of see some of 

these. That one’s pretty cool. 

And then the last one at the bottom is a three-dimensional rotation. Now let me just do that on a 

different object. I’ll pick this one. So when I click 3-D Rotation you can see I can rotate my 

object in any of these directions that you see here. Okay? Alright I’m going to undo that but you 

see you can rotate your objects. 

So those are going to be your quick formatting options. Your fills, your outlines and your effects. 

Now we’re going to take all this a step further because I want to show you that for each of these 

you’ve got a lot of little options that have to do with those. 

Okay see this arrow where it says Shape Styles and you can format your shape? This is going to 

turn on an area on the right where you can work with you fill, you can work with your effects, 

you can work with size and properties, or with pictures. So I’m going to start with fill.  

Now some of these options we were able to get to up here but they’ve taken these a lot further. 

So for example with solid fill we already know we can change our color and we can change our 

transparency. So we can have any color we like here. Notice the gradient fill. We’ve already 

talked about the fact that you’ve got these preset gradients you can pick from if you like any of 

these. But you can also have a different type. So if you want it to be more rectangular or you 

want that color to be more of what they call path you can kind of see those in there. You can see 

there’s more white in the middle of this one and the green around the edges.  

Now also you can work with direction depending on which color you’ve chosen. And that’s 

going to be the direction that the colors flow within your object and the angle and then the 

gradient stops. Now here’s what gradient stops do. This particular one has green and white in it. I 

can slide this slider a little bit to the right and see more of the green or more of the white or vice 

versa. So see how you can move them to the left and move the colors this way and your colors 

move in a little bit towards the center. So you just have to play with these and get it to the exact 

way you want it to look. Here’s your color down here and your position. Also you can make this 

a little more or less bright or you can work with the transparencies.  

Now notice the line down here. When we talked about the line around the object. If I wanted a 

solid line I can choose the color for my line. We kind of already talked about this. I can choose a 

weight or a width or a thickness. So remember we talked about the higher the number the more 

thicker the line is. We can have a compound type. So if you wanted to have double lines you 

could instead of just one single line. You can have rounded corners or square corners. And you 

can have a join type if you want it to be more of a miter type type or a beveled. But you can see 

there’s a ton of different options right here. And the reason you have these arrow types is 
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sometimes a line you draw can have arrowheads and then these would be available so you can 

choose a different arrowhead types you might want.  

Okay let me scroll back up to the top here. So you can see there’s a lot of options. Now the 

second one is the effects we talked about. Remember the shadows and the reflections and the 

glows? Well again we’ve got these predetermined ones we saw from our dropdowns but now we 

can actually go through and change the colors. So if you remember this one where we had a 

shadow. What if I went through and changed the color of my shadow? Then I might be able to 

see it a little bit better. Or you can see it right there. Or if you changed the glow, the reflection, 

all of these things we talked about. You can change your three-dimensional format if you want 

down here near the bottom. Tons of different options. And also your 3-D Rotation at the very 

bottom. So you want to go in here and play with all these options because there’s so many things 

in here. So, so many. Okay?  

So let me go ahead and wrap that up right now because I want to give you time to kind of go 

through every single one of these and play with them. And remember this, just a little something 

you can do just to get you thinking a little bit. If you ever have a picture that you want to work 

with and you’re not doing a PowerPoint presentation. Let’s say it’s something like maybe you’re 

working on a website and you have a particular picture but you want to use some of these 

PowerPoint options to change the picture. Feel free to copy the picture into PowerPoint and then 

use all of these options and you’ll get some really cool effects when you do that.  

So we’re going to be talking more about pictures in module seven. But before we talk about 

pictures we’ve got to talk about how to arrange these objects so they look a little bit nicer when 

you’re working with your slides. So I’m going to see you over in section four. 

  

http://www.simonsezit.com/


Learn PowerPoint 2016 

© Copyright 2008-2013 Simon Sez IT, LLC. All Rights Reserved. 

Video: Arranging Objects 

Cindy: Okay good to see you again. We’re still in module six where we’re talking about 

formatting our objects and now we’re going to talk in section four here about arranging objects, 

making them look nice and neat on our slide. So let me show you how that’s done. 

Okay so we’re here on slide four and we’ve got these five objects. Remember these arrows are 

an object as well. That’s why I said there’s five objects. Now I want to do some things like I 

want to make them look a little bit nicer. I want to center them on the slide, things like that.  

Now a first thing is this. I want to go ahead and take this formatting and put it inside of Campus 

and Graduates as well so they have some sort of similarity. Don’t forget that you can always use 

Format Painter to copy your formatting from one object to another. So I’ve selected the object I 

want to copy from. I’m going to click Format Painter on the Home tab and then click inside the 

object I want to copy to. And now you can see they have the exact same formatting. A little trick 

with this. If you know that you’re going to copy this to multiple objects when you first click 

Format Painter double click it and it will stay on until you turn it off. And you would turn it off 

by hitting Escape on your keyboard or go back and clicking on Format Painter again. 

Now I’m going to line these up. So the first thing I’m going to do is select them all. So I’m going 

to draw my net. Now I want to line them up let’s say with the top of this particular one, 

Graduates. Now first of all notice that I’ve got these arrows selected as well and I’m going to 

deselect them just by holding Control because if I leave them selected they’ll also line up at the 

top and I don’t want them to do that.  

Now you can get to the options for alignment a couple of different ways. If you’re on the Home 

tab you’ll see there’s Arrange. And if you’re under Arrange you want to choose this Align 

option. Now when you’re aligning objects if you’re going to line them up and down you’re going 

to use these three. These would let you find the object furthest to the left and line them up, the 

center or the right. If you’re going to line up objects across use these three and you can see from 

the little picture there. You can align the top, the middle or the bottom. I’m going to align the 

top. And now you’ll see they’re all lined up exactly alike.  

Now if the arrows happen to be not lined up themselves. Maybe they look something like this 

then I can do the same thing with just the arrows. I would go back to Arrange, Align and I’d 

align probably in this case the middle and there they are. So you can always line your objects 

that way. 

Now another thing is the spacing. You can kind of see that the spacing here is not the same as 

here and not the same as this or this either. So I’m going to select all the objects and here’s how 

you line the spacing up so the spacing is exactly the same between all of your objects. You’re 

going to go back to Arrange, you’re going to choose Align and this time choose Distribute 

horizontally. Notice if your objects were up and down you could distribute vertically. So I’m 
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going to distribute horizontally and now every object has the exact same amount of spacing 

between it. It looks a lot nicer like this.  

Now the next thing I want to do is I’d like to center these on my slide because right now they’re 

kind of over to the left. Now what you can’t do is select the objects and hit the centered button. 

That’s not going to work because that’s just the text within your object. So let me show you how 

to turn on the guides that will help you when you’re trying to line objects up. 

If you go to the tab that says View you’re going to see a checkbox that says Guides. And you can 

see your guides right here. Now typically they automatically are on zero and zero this way. The 

reason I moved mine is because it was over here on the two. See how you can move the guides 

anywhere you want them to be? Now technically if you think about this one left to right this 

center control handle is the center of my objects from left to right. So I can grab any one of these 

since they’re all selected and drag them. And as soon as this control handle is right on the line 

then I know they’re centered. Now if you’re having trouble getting them right on the line you can 

get them close and then use your arrow keys that go left, right, up, or down to help you line up 

your objects. But now you can see that they’re lined up perfectly from left to right. 

Now if I’m trying to line these up in the middle of the slide altogether I’m going to grab these 

and drag them down like this. And I’m trying to put this center control handle on that line is what 

I’m trying to do. So I’m going to go down a little bit just like this, perfect, and then I’ll go left a 

little bit just like this. And now they’re lined up perfectly from top to bottom and left to right. So 

that’s the center of my slides. 

Now let me just show you the grids real quick. I’ll take the guides off for a second. Here’s your 

gridlines. They look like smaller little squares on your screen. Now gridlines just let you line up 

objects that are smaller. Maybe you’re not trying to put them in the center of the slide but you 

just want to line things up. You can actually take an object and move it as close to a gridline as 

possible and then line them up that way. So those are going to help you when you’re working 

with lining up your objects. 

Okay I’m going to go ahead and turn the gridlines off.  

Now let’s say that I want to have some picture behind these objects just to make them stand out a 

little bit more. So I’m going to go and grab a picture that I’ve got. So I’m going to go to Insert 

Pictures and let’s say I grab this one here. Now right now if you notice it’s sitting on top of these 

objects. So objects can layer as it’s called. And you have the ability to move them backwards or 

forwards in the stack. Now before I do that I want to go ahead and make this a little bit bigger 

just so that it’s going to look a little bit nicer when we get it here. And let’s just say that I want to 

do something like this. I’m going to go ahead and make it much bigger. Now see how it’s sitting 

on top of my objects and I can’t see them? Now if you have your objects selected you can use 

under your Picture Tools contextual tab the bring forward or send backward options. So I’m 

going to send this backwards.  
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Now a couple of things. See the dropdown arrow? If you send something backwards it goes one 

layer at a time. See how if I send backwards I’m going to see one object at a time that pulls 

forward? Now I could have said under the Send Backwards to send to the back. And that moves 

it all the way to the back of the stack. Now you might have also noticed that sometimes this 

Selection Pane pops up. All this is is instead of me clicking to select an object it allows you to 

click here to select an object if you wanted to do it that way. That’s all that is. So I’m going to go 

ahead and close that out. 

But see now how I’ve got something behind my objects? Now we talked a lot about the fact that 

you can actually make objects a little bit darker, lighter, things like that. We’re going to be 

working with pictures in module seven and I’m going to show you how to lighten this up back 

here so these stand out a little bit more. So you can always work with your objects and arrange 

them like that.  

So let’s go ahead and talk over in section five here about how to group these.  
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Video: Grouping Objects 

Cindy: Okay so we’re getting ready to wrap up module six where we’re talking about formatting 

our objects. And this is going to be section five where I’m going to show you how to group 

objects. 

Okay so we’re back on slide four and we’ve got these objects here that we lined up previously. 

And we can certainly leave them this way but a lot of times it’s easier to work with objects if 

they’re grouped together. So I’m going to go ahead and select all five of these objects and what 

I’m going to do is I’m going to go back to Arrange and then you’ll see Group. And if I group 

these together they’re now one object. So I can move this one object anywhere I want. And 

notice that they don’t come apart because it’s all one object. Now if I want to ungroup them I just 

go back to Arrange and now Ungroup is available.  

Now you don’t have to group objects that are lined up. They can be totally nowhere near each 

other in order to group them. So let me show you what I mean by this. 

Let’s say that I add a couple things to this particular slide here. Let’s say that I go ahead and put 

in this number twelve like this and then let’s also go ahead and add, I’ll just put this sixteen point 

star up here. So if you notice these two objects are nowhere near each other. But if I select both 

of them and do the same thing, I can go back to Arrange and I can choose Group. Now these are 

one object. See how if I move one they both move because it’s one object. Now let me ungroup 

those.  

Now here’s a better example. Let’s say I have something like this. I want to go ahead and draw a 

star and I want to put a little one down here like this and let’s say I change this a little bit and I 

put one over here exactly like it. Now I probably want to line them up but if I wanted to group 

them I just select them both, go back to Arrange and group. And now they’re one object. So if I 

wanted to move them to the top for some reason it’s easier to do because they’re just one object. 

So just remember that you have the ability to group or ungroup objects like this. Now let me give 

you another example. 

I’m going to go ahead and ungroup these. So I’m going back to Arrange and I’ll ungroup. Now 

let me go ahead and move one of these up to the top like this. Do you remember how we talked 

about duplicating in a previous section? You’re just going to hold the Control key and hit D for 

duplicate several times. Well I’ve got this neat little cascading effect with these stars now and 

that’s kind of neat but I’d like to line them up across let’s say. So in order to do that I’m going to 

have to select all of them. Now that they’re selected I can change them so they line up across or 

up and down. I’m going to go back to Arrange and if I go down to Align I’m actually going to 

align these, I’ll align center because they’re going up and down. So see that? They’re nice and 

aligned up and down. The problem is they’re still multiple objects. So if I wanted to move this 

whole set of stars over to the right I’d have to select them all first. Notice now if I go ahead and 
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select them and then group them they’re one object. So I can move that one object over here if 

I’d like or I can move it down here if I’d like, whatever I’d like to do with it. It’s one object. I 

could even rotate it if I want and then it’ll look like this. Maybe I could rotate it like this. So it’s 

very easy to group and ungroup objects. Just remember you can do that and it makes it a whole 

lot easier to work with objects. 

So that’s going to wrap up module six here. Let’s go ahead and go over into the exercise. I’ve 

got a few things I want you to do here and then we’ll go over to module seven. 
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Video: Exercise 05 

Cindy: Okay so this is the exercise for module six and I’m going to have you actually just go 

through and do a couple things for me.  

So first of all you should have a file called Practice Presentation 6. Now when you get in there I 

want you to add a slide. You can add it at the end so it would be slide number four. Use the blank 

layout when you add this slide and go ahead and take the background graphics off. Now just start 

drawing a few objects. Just kind of play here. And what I want you to do is once you get some 

objects drawn and you’re comfortable with it go ahead and go over some of those formatting 

options we discussed. Remember we talked about using the fill which is going to be the color or 

the picture or whatever you put inside of the object. We talked about the line around the object. 

And also we looked at effects. Those were your shadows or your three-dimensional effects. So 

just make sure you know where all those are and how to play with them. Take a few of those 

objects that we practiced and go ahead and learn how to group and ungroup them. And also take 

a picture and put it inside one of the objects you drew. 

So just take a lot of time on this one and just kind of play with it. And when you feel like you’re 

comfortable with it go ahead and save the file and then go over to module seven and we’ll talk a 

little bit about working with pictures. Okay? 

Great job. 
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Chapter 7 – Working with Pictures 

Video: Picture Options 

Cindy: Hi there. Welcome back. This is PowerPoint 2016 and we’ve made it down to module 

seven now and we’re going to talk about working with pictures. 

Now so far we’ve actually put some pictures in our presentation and we even took one and put it 

inside of an object. But we haven’t really worked with changing colors or cropping pictures or 

anything like that so that’s kind of the idea of the things that I want to get into in this particular 

module.  

Now we’re in the first section here, the Picture Options, so let’s look at some basic things you 

can do to change the look of the picture. 

Okay so we’re back in our presentation here and I’d like to go back to slide two. Now we had 

actually inserted a picture here on slide two and if you notice this picture really doesn’t look 

right because this blue clashes with the blue that’s in our presentation. So let’s say first of all that 

you want to keep the blue back here but you just want to fix it so it doesn’t look so bad. So 

here’s a couple things you can do.  

So first of all we can add a border to this picture. Now remember when we did this with objects 

we just used the Shape Outline and we had all of these options. I wanted you to know that when 

you’re clicked on a picture your Picture Tools contextual tab appears and all of this has to do 

with pictures. The Picture Border option right here, these are the exact same options we saw just 

a second ago under the Home tab. So it doesn’t matter which one you use. 

So first of all let’s pick a color for our border. And we can see it there but remember that if you 

really want it to stand out go ahead and play with the weight and the dashes. Now remember the 

weight is like a thickness for your line and the dashes that’s going to allow you if you don’t want 

a straight border you can have dots or dashes or any of these other dash options that you see here. 

So I’m just going to leave it on a straight line for now. But you’ll notice that just by adding a 

border this picture looks totally different. It just stands out and the blue doesn’t really clash. As a 

matter of fact you don’t really notice it as much. So any picture you can apply a border to like 

this and it just really enhances the picture. 

Now if we look over here at Picture Effects this is where you can actually have a shadow around 

your picture if you like. And we had seen some of these options when we worked with our 

objects. Remember you have outer shadows, inner shadows and you also have perspective 

shadows. Those are the ones that kind of lay down on the ground just like this. 

We also had talked a little bit about the fact that you can have a reflection. So if you want your 

picture to have a reflection you can do that and you’ll see the reflection right down there.  
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Now you can also work with the glow. Remember that’s going to be a nice, soft glow around 

your picture and you’ve got different variants of that you can choose from. You can also pick 

soft edges. And also you had the ability to go back and pick from the bevel options. So 

remember you might want your picture to have a bevel look. 

Now the last one was those 3-D Rotation. So you can see here that you can rotate your picture at 

any angle that you like. You’ve got some perspective options, you’ve got some oblique options 

down here at the bottom. You’ve just got a bunch of different options you can work with here. 

Okay? Now I’m not going to leave it like that but I wanted to show you that those are some 

options that could look pretty nice depending on which options you chose there. 

Now let’s go ahead and put this picture back the way it was when we started. Now I want to 

show you this little option here.  

If you go all the way to the left here do you see this Reset Picture? This allows you to reset the 

picture and if you want to reset the picture and the size you can do that too. I’ll just reset the 

picture. And you’ll notice it took all the formatting off that I just applied. So don’t forget where 

that option was. When you click on your picture it’s Reset Picture. 

Now also instead of just manually picking these which are certainly okay, you can look at the 

Picture Styles. Now if you just move your mouse over some of the different styles here you’ll see 

that some of these are pretty cool actually. Like this one’s pretty neat. Or if you wanted more of 

a circle effect you can have that. So you can see there’s all kinds of different ones you can pick 

from here. So I’m going to leave that one for now. Okay?  

So don’t forget you have Picture Styles and then you can work with the border and the Picture 

Effects here. 

Now these options here we’re not really going to get into too much right now because those are 

just like we talked about with objects in module six. You can layer your pictures, move them 

forwards or backwards in the stack. If you had multiple pictures you could align them using your 

align options here. So just don’t forget that those are there if you need them. Okay? 

Alright. So what I want to do now is go ahead and look at section two of this module because I 

want to show you how to crop pictures because sometimes you don’t need everything that’s in 

the picture. 
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Video: Cropping Pictures 

Cindy: Okay welcome back. We’re working in module seven with our pictures and now in 

section two let’s talk a little bit about cropping your pictures.  

Now sometimes there are areas of a picture you want to keep and other areas you don’t. And you 

want to be able to go in and actually get rid of those areas that you don’t want. So let’s talk a 

little bit about how that works. 

Okay so we’re back in our presentation and we enhanced this picture a little bit in section one by 

playing with some of the options that were under the Picture Styles. But I want to reset this 

picture for a moment.  

Now what if we didn’t want to use one of those styles? Let’s say we wanted to keep this diploma 

and this hand and maybe this arm here but we don’t want that blue in the background. We can 

actually get rid of that. Sometimes you just take a part of the picture and cut it out and then other 

times you mark the areas you want to cut out. So let me show you both ways. 

Now if I click on the picture and I go back to my Picture Tools contextual tab I want you to 

notice that right over here is your cropping option. Now if I wanted to, let’s say I want to get rid 

of everything except the little bit of the hand and the diploma. So maybe cut it off about right 

here. I can actually turn on this crop and I can grab this cropping button right here and drag up 

like this. And so you can do that on any side or in the corner if you wanted to crop out part of 

your picture. So when I click to the side you’ll see it just looks like this. Now that area of the 

picture is still there. It’s just hidden. So the size of the picture has not changed. So just keep that 

in mind.  

Now if I wanted to bring it back I can just turn the cropping tool back on and I can crop and then 

I can pull it back down like this and then I can see the parts that I hid. So you can always work 

with it that way. 

Now the only thing about using that cropping tool like that is that I’m able to pull the sides in or 

out but I’m not able to go right in the middle and grab something and get rid of it. So just kind of 

know that for now. 

Now you had another option under Crop here and that was to Crop to Shape. So let me show you 

what that would look like. 

Now these are your shapes that you could draw and let’s just say that I pick one of these. Notice 

I have cropped my picture to fit in that shape that. So that’s an option you’ve got as well. Now 

I’m going to undo that.  
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But what if you really just want to get rid of the blue in the background here and see just the rest 

of the picture? Then you can actually do that but you don’t do it with the cropping tool. So here’s 

what you’re going to do. 

If you notice all the way to the left here it says Remove Background. So when I click on the 

Remove Background button then what you’re going to notice is that you’ve got this little box 

that’s inside of this bigger box here. Now the way this is going to work is I’m going to go ahead 

and use the control handles to include in the box all the parts of the picture I want to keep up and 

down. If there’s some parts left to right I want to keep as well then I can drag this way to keep 

those. So it’s kind of up to you. But whatever is inside this box here is what you’re going to 

keep. Now if I do something like this and now I click to the side you’re going to see I’ve taken 

away that blue background that was there and it just looks like the picture belongs on this slide. 

So it looks a lot nicer this way. But remember it’s just like cropping. Those options are just 

hidden. So just kind of remember that.  

Now you can do a couple of other things. So when you were on the Remove Background you 

might have noticed there is an option to mark the areas to remove or to delete or discard all the 

changes. Let me discard all the changes for a second. Now if I go back to Remove Background 

here’s another way I could have done this. I could have just marked the areas that I wanted to 

remove. So what I could do is when I click on that I can draw like a line just indicating the areas 

that I want to remove. And then if I click away from it it looks the same way. Now keep in mind 

that some pictures are much easier to work with than others. This one was pretty easy but 

sometimes you might grab a picture that’s a lot harder to work with and you’ve got to spend a 

little more time with it. So just kind of remember that. 

Now if I go back to Remove Background here you also had the option to delete your marks. That 

would be these marks I just put in here. We saw discard all changes and keep changes. So I’m 

going to keep changes and then you’ll see it’s the same way it was a second ago. 

So just keep in mind that those are some of the ways you can crop a picture. 

So what I want to do now is we’ve got some formatting things we can do to change the colors 

and things like that. Let’s go look at section three and see what else we can do here. 
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Video: Formatting Pictures 

Cindy: Okay so hey there. We’re still in module seven, Working with Pictures, and this is 

section three where we’re going to talk about some of the formatting options we can do with 

pictures. Now so far we’ve just looked at some basic ways to enhance your pictures. We’ve 

actually looked at the cropping and now let’s look at the formatting options.  

Okay so I’m here on our presentation on slide two and what I’d like to do is put in a picture on a 

new slide. I’d like the new slide to be slide five so I’m going to click on slide four over here on 

the left. I’m going to go up to New Slide and I’m going to ahead and choose Title Only. Now 

let’s say I’ve put in the word Graduation here and I want to put a picture down in the bottom. So 

I’m going to go to Insert and I’m going to insert a picture. And let’s say this time I use this cap 

and diploma picture. So I’m going to go ahead and change the size of it so it’s a little bit larger 

here. And let’s say I want to take this white off the background. So remember to do that then I’m 

going to go up to Remove Background and I’m just going to include what I do want in this box 

here. So I’ll just drag this up a little bit, make sure this is good, and I’ll bring that down a little 

bit and let’s see what it looks like now. Okay. So with the exception of this corner right here. So 

let me go ahead and undo that and make sure I get that in there as well. Awesome. I think I have 

it all now. So let me go ahead and click away from it and it looks a lot better doesn’t it?  

Now notice there’s a couple of areas there that I might want to get rid of. So if I click on the 

picture again and I go back to my Picture Tools contextual tab, back to Remove Background I 

can mark areas to remove which would be this area right in here and it looks like this right back 

here I can rid of and this little area here. See how I’m doing that? And then this area here, this 

one and right inside the little bows. Let me get rid of those. So let’s see what it looks like now. 

See? So I could go ahead and get rid of these little areas too but I’ll leave it for now. So it looks a 

lot better this way. 

Now as far as working with the colors in your pictures. Here’s going to be your options. Under 

Corrections here you’ve got several different options you can choose as far as sharpening or 

softening the picture and you just move your mouse over whichever one you like and notice 

these down here have to do with brightness and contrast. So if you like any of these then you can 

go ahead and choose it. So you have several different options you can pick from there. So just 

kind of remember that. 

Now where it says Color right here you can also choose different variants of color. So you’ll 

notice they’ve got a color saturation group so it can change the actual color of the diploma. I can 

go down to the recolor options if I want one of these yellower options or one of these blue or 

green options I can do something like that. Here’s a blue one. So that’s kind of cool. So just kind 

of notice that you have all those options as well when you’re working with color. 
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Now notice at the bottom of this you have more variants, you’ve got the ability to set a 

transparent color and also you can go to the Picture Color Options. 

Now when you’re on the Picture Color Options you’ll notice that over on the right you can 

change the presets. You can also work with the saturation and you can see when I pull this back 

or forth you can see more or less of the color in there. And also you can work with what they call 

the temperature with some of the presets that we looked at. So I’m going to go ahead and change 

that a little bit. So working with that is going to allow you to change what your color looks like. 

Okay. You’ve also got some artistic effects. So let’s say you like this but you want this one that 

kind of looks like some water or maybe something like this. This one is plastic wrap. So you can 

always work with these artistic effects which are really cool. 

So just kind of know that you have all these options when it comes to your picture. 

Now I want to tell you real quick about compressing the pictures because what happens is if 

you’re going to be emailing pictures or you’ve got a lot of them that need to go out in this 

presentation pictures take up a lot of space. So you might want to go ahead and work with some 

of these options as far as changing the resolution and that sort of thing. So just kind of know 

these are here. 

One of the things to notice is the cropped areas that I mentioned earlier that they were still there. 

They’re just hidden. You can delete those cropped areas right here if you want. Alright? So I’m 

going to cancel that. Also you can change the picture totally. So if you don’t like that particular 

picture just change it out with another one. And then we talked about reset picture where you can 

reset the picture to its original colors and size and things like that. So you do have a lot of things 

you can do as far as working with the colors of these pictures. 

Now what I want to do now is we’ve talked a little bit about some different options with pictures 

as far as cropping and formatting and whatnot. But I really want to make use of some of the 

different things we’ve talked about in module six and seven to show you how to layer some 

pictures and to make use out of some pieces and parts of pictures. So just join me over in section 

four and let’s talk about making some good use with some of these pictures. 
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Video: Things You Can Do with Pictures 

Cindy: Okay welcome back. We’re working in PowerPoint 2016 and this is module seven where 

we’re talking about pictures.  

Now we’ve already done some formatting with our pictures. We’ve looked at some ways to crop 

pictures. So now I want to take some time and just show you some really cool things you can do 

when you mix and match pictures or use pieces and parts of pictures. 

Okay so we’re back in our presentation and what I’d like to do is add a new slide and make the 

new slide number six. So I’m going to go to New Slide and put in the blank layout.  

Now I’m going to put in a couple of pictures just to show you something really cool that you can 

do. I’m going to go up to Insert and I’m going to put in a picture and I’m going to choose this 

one right here. Now what this is is basically a circle that has nothing in it right here and we’re 

actually going to take another picture and insert it in there. Now before I do that what I’d like to 

do is take this white background off of this picture. And let me enlarge it just a tad more. So first 

I’m going to remove the background. And we’ve already seen how to do this. Remember you 

want to include in this box the areas of the picture you want to keep. And now if I click away 

from it notice it’s gotten rid of that white in the background. 

Now let me show you the picture I want to put in the center there. I’m going to insert a picture 

and let’s say it’s this cap and gown right here. Now first of all you’ll notice a couple of things. 

It’s got that white background and I could go take it off but I’m going to show you some other 

ways to do this because I want to put this right in the center here.  

So remember how we looked at the Picture Styles? You remember this? So what if I picked this 

one that looks like a circle or an oval like this? And I probably want it a little bit smaller because 

I’m going to put it right on top of this and I’m going to make it in the shape of a circle so it fits 

right in the middle there. And sometimes you have to play with it a little bit. But look at that. It 

fits right in the middle there.  

Now you can play with the border and the colors and things like that but let’s try one more thing. 

Let’s say that at this point we take the background off. So let’s say I go to Remove Background 

and I go ahead and just tell it the parts I want to keep and do something like this. And let’s click 

away from it and look at that. Look how it’s got the same color that was originally in this object 

in the background here. Isn’t that cool? 

Now how about if we put some text down here? We can always draw a text box and we can type 

some text in there. So what if we say 2016 Graduates. Now sometimes with a text box you have 

to pull it like this and then you can work with it. Alright? So need to put a two there. So we’ve 

got 2016 Graduates. Now I’m going to change the size of it a little bit and I’m also going to 

change my font color a little bit so we can see it. And let’s just use black for now. And I’ll make 
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it bold and center it in the placeholder there. And it could be I want to make it a little bit bigger 

too. Awesome. Look at that. So you can always play with things like this. 

So you see how you can work with different objects and put them inside of others just to make 

some really cool pictures and some effects like this. 

Now how about this? Let me put another slide in. I’m going to click on New Slide, put another 

blank one in. Now what if I go ahead and grab this picture of this guy here? He’s thinking. And 

he’s thinking that he might want to go to school. So let’s go ahead and make him a little bit 

bigger. And I’m going to take the background off of him as well. Make sure we get his hair in 

there and all of his shirt. Get this in there. Perfect. Now what is he thinking? What if we went in 

and we drew one of those callouts. Remember these? Right down here at the bottom? Let’s draw 

this one. Okay and we’ll change the color and all that in here. And remember you can actually 

move the little mouthpiece if you want like this. So he’s thinking, “Should I go back to school?” 

Okay? I guess I could spell that right. Alright. So he’s thinking, “Should I go back to school?” 

Now I’m going to go ahead and change the text color a little bit so we can see it. Let’s just use 

black. And if you want to make it bold you could do something like that. And then maybe you 

can change the color here if you want. So you could always go up to your Shape Fill and maybe 

put one of those textures in the background. Those are always kind of cool. How about this one? 

So see how you can utilize some of your drawing objects and your pictures together?  

Now let me show you one more cool thing you can do. I’m going to put in one more picture. 

We’ll make it number eight here.  

Okay so let’s say that you put in a picture like this. Let’s say I’m going to use this one here that 

says Diploma. Now I’m going to make it a little bit bigger so we can see it right here. Now this 

one probably would need a little cropping. So you can crop off the white on the edges there. And 

I’ll do the top and I’ll do the bottom there. There you go.  

Now I like this picture but it’s kind of boring. Now I could put a line around it but how about a 

frame? So I’ve got another picture here that has a frame around it and let’s say it’s this one here 

where it says Diploma. Now I could care less about what’s in the middle of it. I’m going to use 

this border or this frame on the outside of this picture. Now first I’m going to crop out the white 

around the edges here. So let me turn on the crop and let me do it down at the bottom here and 

on the sides. And we’re going not going to see that stuff in the middle when we get through here.  

So now I need to make it a little bit bigger. So let’s go ahead and make it the size of our object. 

We actually want it a little bit bigger or we can edit the one that’s inside when we get it in there. 

Now we’ve got two pictures. So we’re going to take this one and move it to the back. So I’m 

going to go ahead and choose Send to Back. There you go. And now what I can do is take this 

picture here and just kind of line it up so it goes right inside the frame there. And again you have 

to work with your picture sometimes like I told you earlier. But you can kind of see what I’m 

doing here. So you can always do stuff like that to work with the frame. 
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So those just give you some ideas of how to use pieces and parts of pictures to work together and 

that’s really cool. Just kind of use your imagination when you get to points like this.  

So that’s going to wrap module seven. I do have a quick exercise that I’m going to have you do 

for me where we’re going to put in some pictures and change colors and things like that just like 

we went through. So I will see you real quick over in the exercise for module seven. 
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Video: Exercise 06 

Cindy: Alright we’ve made it down to the end of module seven so it’s time to go ahead and do 

the exercise here. 

What I’m going to have you do is open a file called Practice Presentation 7. Go ahead and add a 

blank slide and I want you to use the blank layout. Add a picture of your choice from the internet 

and find one you think you can crop very easily so you can practice and learn how to do this. If 

you want to put in a couple of slides and practice feel free to do that.  

Go ahead and also practice formatting that picture. So we talked a lot about different things you 

can do as far as the formatting options that are available. And then I want you to get really 

creative. So if you want to put in a couple of pictures and mix and match parts and come up with 

your own picture that you couldn’t get any other way feel free to do that.  

Once you get through and you feel like you’re comfortable with everything go ahead and save 

and close the file and then you’ll be good to go. 

Great job. 
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Chapter 8 – Working with SmartArt 

Video: Creating SmartArt 

Cindy: Hi there. Welcome back. This is Cindy again and we’re talking about working with 

SmartArt in PowerPoint 2016. Now we’re in module eight and this is the first section where 

we’re going to talk a little bit about what SmartArt actually is and how you’d actually insert a 

SmartArt object. So let me go ahead and flip over to our presentation we’re working on and I’ll 

show you how this works.  

Okay so I’ve added a slide here that shows us our board of directors. And this is a good example 

of a SmartArt object here. I’ve got each person that’s on the board listed along with their picture 

and their title down here at the bottom. Now this is just one of many different formats that you 

can choose from. They don’t all have to have a picture in them. You’re going to see here when I 

start showing you how to work with this that there’s different ones and also different styles for 

each one that you can work with.  

Now when you’re putting in a WordArt object you can either put in the object that’s blank and 

type all the information in each one of the little boxes you see or you can have some generic 

information just typed in a slide and convert it to a SmartArt object. Either one would work fine. 

So let me show you how that’s going to work. 

I’m going to go ahead and put a new slide in over here and I’m going to choose the title and 

content. Now I’m going to put in in this particular case this is going to be the College Team 

Members. Now I’m just going to put their names here in a bulleted list. So let’s say the person is 

John Tanner who happens to be the president. The next person is Molly, Molly Timmerland and 

Molly is going to be our legal counsel. Alright we’ll have Kenny Dooer and Kenny happens to 

be our IT director. And we’ll just put in one more here. Let’s say that our last one is going to be 

Carol Jones and Carol’s going to be on our board of directors. Now notice the way I’ve typed 

these in. I’ve actually got their names on the first level and I’ve got their title on the second level. 

Now you could flip it around but just be consistent with however you do it. 

So now that I have this information in I’m going to select each one of these names and notice 

that I’m on the Home tab and I’m going to come over here where it says Convert to SmartArt. 

Now these are different styles of SmartArt objects that you can insert. Notice you can just point 

your mouse over each one and it will show you what it’s going to look like if you choose that 

particular one. Some of these have a place to put each person’s picture and some don’t. And you 

may or may not want that. It’s really up to you what you want yours to look like.  

So let’s just say that I pick this one here. Now you’ll notice that it’s got all their names in and 

their title right below it. But what it doesn’t have for the one I chose is their picture. Now these 

pictures would need to be files in your computer so here’s how this is going to work. I’m going 
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to double click on this little picture and I’m going to browse and find a file for my computer. 

Now this first one is John Tanner so I’ll choose it and insert it and notice there’s John Tanner’s 

picture. Now let me go ahead and insert the rest of these. This will be Molly, Molly Timmerland. 

Next one is Kenny Dooer and let’s see if we can find Kenny here. There’s Kenny. And then the 

last one is Carol Jones. So we’ll go ahead and see if we can find Carol. Okay let’s scroll down 

here and we’ll look for Carol and there she is and we’ll pop her in there. So now you have a 

picture of each one of the college team members.  

Now when you put their picture in sometimes it may not be exactly centered or exactly the way 

you want it to look. So I want you to notice that you can actually crop these if you want. So 

notice when I select the picture I can now up to my Picture Tools contextual tab and I can use the 

crop option if I want. Now this will allow me to crop and move this if I want it left, right, up, or 

down. See I can move the picture within the circle there. Now these all looked good but I just 

wanted to show you this because you can line them up and make them look nice and neat in 

there. 

Let me go ahead and show you how to put in a blank SmartArt object and then you can type the 

information right in the object itself. 

So I’m going to go ahead and put in a new slide. So I’m going to go back to home and put the 

new slide in this way and I’ll choose title and content. Now let’s say that I want to have a title for 

this particular one and this is going to be our Student Advisory Board. Now if you notice down 

at the bottom where you have these graphics this one says Insert a SmartArt Graphic. Now you 

can certainly do it that way. If you didn’t have an icon down here to do that with then you would 

just go to Insert and then you would use SmartArt this way. So I’m going to go ahead and choose 

it down here. Now this is a list of all the different SmartArt objects that you can use. And you 

can see when I scroll down that there’s different ones. Some have pictures, some don’t. Now if I 

wanted to categorize these by just the ones that are in a list format I can choose list, just 

relationship formats, if I want to see just the pyramids, the matrixes. You can also see all the 

ones that have pictures, if that’s what you want. So any of these you can certainly use. 

Now I’m just going to go back to the list and I’m going to use one of these. Let’s say that I use 

this particular one right here. Now all I have to do is type in whatever text I want. So let’s say in 

this particular case that I want to put in James Allan. I’ll put in another name. I’ll put in John 

James. And then the last one here is going to be Jenny Haynes. Alright? Now let’s say all of 

these people happen to be students. And so you can pretty much set up any way you want.  

So this was a pretty easy one. Again I could have picked any of those that I wanted from the list. 

So now that you know how to actually insert a SmartArt graphic let me go ahead and show you 

how to take your existing SmartArt graphics and modify them. So let’s go over to section two 

and I will show you how to do that. 
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Video: Modifying SmartArt 

Cindy: Okay welcome back. We’re working in module eight and we’re talking about how to 

work with SmartArt. This is going to be section two where we’re going to talk about how to 

modify those existing SmartArt objects. It could be that you inserted one and you really wish you 

had started with a different one but you can always take the one you have and actually change 

what it looks like. So let’s slip over to our presentation and I’ll show you how that works. 

We’ve got this particular SmartArt object that we put in initially but let’s say that we want it to 

look a little bit nicer so we want to actually change it to one of those other SmartArt objects that 

we saw. So notice if you select the object you can go up to your SmartArt Tools contextual tab 

and you can look at the different layouts. Now these are the same layouts that we saw earlier. 

Notice if you just move your mouse over any one of these that you’re going to see what the 

layout would look if you chose that particular option. So I’m just going to choose this one here 

and you can see I totally changed the look of my object. 

Now when you have your object selected a couple things you can do. First of all there’s a little 

arrow on the left here and that’s because if you wanted to type and change someone’s name you 

could certainly type it right here but some of those other layouts may not be so easy to type in. 

So if you have this open you can also type right over here and it’s really good if you have a large 

amount of text or bullets that have a second and third and fourth level. Just a little bit easier to 

type in. Now you can also close it with the X there if you don’t want to do that. 

Now also notice the different SmartArt styles. So based on the layout you chose there are several 

different styles you can choose from. So some of these have a little beveled look you can see. 

Some of these look like they’re tilted a little bit. So it’s really up to you whichever one you’d like 

to choose. So I’m just going to stick with this one. 

Now the other thing is you can change the colors. So you’ll notice there are three primary theme 

colors you can pick from but you can also pick from Colorful or several different accent themes 

that they have. So you can always choose any one of these that you like. I’ll just pick Colorful 

for now. 

Now a couple of things you’re going to be able to do with the bulleted items themselves here. 

Let’s say that I’m clicked where John James is and I really want to move him up so he’s the first 

name in this list. Instead of cutting and pasting notice that where it says Create Graphic here you 

can move your bullet up or you can move your bullet down in the list. Just a quick way to do it 

there. 

Also let me just tell you what the promote and demote are. If you have more than one level 

promote means you’re going to move to the left and make it a higher level and demote means 

you’re going to move it to the right and make it at a lower level. So that’s all that is.  
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Also you can actually move these right or left if you had names that were to the right or left of 

each other.  

So that’s basically how that works. 

Now after you’ve done all of this work if you ever decide you want to reset your graphic just 

come back up to this Reset Graphic option here and it discards all the formatting changes you 

made and then you’re back to your original way that it looked when you first put it in. 

Also just notice this last button here. It lets you convert this whole SmartArt object back to 

generic text or if you want to convert it to an actual drawing shape you can do that and then it’s 

not a SmartArt object anymore.  

Now I want to show you one more thing you can do with SmartArt. You can actually use 

SmartArt objects to create a flow chart. So instead of actually drawing all the objects and the 

arrows and typing inside the objects just type in the text, convert it to a SmartArt object and 

you’re good to go. 

So let’s go over into section three and I’ll show you how to do that. 
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Video: Writing Math Equations 

Cindy: Okay welcome back. We’re still working in module eight and we’re talking in this 

module about working with SmartArt. Now we talked a little bit about how to insert SmartArt 

objects, how to modify them and I want to show you real quick how to use them if you want to 

create a flow chart. 

Now what I want to do is go ahead and put in a new slide. So I’m going to go ahead and choose 

the title and content. And I’m going to give this particular one a name. And let’s say that we’re 

going to call it Next Steps. Now a lot of times when people want to create a flow chart they 

actually draw some boxes and they draw some arrows that point to other boxes and they type in 

there. You could certainly do that but there’s a lot of work because you have to line things up 

and it’s a lot of drawing. Whereas if you just use a SmartArt object then it’s already set up for 

you pretty much. 

So I only want to have three things in this particular flow chart. I want to say Apply. I want to 

say Find money. And the last one will say Register for classes. Now I’m going to go ahead and 

select this and I’m going to Convert to SmartArt. Remember that’s under the Home tab.  

Now let’s just say we do something super simple with this one. Let’s say that I want to use this. 

So there you go. You can see it’s all set up for you. Now remember we talked earlier about the 

fact that if you want to change colors you could. If you want to change the layout. So if I didn’t 

like this particular one I could choose a different layout like this. And that way it’s super simple. 

I didn’t have to draw these. They were already lined up for me. Really, really easy when you 

want to use them to create flow charts. 

So that’s kind of how your SmartArt works.  

What I’m going to have you do now is a little exercise just to make sure you’re okay with how to 

add some SmartArt objects and modify them and then we’ll move over to module nine. So I’ll 

see you shortly. 
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Video: Exercise 07 

Cindy: Hey there. Welcome back. We have made it all the way down to the end of module eight. 

So I have a quick exercise that I want to have you do for me. We talked a lot about SmartArt in 

this particular module so let’s see if you can do a couple of things on your own with this. 

The first thing I want you to do is go ahead and open the file called Practice Presentation 8. And 

go ahead and add a slide. You can add it wherever you like. But go ahead and use the title and 

content layout. And in the title go ahead and put in Our Team. Now I’m going to have you type a 

bulleted list using the names that you see right down here. Remember to use your first and 

second level bullets if you need to. Then I’m going to have you select that list and convert it to a 

SmartArt object. Once you’ve done that go ahead and change the layout to one of your choosing 

and just play with some of the different ones just to make sure you’re okay with how to actually 

change those layouts. When you’re done go ahead and save and close the file for me and then 

you’re done. So great job.  

So let’s go ahead and move over into module nine now and I will see you shortly. 
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Chapter 9 – Working with Tables 

Video: Creating Tables 

Cindy: Hi there. This is Cindy again. We’re working in PowerPoint 2016 and this is module 

nine where we’re going to talk about how to work with tables.  

Now this will be the first section where we’re going to look at creating tables. If you’ve done 

tables before in Microsoft Word then you’re going to see you’re using a lot of the same features 

to create these tables here in PowerPoint. So it’s going to be very similar. So let me show you 

how to actually start working with your tables. 

Okay so we’re back at our presentation here and what I’d like to do is add a slide where it can 

actually put in our graduation rates in a table. So I’m going to go ahead and click on New Slide 

and I’m going to choose title and content. Now I’m going to go ahead and give a title to this 

particular slide. So I’m going to say Graduation Rates. And then what we’re going to do down 

here is instead of typing in bullets you’ll notice that I can actually click right here to insert a 

table. So I’m going to click on that.  

Now you probably want to know ahead of time how many rows you want and how many 

columns you want in a table. Now you can always change this but let’s say I want to start with 

four columns and three rows and I’m going to click okay. 

Now when you’re working in a table you’re going to be able to click inside of whatever cell 

you’d like and you can also if you need to add columns or rows you’ll be able to do that as well. 

So let’s go ahead and set this one up. 

I want this first one, we’ll just leave this first one blank. And what I’m going to do here is put in 

Science. I’m going to say Technology. And the last one I’ll say Math. And then what I’ll do 

down here is type in the years like this. If you’re in a particular cell and you hit the Tab key 

you’re going to move to the right. So this is where I can put in some of my different percentages. 

I’ll say 93% here and 93% here.  

Now notice that I’m in the last cell on the first row. So if I hit the Tab key I’ll just move down to 

the next row. Let me go ahead and put the rest of these in here. We’ll have 92% for technology 

here and 91% here. 

Well now I’d like to put in 2015. I don’t have a row for that. If I hit the Ta key I’m going to put 

in a new row automatically because I’m in the last cell on the last row. So now I can add 2015 

and I’ll say 83%, 94% and 92%. Just like that. 

It’s easy to add a row if you’re in the very last cell. But what if you needed to add a row up in 

your table? 
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So let’s say for whatever reason I want to put one in for 2012. Now when you’re selecting in a 

table you want to select a row by getting outside of the table on the left and you want to get a 

black arrow that points to the right. When you click you’ll select the whole row. If you’re 

needing multiple rows for some reason click and drag down like this. 

Now as long as I have the rows selected I’m now going to be able to either right click and insert 

here. See how you can insert a row just by clicking on that? See how it says Rows above or 

Rows below? So I would obviously want to put one above. 

Now just so you’ll know if you didn’t use this and you didn’t right click you could actually go up 

to your Layout tab and here is your Insert Options as well. You can insert a row above or insert a 

row below. I’m going to insert one above and now I’ve got room for 2012. 

So I’m going to ahead and put in my rates here. We’re going to say this was 91% and we’ll say 

math was 94% in this case. So you could always add rows within your table. 

Now columns are going to be pretty much the same thing except columns go to the left whereas 

rows typically go above unless you tell it otherwise. So see how if you get above a column 

you’re going to get a black arrow that points down. Just click and that will select that particular 

column. So again you can right click if you want and you can use the insert option here. And see 

how you can put columns to the left or the right? And again if you didn’t right click you’d be 

able to actually insert using your ribbon up at the top. 

So I’m going to go ahead and enter a column to the left. So here I’m going to put in Engineering. 

Then I’m going to come down and put some statistics in for this. We’re going to say it was 79%, 

I’m going to say 81%, we’ll do another 81%, and then down here we’ll do 86%. So there you go. 

You can always work with a table and insert rows and insert columns within that table. 

Now I want to show you how to put in a table if you didn’t have something to click on on your 

slide to insert it. Let’s say for some reason I want to put another table here at the bottom. What 

I’m going to do now is under the Insert tab you have a Table option. And basically you just drag 

down to tell it how many rows or across if you want columns. So let’s say that you wanted to 

have three columns across and three rows just like you see here. You’re just going to click and 

there’s your new table.  

Now you can move the table. So if I put my mouse around the edges of the table and get that 

white arrow. See how I can drag this and move it out of the way? And that way I can put this 

table wherever I’d like it to be.  

Now if you have your table here and you decide that you don’t want a column or a row, for 

example. So let’s say I really just wanted two columns. As long as I have a column selected I can 

right click and then I’ll be able to actually delete. So you’ll see Delete here and you’ll notice that 
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when you click on this you can actually delete the column you have selected. Now just move this 

over a little bit so it looks a little more centered and then we can type in here.  

So I’m going to say Credit Courses and over here we’ll say Continuing Education. So then what 

we’ll do is go ahead and type in some statistics here. So we’re going to say 93% credit courses 

and we’re going to say that 87% of these were continuing education course. And then we can go 

ahead and delete this row if we don’t want it and that way our table looks a little bit nicer. 

So that’s kind of how you put these tables in. Now obviously you’ll want to format these so they 

look a little bit nicer. So let’s go ahead and talk in the second section of this module about how 

to format your tables. 
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Video: Formatting Tables 

Cindy: Okay so we’re working in PowerPoint 2016 and we’re in module nine and this is the 

second section where we’re going to talk a little bit about formatting our tables.  

Now in the first section we actually created a couple of tables. One we put in straight from our 

ribbon and the second one we put in based on a button that was actually on our slide when we 

inserted it. So now what I want to do is take you in and show you how to work with some of the 

formatting options available for tables. 

So we’ve got our tables here and they don’t look too bad but I want to change them a little bit. 

Maybe some colors, just some centering, things like that. So what I’m going to do is I’m going to 

go ahead and select the table. So I’m going to go ahead and select all the rows like this and 

notice now I’ve got a Table Tools contextual tab. Now the first thing I want to look at are the 

Table Styles right here. And notice that I’m currently using this particular one. But if I use my 

scroll bar here I can see there are lots of different styles I can pick from. Now they’re actually set 

up by different groups. They’ve decided these would be the best match for my particular 

template that I’m using. But I could choose from the light variations here. I could choose from 

the medium ones down here or you’ll notice there’s also some dark ones at the bottom. So I’m 

just going to go ahead and choose this one right now. So you’ll notice that in this case I have a 

header row that’s black and then the rest of this is this green color, a couple of different greens. 

Now that I have my table style in if I wanted to actually change a particular color or a particular 

border or effect I can do that using these options right up here.  

So I’m going to select my header row because I don’t like that black. And I’m going to choose 

the shading option. And so I can come down the list and choose any color shading that I would 

like. So let’s say I choose one of these blues. I’ll just pick this one. So it matches a little bit 

better. It’s not quite as crisp as that black was. 

Now I want you to notice also that when we picked a style every other row was the same color 

here. Those are called banded rows when every other row looks the same. 

Now let’s say I want to do a few other things. I’ll go ahead and select my table again. I do have a 

Borders option. So notice if you wanted to put an outside border on your table you could. Now 

it’s not very thick so you’re going to notice that it’s a little bit hard to see but if I click outside 

border, I click away from my table I can see it right there. It looks like it’s a really light color. 

Now also I could have picked from some of the effect options. Notice I could pick what they call 

cell bevel. So as I move my mouse over the different ones you can see what they’re going to look 

like. Also if I want to put a shadow around my object I can do that. And if I wanted to actually 

work at the reflection options I could do that too. So you can always pick from some bevel, 

shadow and reflection. 
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Now don’t forget I have another table that I want to look like that as well. So I’m going to go 

ahead and select this table and I’m going to choose some of the same options. So maybe I’ll start 

with that same shading style that we had chosen earlier and I’ll go ahead and choose the same 

teal color that we used for a shading. And then down here you’ll notice I’ve still go that green so 

that looks good.  

Now a couple of other things I might want to do. I might want to take my titles and center them. 

So I’m going to select my first row and then I’m going to go back to the Home tab for a moment 

because remember this is where you have your font options. So I’d like in this particular case to 

go ahead and use my paragraph grouping here and center these within each cell. And if I want to 

do that down here as well I can certainly do that. 

Now if I wanted to select everything else I could do that too. I’ll just go ahead and select it and 

use my centering button to do that. So all of your font options and your paragraph options are 

going to work here as well.  

Now let me go back to Table Tools.  

Now a couple of other quick things. Here’s your WordArt styles. Now we’re not using WordArt 

in this particular case but when we talk about WordArt a little bit later you can use your WordArt 

to change the text and the way it looks within your table as well as just regular WordArt. Also 

when you have borders you can draw them over here. So if you wanted to turn your mouse to a 

pen then you’d be able to use the pen style, pick a pen color and draw your table. 

So that’s some of your table options that you have. Just go ahead and play with some of those 

and get real familiar with how it works. 

Now that’s we’ve actually formatted some of our tables here let me show you how to take tables 

that you might have over in other Microsoft Office applications and insert those into your 

PowerPoint presentation. I’ll see you over in section three. 
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Video: Inserting Tables 

Cindy: Hey there this is Cindy again. We’re working in PowerPoint 2016 and we’re down to 

module nine where we’re talking about working with tables. 

Now we’re in the third section here, Inserting Tables from other Microsoft Office applications. 

Now you might want to take a table you have in Word, for example, and put it into a PowerPoint 

slide. You can do that a couple of ways. You might actually copy and paste it over as an object 

or you might actually take that table and insert it into your slide and therefore if you make 

changes then you’ll be able to actually affect both Word and PowerPoint. Let me go ahead and 

show you how that’s going to work. 

Okay so we’re back in our presentation we’ve been working with and what I want to do here is 

add a new slide and I’m going to go ahead and choose title and content. 

Now I want to make the heading say Continuing Education and then what we want to do is down 

here we want to place our table. Now if you think back to section one where we created a table 

from scratch we have a couple of ways we could have done it and one of the ways was to click 

here where it says Insert Table and then we can tell it how many rows and columns and then type 

our information in. But that’s not what I’m wanting to do in this case. I want to actually grab a 

table that I’ve got over in Microsoft Word and I want to actually put it here on this particular 

slide.  

Now before I flip over to Word let me just change the layout real quick. We’ll have title only and 

we don’t have worry about that other placeholder back there. So I’m going to flip over to Word 

real quick. 

Okay so here’s the table that I have and basically I want to copy this table and put it over into 

PowerPoint. No big deal. Right? So I’ll select the table and then I’m just going to go up and copy 

it and now I’m going to flip over to PowerPoint and I’m going to right click and just paste it in. 

And there’s the table. Now let me make it a little bit larger here so you can see what you have. 

So basically you just copied an object from one program, in this case Word, and you put it over 

into PowerPoint. Now you do have the ability to edit some of these numbers if you like. If you 

wanted this to say nine, for example, you can edit it. But it’s not linked over to Word. It’s just an 

object that you’re actually making a few changes to.  

Let me actually show you how to link the two together so if you change the figures in 

PowerPoint you change them in Word and vice versa. So I’m going to go ahead and delete this 

table here. I’ve already copied it so I’m not going to go copy it again. I’m going to right click but 

this time when I paste I’m going to use the third option over that says Embed. And now this is an 

embedded object. So I’m going to actually make this a little bit larger so we can see it and then 

I’ll show you how it works. 
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Now remember I’m in PowerPoint right now. If I double click in the table noticed I’m now 

working in Word. So if you notice up here these are all of your Word options. So if I make a 

change, for example, let’s say I make this 60 hours and I click back in my slide I’m now back in 

PowerPoint. If I double click inside the object, make any changes I want, that changes Word and 

if I click back here I’m now in PowerPoint.  

Now let’s say we have a table over in Excel, for example, and we’d like to bring that table over 

here into PowerPoint. Now I could do the same thing. I could go over and copy and paste it but 

let me go through and let’s actually insert it as an object so you can see how that works. 

So let me go ahead and put in a new slide real quick. And this time we’re just going to choose a 

blank layout. Now here’s how I’m going to inset the object that’s in Excel. I’m going to go to the 

Insert tab. I’m going to come over to Object which is under the Text group in here. And I’m 

going to choose Create from File. Now I’m going to browse and find the file. Now when I 

browse here and I look I’m just going to kind of look on my desktop here and if I come down it’s 

called Excel Table. And I’m going to choose this link option and that’s actually going to link 

this. So I’m going to go ahead and click OK and it’s going to go and find that object and pull it 

in. And there it is. Now I can make this a little bit bigger if I want. But I want you to notice that 

if I double click inside of the table anywhere I’m not in Excel. See that? So when I start making 

changes to either one it’s going to reflect in the other one. 

So watch this. I’m going to change the hours here for networking to 75. Look how it changed it 

over in PowerPoint. So all I’ve got to do now is save this and close it and then I’m back in Excel 

and if I wanted to flip over to PowerPoint you see I can flip right over and it’s got the 75 hours. 

So when you’re pulling in an object that way make sure you check that little box that says Link 

and that way you’re linking the table in Excel to the table here in PowerPoint so you can make 

changes back and forth. 

Now what we’re going to do is go ahead and wrap up module nine. I’ve got a practice exercise I 

want you to do in section four. So if you want to flip over and just start that. And then we’ll 

move over to module ten and talk a little bit about working with charts. 
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Video: Exercise 08 

Cindy: Okay so we’re now in the practice exercise for module nine. So this is section four. And 

I’ve got a couple things I want you to do here as far as working with tables.  

What I’m going to have you do is there’s a practice file called Practice Presentation 9. I just want 

you to open it up and go ahead and add a slide at the end and you can use the layout title and 

content. I’m going to have you put in the title CE Courses and then put in a blank table like you 

see here just to make sure you can put it in and you can type inside that table. 

Now a couple more things. I’m going to have you put one more slide in. You can use the blank 

layout if you want. And you’ve got a Word file here called Practice Word Table. I want you to 

open it up and there’s a table in there I want you to copy. And then you’re going to go ahead and 

you’re going to put it in PowerPoint. Now I want to make sure that you put it in as an embedded 

file so that way that when you make the changes to the nursing hours it’s going to change it in 

both Word and in PowerPoint.  

So make sure you can do that. When you feel comfortable with it go ahead and save and close 

the file for me and you will be good to go. Awesome. 

So I’m going to see you over in module ten and we’re going to talk a little bit about charts. 
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Chapter 10 – Working with Charts 

Video: Adding Charts 

Cindy: Okay welcome back to PowerPoint 2016. This is Cindy again. We’re working in module 

ten and we’re going to talk a little bit in this module about working with charts.  

Now charts are actually an Excel feature. You can make a graphical representation of your data 

using a chart. You’re going to see there are line charts and there are all kinds of column charts 

and just a whole bunch of different types of charts you can play with. So you have the ability to 

use that charting feature from Excel over in PowerPoint. So come on over and let me show you 

how it’s going to work. 

Alright so we’re back in our presentation and what I want to do is go ahead and add a new slide. 

I’m going to use the title and content layout. And what we want to do in this particular case is go 

ahead and chart our student count for our different locations for the college. 

So once I get the title in I’m going to come down here where it says Insert Chart and then it’s 

going to allow me to pick from several different chart layouts. Now I want you to notice that the 

most common layout is what’s called a clustered column. But notice you can put in line charts, 

you can put in pie charts, bar charts, area charts. You can see the different types of charts that 

you can insert. 

Now just so you will know from tree map down to combo these are all brand new for Office 

2016. If you had a previous version of Microsoft Office you won’t see those. 

Now when you click on a particular chart layout you’re going to notice there are several different 

subtypes you can pick from as well. Now you’ve got several here, clustered common, like I said 

is the most common. But you can have a stacked column or a stacked column 100% and these 

have like a little three-dimensional effect. And the same thing for any of these. Like the pie chart, 

for example. Here’s one that’s a 3-D pie. But you can just look through the list and kind of pick 

the one that you want. 

Now if you’re really into charts and you want to know how the different layouts might help you 

relay information to your audience you might want to think about taking an Excel course related 

to charts where they talk a little bit more about the different layouts. But for right now we’re 

going to go ahead and just choose a basic column chart and we’re going to go ahead and click 

OK at the bottom. And then you’ll see here’s our basic chart.  

Now a very common question that comes up at this point is where did this data come from? 

What happens in Microsoft Office products is if you’re working actually in Excel then you can 

actually type in your data and the chart is created right there. But if you’re using this feature 

that’s an Excel feature in Microsoft Word or in PowerPoint, for example, then it puts in this 
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default data and you change it. And as you change it your chart will update. This is a datasheet 

and this is a chart. So the datasheets and charts are linked. 

Now I’m going to go ahead and expand the datasheet a little bit because I want to type in some 

data that represents our student enrollment. So let me have some rows here. We’ll have a row 

that represents our main campus. We’re going to have one that represents our Saint Phillips 

Annex. We’ll have a row that represents our Childer’s Annex. And the last one at the bottom is 

going to be our Other Offsite locations.  

Now across the top here I’m going to put some column headings in and these are going to be the 

different years. So I’ll start with 2012, 2013, 2014 and notice that I just tab to get over here to 

put 2015 in but it wouldn’t let me. It just went down to column A, row 2. Now here’s why. If 

you see this blue box right here that’s the outline of the data that’s going to be represented in the 

chart. See how I can grab this little box in the bottom right and get that black double arrow. I can 

actually expand that if I wanted to include additional information. So that’s how you put in your 

row headers and your column headers. 

Now by the way in charting terminology these are going to be called your X and Y axes. So X 

always represents your categories and Y always represents your values. So we’re going to talk 

more about that when we talk about formatting here shortly.  

But let me go ahead and plug in some numbers here. Let’s say we had 1,500. Notice how the 

chart is actually being updated as soon as I type in the number and hit the Enter key here. So 

that’s why I said earlier that charts and datasheets are linked. Alright let’s put in the 2014 

numbers. Okay one more. We’ve got 2015. We’ll have a lot here. There you go. 

Now if you didn’t want to include some of this data in your chart grab that same little box on the 

bottom right and just bring it in a little bit like this and that data is excluded from your chart. So 

let me go ahead and include it again. So that’s how you’re going to actually put in the data which 

creates the chart. 

Now if you’re finished working in your datasheet here as it’s called go ahead and just close it out 

and then you can do whatever you need to to this chart here.  

So let me go ahead and just show you real quick where you would go if you didn’t choose a 

layout that had a button to insert a chart. So maybe you’d picked the blank layout, for example. 

So what you would do is you would click on Insert and you’ll notice here under the Illustrations 

grouping is Chart. And when you clicked on Chart this same window would appear where you 

can pick the type of chart and then type in your data. So I’m going to go ahead and close that. I 

just want you to know where to go to do that. 
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So now that you know how to actually insert a chart let’s talk a little bit about formatting this 

chart to make it look a little bit nicer and maybe to make some things stand out. So go ahead and 

go over to section two and I will see you over there. 
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Video: Formatting Charts 

Cindy: Hi there. Welcome back. This is Cindy and we’re working in PowerPoint 2016. And 

we’re down to module ten now where we’re talking about working with charts. 

Now we’ve already gone through how to add a chart. We did that in the first section. So what I 

want to do now in this second section is talk to you about how to take that chart and format it so 

that it looks a lot nicer and gets your point across to your audience. 

Okay so this is where we left off in section one. We had actually added this chart that you see 

here. Now it looks okay and it probably would be okay to just leave it this way but if you really 

want to enhance it and make some things stand out visually then you might want to think about 

formatting this chart a little bit.  

Now let me just say real quick that I don’t have time to go through every single formatting 

option there is for charts because there are so many. I’ll just kind of hit the high points and then 

you can play with the others yourself. Now if you’re interested in learning more about charts go 

ahead and take an Excel course where you focus specifically on charts and they’ll go through all 

of the options with you. 

Now real quick if I click inside the chart you’re going to notice your Chart Tools contextual tab 

appears and your options will be under the Design tab and the Format tab. Now before I start 

going through some of these this chart title that you see right here, if you want to delete it just 

select the placeholder and hit delete. You could have made some text inside of that placeholder 

but you already have some text in this particular case as the title for this slide. So you really 

don’t need text in there twice. 

Now real quick a couple of just terms that you’re going to hear when related to charts. I 

mentioned in the first section that you have an X axes and a Y axes. And the way you remember 

this is X always represents your categories. That would be Main Campus, Saint Phillips, 

Childer’s, and Other Offsite down here at the bottom. So this is my X axes. Y represents the 

values. So see the values go up and down the left. So that’s your Y axes. Now if you had a 

different type of chart, like a pie chart, it wouldn’t have any axes at all. So just kind of know that, 

that X represents your categories and Y represents your values always. 

Now some things that you might want to do with this chart. Let’s go ahead and start with our 

Chart Styles that we see here under the Design tab. Now I’m going to click the scroll bar so you 

can see all of the ones that are available. So if you like one of these you can go ahead and just 

choose it from the list. And depending on which one you choose you might have a dark colored 

background. You might have a white background. You might have one that looks like this where 

you have your values or your labels across the top. So they’re all different and you just have to 

choose the particular one that you happen to like.  
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Now you also have the ability way over here to work with changing your colors and also the 

layout. And let me briefly tell you about the layouts.  

There are some things that are not on this chart. For example, that title we just deleted. Or just a 

moment ago you didn’t have these values at the top of each one of these columns or bars right 

here. We only got those because I chose one of these chart styles. But just by clicking on the 

different layouts you can see that the layout will either add something or take something away 

from your chart. This particular one here took away some gridlines as they’re called. This one 

puts a legend at the bottom. This one has a title on the left and on the top. So you can see just by 

choosing one of these you can change the whole look of your chart. 

Now also where it says Add Chart Element some of these things may not be in the particular 

layout or chart style that you’re using so you may want to add them individually. So for example, 

we just saw chart titles briefly. And that’s where you could put a title at the top like this and you 

can also put one over here if you wanted. Notice that you can also choose what they call center 

overlay where it overlays on top of some of the items in your chart. Data labels, for example, 

that’s going to be these numbers at the top of each of these columns that you see here. I could 

have chosen to put those in the center of I could have chosen to put those inside at the bottom or 

outside on the end which is where they were originally. You also have what they call data callout 

and those are kind of new to Office 2016.  

Now there are some other things here like gridlines, for example. Gridlines are those lines that 

are behind your chart that you see here. That’s called the plot area by the way. You can also play 

with your legend. The legend actually tells you what the different bars represent. In our case the 

years. So see how it can be on the right, it can be on the top, the left, or the bottom. So I’m going 

to ahead and put mine back at the bottom and take this chart title out again. 

So those are some things that you could actually add to your chart. 

Now looking over on this side of your ribbon. If you need to edit your data at any point you can 

click on this Edit Data and that’s going to bring up your datasheet and then you can just change 

the data to whatever you want. And when you’re finished just close out of it and you’ll be good 

to go. 

Now also notice way over here on the right that you can change the chart type. Remember when 

we first put our chart in and we picked a clustered column? I might decide now that I’d like the 

bar chart because I like it a little bit better. I can choose it and click okay and now I have a bar 

chart. So you can always come up and change the chart type. 

Now let’s look at some of the options under the Format tab.  

So you have the ability to change what they call the shape fill, the outline and the effects. And 

you might remember those from when we were working with objects. This area behind these 
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bars is what’s called the plot area. And actually that is an object. So if I wanted to put a particular 

color in the background I could. Or if I wanted to just take the color out I could do that. Or any 

of these other options that you see here. So let me go ahead and put a good color that’s going to 

look good with ours. Alright so I’ll just use this blue. Now I can also put an outline around this. 

So if I wanted to have a thicker outline I could certainly do that. And then I’d need a color for 

that outline because you can’t see it if you don’t have some sort of color there. 

Now the other thing is I can’t really see my text over here or the number. So I’m probably going 

to want to go back to my Home tab and work with these options here and let’s just say I want 

some black text, some black numbers. There we go. A little bit easier to read there. So you see 

how you can use the tools under your Chart Tools contextual tab or you can use like in this case 

some under the Home tab where we had to actually make our text a different color. There’s a lot 

of options here. Just remember to go through and kind of play with different ones and see how 

they affect your presentation. 

Now something else I just thought about. You may want to do some things like use some 

drawing tools in conjunction with your charts. So how about this?  

Let’s say that you wanted to circle this 4,900 right here because it’s the largest number. 

Remember how we talked about shapes in a previous module? I’m going to go ahead and use the 

oval and I’m going to go ahead and circle that. Now I can play with that circle to make it any 

size I want but notice it is an object that’s on top of my number there. So what I’m going to do to 

see the number through it is I’m going to go ahead to the Shape Fill and I’m going to say No Fill. 

And now you can see it.  

Now I probably want to do something like make the outline a little bit bigger and maybe a 

different color. So let’s say we do something with the weight and the thickness like this so it 

stands out a little bit more.  

Now you could also do something like this. What if you wanted to add one of your shapes that 

looks like a callout? So let’s say I had a callout up here like this and I’ll just point to it like this 

and I’ll say, “Great job Saint Phillips”. And then if I want I can choose my text color and there 

you go.  

So just get really creative with this and learn to use some of these different objects in conjunction 

with some of the different items that you’re going to have on your slides. 

That’s all I have to say about formatting for now. What I want to do now is move over to the 

third section and talk a little bit about how to insert charts that you already have in Microsoft 

Excel. I will see you over in section three. 
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Video: Inserting Charts from MS Excel 

Cindy: Okay welcome back. This is Cindy again. We’re working in PowerPoint 2016 and we’re 

talking about charts. This is module ten. 

Now we’re down on section three where I want to show you how to insert charts from Microsoft 

Excel and have them link back to PowerPoint so that when you change the data in Excel it’ll 

change it here in your PowerPoint presentation at the same time. 

Alright so I’m back over in PowerPoint and I’m just going to go ahead and add a slide here so 

we can actually put in our student count by program area. And we’ll just put the chart right down 

here at the bottom.  

Now let me flip over to Excel so we can grab our chart.  

Okay so I’ve got a table here that represents the student count by program area. And I’m just 

going to go ahead and select the range that I’d like my chart to represent and then I’m going to 

insert the chart here by going to the Insert tab and I’ll just choose a 2-D column chart. Now you 

can see this is what we call an embedded chart because it sits on top of the data. I can move an 

embedded chart. I can change any of the formatting. So you can see that I could come up and 

change some of the chart styles if I like. But I don’t really know yet what it’s going to look like 

over in PowerPoint. So it’s best to go ahead and just right click and copy this and I’m going to 

run over to PowerPoint, pop it in and we’ll see what it looks like.  

Okay so I’m going to right click and here’s all of my paste options. Now I want to go through 

these with you so that you know exactly what each one does and then you can make an informed 

decision about which one you’d like to use.  

Now this first one it says, “Use destination theme and embedded workbook”. Now here’s what 

that means. This one is going to keep the look of PowerPoint not Excel. So you have a certain 

theme you’re using in PowerPoint, certain colors, fonts. It’s going to take on all those 

characteristics. Also if you change the data in Excel it’s not going to change it here in 

PowerPoint. So it’s not linked.  

The second one, basically it’s going to look like it did in Excel. So if you change the colors and 

you add a dark background it would copy it over just like it looked over in Excel but it’s still not 

going to link the data. So just kind of keep that mind. Neither one of the first two will actually 

link the data. 

Now this third one here it’s going to keep the look of PowerPoint. So again if you made any 

changes they might not be reflected because it’s going to take on the characteristics of the 

PowerPoint template. This one does link the data. So if you change the data in Excel it will 

update your chart here in PowerPoint.  
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And number four is a lot like number two where it will keep the Excel formatting but yes it will 

link the data. So these two will link your data right here. 

Now the last one just puts it in as a picture. It treats it as an object. So however it looked over in 

Excel is how it’s going to look here. Now as far as this last one is concerned you’re not going to 

be able to change any of the individual characteristics that you see within your object. So I 

couldn’t change the color of the bars or link the data because it just treats it as a snapshot or a 

picture. 

So which one is the best to use? Well it’s really up to you because it depends on what you’re 

trying to relay and what you want the chart to do. If you don’t need it to do any linking great go 

ahead and use this last one. But if you do need it linked make sure you use the third or fourth one 

here.  

Now I’m just going to pop in this third one and make it a little bit bigger so you can see it there. 

Now you will be able to use any of the formatting options to make the chart look a little bit nicer. 

So you’ve got your Chart Tools contextual tab and if you need to do some things like maybe 

change the style you can certainly do that. Maybe as far as formatting you need to put a line 

around your object. You can certainly do that. Make sure if you change the line that you also 

change the thickness so you can see it. So any of that formatting is going to work but it will 

update. 

So that’s really all I wanted to tell you about working with inserting charts from Excel. 

What I want to do now is I want to have you go over to the fourth section which is our exercise 

for module ten. I want you to go ahead and go through it and make sure you know how to put in 

a chart just by adding it from scratch and also how to pull it over from Excel. So I’ll go ahead 

and meet you over in section four so I can tell you exactly what you need to do. 
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Video: Exercise 09 

Cindy: Okay so are you excited yet? We’re getting ready to wrap up module ten and this was the 

module where we talked about charts.  

Now remember we talked about the fact that you can put in a blank datasheet and go ahead and 

take the default data out and put your own data in and that would create a chart right here in 

PowerPoint. We also talked about the fact that you might have the chart already in Excel and you 

want to copy and paste it over. And remember if you do that that there’s going to be different 

options if you right click to past which would allow you to bring over formatting, bring over the 

linked option, etcetera. And let me show you what I want you to do here for me. 

So you’re going to open a practice file called Practice Presentation 10. Go ahead and add a slide 

when you get it open and use the title only layout because I’m going to have you put in the title 

Student Count by Program Area. Now go ahead and put in a blank datasheet, take out the default 

data and add the following information. Now remember when I say insert a blank datasheet 

you’re actually going to be inserting a chart and then the blank datasheet with come up 

automatically. And I say blank but it’s going to have the default data so you just kind of pop it 

out and pop your own data in. And this is the data I want you to put in there. 

Now you’re going to go ahead and create another slide and you’re going to use the blank layout. 

Don’t even have a title on this one. Go over into this Excel file called Practice Charts, go ahead 

and create a chart from the range A5 through E9 and once you get that chart created copy it into 

PowerPoint. Make sure that you choose one of those linking options so you can practice and see 

how if you change it in Excel it’s going to change it over in PowerPoint. 

Once you get that done save and close the file and we’re ready to move on to module eleven 

where we’re going to talk a lot about the Masters. 
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Chapter 11 – Masters 

Video: Using Masters 

Cindy: Hey welcome back. This is Cindy and we’re working in PowerPoint 2016. Now we’ve 

made it down to module eleven where we’re going to talk a little bit about the Masters. 

The Masters are considered the most underutilized feature in PowerPoint because a lot of people 

don’t know they exist. And if they do know they really don’t know actually how to use them. So 

I want to show you how to use the masters and make life a lot easier for you when you’re 

creating your presentation. 

Okay here’s the deal with the masters. Every time you go up here and you choose a new slide 

you have to choose a layout. Now the layout already has predesigned certain things. Like certain 

fonts look good on the left versus the right. You remember your theme you chose? It had certain 

colors in it, the bullets were a certain look. All of those things are part of a template or a theme 

and then also when you start picking these different layouts they’re also part of this master.  

So there’s going to be things that you might want to change globally throughout your 

presentation. So for example, we have several slides that have bullets. And if you notice we have 

this little green arrow here. See even on this one we have that same green arrow. What if you 

wanted to change your bullets? Well you could change it once on each bulleted slide but then 

that’s a lot of work, especially if you have a hundred bulleted slides in your presentation. And 

what’s going to happen is you’re going to pick the wrong size. One bullets going to look a little 

different than the other. So to keep things consistent you can actually utilize the master to make 

changes like that. You would change it once on the master and it changes it globally throughout 

your presentation.  

Here’s another example. The titles that you have. If you notice my titles in this case happen to be 

this white and they happen to be a certain font, certain size and that’s okay but what if I wanted 

to change all of my titles to a specific color, a specific size, specific thought because you want 

them all to be consistent and look the same. I could change them once on every slide but again 

that’s a lot of work. I can change them once on the master and it changes it globally throughout 

my presentation.  

Here’s another example. See this little thing right here? This little graphic? That was on most all 

of the slides. Now you can’t click on it because it’s not actually an object that’s on top of the 

slide. It’s actually part of the slide. It’s actually on the master is where it is. So that’s why you 

see the same graphic in the same place, looks the same size on all of those slides. So that’s kind 

of where we’re going to go with this. We’re going to actually talk about how to use these masters 

to make global changes to your presentation. 
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Now here’s the thing. If you manually make a change the master will not override it. So meaning 

on this one slide only if I decide to change these bullets it would override the other bulleted 

slides but not this one. So that’s why it’s best when you’re working with your formatting options 

to wait until you’re totally finished with your presentation and then make those changes on the 

master so you do it once and they’re global and it looks a lot nicer. 

So I do want to show you how to get to the masters. You’re going to go up to the tab that says 

View and then you’ll see your masters right here. You have a slide master, a handout master and 

a notes master. Now you’re going to be using the slide master the majority of the time but let me 

just tell you about the handout and the notes masters. You have the ability to print handouts. I’ll 

show you a handout a little bit later in another module but a handout basically has a piece of 

paper with a slide at the top and any notes at the bottom. So if you think about it remember these 

notes you were able to type at the bottom right down here. A handout would look just like this 

with a slide at the top and the notes down at the bottom. So you can have a master for those.  

You can also have what’s called a notes master if you want. So if you wanted it to look like this 

and you have certain notes that you wanted you could use the notes master. But most of the time 

you’re going to be using, again under the View tab, you’re going to be using the slide master. 

Now here’s what masters look like. Masters don’t usually have any actual text. It’s more about 

the formatting and the graphics and where you want them placed, certain fonts, things like that. 

Not to say they can’t have text but generally they don’t. If you had some text right up here, for 

example, then every time you picked this particular layout and you typed a title you would see 

text underneath and your text for the title on top of it and it would look really funny. 

So you’ve got different kinds of masters here. Typically the layout you were clicked on when 

you first came into the masters is going to be the one here at the top. But notice there is a master 

for each layout. So they could all be different if you wanted them to be. And you can see all the 

way down you’ve got a master per layout. 

So what I want to do now is talk to you a little bit about how to make some changes to your 

master so you can see how this works. Now to close a master you’re going to click up here on 

Close Master View and then you would see any changes you had created.  

So I’m going to go ahead and pull this back down here and let’s go over to section two and talk 

about changing master slides. 
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Video: Changing Master Slides 

Cindy: Welcome back. This is module eleven of PowerPoint 2016 and we’re talking about 

masters in this particular module. 

Now we’re down to section two where we’re talking about changing master slides. Now that we 

know what a master slide is and we have a quick overview of what it looks like then let me go 

ahead and take you in and we will actually start changing some of these master slides to see how 

they work. 

Alright so we’re back in our presentation here and let’s say we’re looking through it and we see 

some things that we would like to change that would be the same on several of the different 

slides. So for example, if you notice our title color happens to be white and it’s white on all of 

the slides that have a title. We could manually change those colors on each slide but we can also 

go to the master and do it once so it changes it globally. What about something like bullets, for 

example? Let me click on slide three here. We’ve got these green arrows that were automatically 

there in this particular theme. We can change those to any bullets we’d like but we’d have to do 

it on every slide. So why not do it once and then it affects all the slides that have bullets? So you 

see what I’m getting at? Or here’s something else. In our particular theme we’ve got this graphic 

that appeared in the top right of each slide. Now that graphic actually is part of the theme. It’s 

not an actual object we can click on to change. So again that’s something we could put on our 

masters. 

So one thing to remember, when you start making these formatting changes if you’ve manually 

changed those things on the slide itself the master will not override it. So let me give you an 

example. We’re going to change our title colors. I’ll go back to slide two and I’m just going to 

make the title here a yucky red color just to show you. There you go. So you’ll see when we 

change it the masters not going to override that.  

So I’m going back to slide one. Now you can be only slide when you go into the master. Okay? 

You don’t have to be on slide one. But here’s how you get into the master. 

You’re going to the View tab and there’s your masters. Now let me just mention that most of the 

time you’re going to spend your time in the slide master because it has all of the controls that 

affect your colors, fonts, backgrounds, and pretty much everything else throughout your 

presentation. But let me just tell you real quick about the handout master and the notes master so 

you’ll know what they are. 

When we talk about printing in a later module you’re going to see that you can actually print one 

slide on a piece of paper. You can print six slides on a piece of paper, add headers, footers, 

things like that. So this would allow you to make some global changes for that view so to speak.  
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And then the notes master. Remember the notes are these right down here at the bottom. 

Remember how you can drag this up and type some notes down here? Well you can print this as 

well. So if you wanted option pertaining to this view then you’d use the notes master. But like I 

said, most of the time you’re going to spend it in your slide master. So I’m going to click on 

Slide Master and then now we’re in. 

Now on the left I’m going to scroll up for a second because I wanted to show you that there is a 

master for every layout. The layout that you were currently using when you opened up the 

masters is the one that will appear at the top automatically. And typically this is the most 

common anyway so the changes you make here will affect every slide in your presentation for 

the most part. But think about this. We have a title slide at the beginning of our presentation. 

Now you can have multiple title slides like I told you. And if you have two or three and you want 

something different on those slides then on the regular slides make those changes on the master. 

But let me go back here and we’re going to go ahead and change our title. Now just know that 

typically you don’t have text on a master because if you had text there then every time you put a 

slide in the text would automatically be there and you’d be typing text over it. So this is more for 

formatting, backgrounds and layouts, things like that.  

So I’m going to go ahead and go to my Home tab and I want to change the color of my titles. 

And I’ll just use this color right here. And let’s say that I want to make it bold and I’d really 

rather center all of my titles. So I can keep making any changes that I like to that. It might be that 

I want a color in the background of my object. Who knows? But now that I’ve made a few 

changes I want to get out of the master and show you how those changes look. So to get out of 

the master I’m going to go to Slide Master and I’m going to choose Close Master View. Now if 

you look at all of my titles now notice how they’re centered, they’re bold, they’ve got this 

different blue color all the way down except slide two. Remember that’s the one I manually 

changed? But you can see if I scroll on down here every one of them that has a title looks the 

exact same.  

So I’m going to go back into the master and let’s work with our bullets for a moment. So I’m 

going to go back to View, Slide Master and I’m going to scroll to the top. Now here’s the thing 

with the bullets. Remember we talked about the fact that you can have up to five levels of 

bullets. If you want all five levels to have the same picture you start by clicking on the 

placeholder itself. If you want each bullet to have a different picture you click in the first level, 

make the change, click in the second level, make the change, and so forth. So I’m going to 

change just levels one and two because that’s all we have in our presentation here. 

Alright I’m going to go back to the Home tab. I’m going to go over to the Bullets and click the 

down arrow to the right. And I don’t like any of those so I’ll go into Bullets and Numbering. 

Now remember down here this is the size of the bullet in relation to the text so I’ll just make it 

100%. And I want to change the color. I want to give it a little bit of a greenish color. And I also 
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want to change either the picture of the customized option. So I’m going to choose customize for 

now because this is going to allow me to go in and look through all of these and see if there’s 

any bullets that I might like to use here. Now if you see something you like just go ahead and use 

that particular bullet. Let’s say I use this here and I’ll click OK. And actually I prefer a different 

color so let’s go down and find something that’s really going to stand out here. How about this 

one right here? Alright? I’m going to click OK and there it is. Now it looks a little small to me so 

I’m going to go ahead and just make it a little bit larger. So I’m going to go back to my Home 

tab, Bullets, do Bullets and Numbering, and let’s say we make this like 125. That’d be a little bit 

easier. There we go. A little bit better. 

Now I’ll change my second level. So I’m going to go back to my Bullets, back to Bullets and 

Numbering, Customize, and let’s find something down here that we might like. I’m going to pull 

in from the normal text. Alright let’s say this time I use hearts. And I’ll click OK, make that 

125% as well just so it looks like it’s the same and I’ll click OK.  

Now I also may want to change the color of that so I’ll just go back and change it real quick. 

We’ll give it that same pinkish color and there’s my bullets. So now I’m going to go ahead and 

go to the Slide Master tab. I’m going to go to Close Master View and now notice all the slides 

that have bullets now have the same exact bullet. Same size, same color, everything.  

Now a couple more things we can change in the master. So I’m going to go back to View again 

and back to the Slide Master. What if I don’t like this blue background? Then I have the ability 

to go to the Background Styles right up here and change it. So I can have any background that I 

like. So let’s say that I use this one here and I close the master view. And now you’ll see that all 

my slides have a different background. Now this time when I do this you notice that my title 

color I really can’t see. So I probably need to go back in and change that again. So I’m going to 

go back to View, Slide Master, and I’m going to go ahead and select my titles and I’m going to 

give them a darker color. So I’m going to go to Home, change my font color, and let’s say we 

use something like this. Now I’m going to go ahead and close the slide master and now you can 

see the titles a little bit better. 

Now in a situation like this where this is the only slide that has this if I were probably just 

manually change this and just make any changes I wanted to it.  

So you can see how you can globally change something in your presentation. If you wanted to 

add a graphic, for example, then you would just go into the master and add the graphic on that 

particular master where you’d like it to be.  

So that’s kind of how the masters work. So what I want you to do is spend a lot of time working 

with your masters. And when you get comfortable with it we’re going to go to the third section 

and I’m going to show you how to create a new master design template. 
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Video: Creating a New Master Design Template 

Cindy: Alright welcome back. We’re in module eleven and we’re talking about working with 

the masters in this module. This is the third section where I want to show you how to create a 

brand new master design template that’s not one of those automated ones that’s already in 

PowerPoint. One of the best things you can do is make sure that yours looks different from the 

run of the mill PowerPoint presentations. And one of the ways to do that is to use your own 

masters designs that you’ve created. So I’ll show you how to get started with that. 

Alright. One of the first things you need to do is decide if you’d like to actually use an existing 

presentation you already have and make some changes to it and then save it as a template or 

would you like to start from scratch and create your own? And remember the best ones are ones 

that look different from anyone else’s. So I’m going to go ahead and start on a new blank 

presentation. So I’ll just click the File tab and I’ll click on New and I’ll choose the blank 

presentation.  

Now you’re not going to be actually typing or adding pictures or formatting anything on the 

actual slides themselves. So don’t start by formatting the first slide that pops up. You want to 

actually do all of your changes on the master. So we’re going to go up to the View tab and we’re 

going to go to Slide Master.  

Now remember how we talked about the fact that there’s a mast for each layout. So if you want 

something different on your title slides then on your other slides make that change on the title 

layout here. If you want something different on your slides then you can go ahead and make the 

changes here. Now a lot of the changes you make on your slide masters are going to affect all of 

your other layouts. So we’re going to add a background, for example, and you’re going to see 

how that works. 

So I want to go ahead and add a background that will be on all of my slides here. And I’ve got a 

picture I’m going to use. So I’m going to go up to Insert and I’m going to insert a picture. And 

I’m going to scroll down. This particular one is called Blue Borders. So what I’m going to do is 

I’m going to drag this up to the top left like this and just size it so that it’s the same size as the 

background of my slide. Now you don’t have to use a picture. It could be you just wanted a color 

on the background. So you don’t have to use this particular option but this is what I’m going to 

do.  

Now notice the picture is laying on top of the other objects on the slide. So what I need to do is 

move this picture to the back of the stack so to speak. So I’m going to come up here where it 

says Send Backwards and I’m going to say Send to Back. And now you’ll see that my other 

objects are on top of the picture. Now you can see that that effected all of my slides here.  

Now I’m going to go to the title master here because I’ve got another picture I want to put in just 

on the title slides. So I’ll go ahead and insert that one. And this particular picture is called Pencils 
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and I’ll go down and find that one. And what’s going to happen is I’m going to put this in and 

I’m going to drag this down to the bottom so it’s right above that blue border like this. And I’ll 

just change the size so it stretches across the whole slide. How’s that look? It looks pretty good, 

huh?  

Alright now I’m going to go back to the slide master because I’ve got a different picture I want 

to be on the other slides. So I’m going to Insert and this time this picture is called Crayon. So I’m 

going to go ahead and find that one. There you go. And there you go. I’m just going to pop this 

crayon on the left over here so that all of my slides except my title ones are going to have this 

crayon over here on the left like this. And of course you can make it look any way you want. I’ll 

just stick mine in there just like that. 

Now let’s say that I’d like all of my titles to be a specific font, color, etcetera. So I’m going to do 

a couple things with mine. I’m going to make this area a little bit smaller so I can drag my title 

down a little bit. So what I’m going to do is I’m going to go ahead and drag it down so it’s not on 

top of that blue border and then we’re going to change the font. 

So I’m going to go back to the Home tab. I’d like it to be bold. I think I’d like to pick Algerian 

here. And I’ll make it a tad smaller and center it. How about that?  

Now down where the bullets are. You want to make sure that you change the picture for all five 

bullets because you never know if you’re going to have one bullet or five. Now remember that if 

you choose the placeholder and you change the picture you will change it for all five levels. And 

that’s fine if that’s what you want. If you need a different picture on each level start by clicking 

in that level.  

So I’m going to click in the first level and I’m going to go to my Bullets here and I’ll just use 

these arrows. Now I’m going to click in the second level and then I’ll go back and change the 

bullets for that one as well. And I’m going to use the checkmarks this time. And you would do 

levels three, four and five as well but I’ll just do those two for now. 

If you notice that you have a little bit of space between your bullet and your text and you’d like a 

little bit more this is all you need to do. If you look up on your ruler here you’ve got your 

indents. And these work very similar to the way they do in Microsoft Word. So I’m just going to 

drag this one over a little bit and that’ll give me a little more space between my bullet and my 

test. And I’ll do the same thing for the second level here. That way they’ll look a little bit nice. 

That’s a little bit too much I think. Here you go. 

So that’s how you’re going to work with these masters. Now you’ll want to go in like I said to 

each of the layouts and make sure that if you’re creating a presentation with that layout that it’s 

going to have all the formatting, the pictures, etcetera that you want there. I’m just going to go 

ahead and get out of this one right now so you can see how this works. 
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So I’m going to go back to the Slide Master tab and Close Master View. And by the way this is 

something that’s very easy to forget. Make sure you’ve closed the master view before you save it 

as a template.  

Now here’s what you’re going to do. You’re not going to do the File, Save As like you normally 

would. You’re going to go up to the tab that says Design. And remember all these designs? This 

is where we actually had chosen one in the very beginning. You can see the one that’s being used 

for this presentation. So all you have to do is down at the bottom choose Save Current Theme. 

Now I’m going to give it a name. I’ll just say My Theme for Now. And I can put it in one of 

these folders if I’d like but if not I’ll just save and there it is.  

So let me show you how this is going to work. I’m going to go ahead and close this file. And 

notice it’s still called Presentation because it was not a saved file. It was a saved theme. So I’m 

going to go ahead and say File and I’m just going to say Close.  

Okay. So we’re back on my presentation and let’s just say that I wanted to use that new theme I 

created on this presentation. So what I would do is I would go back to the Design tab, pull down 

my list and it should be here under Custom. Now I’m going to click on it and it’s going to 

change my whole existing theme to the new one that we just created.  

So a couple things I want you to notice is notice there’s my pencil on the left. See that? So 

you’re going to see that on all those slides since I changed it on the master.  

Now one other quick thing I just want to mention about these themes. If you’ve created a custom 

theme and you’d like it to automatically be the theme that’s used when you create a blank 

presentation you can set that by right clicking on that theme. And notice the Set as default theme 

option. So just know that you have that option to do that. 

We’re going to leave it right now like it is. I’m going to go ahead and save my presentation the 

way it is and then that’s going to wrap up module eleven, Working with the Masters. Now I do 

have an exercise that I want you to do over in section four. So if you’ll go ahead and flip over 

there I will show you what I want you to do for me. 
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Video: Exercise 10 

Cindy: Hey. Welcome back. This is Cindy. We’re working in PowerPoint 2016. We’re in 

module eleven, the masters, and we’re almost done. 

Now we’re down to section four which is the exercise. And all I want to know is that you know 

how to work with the masters and you understand the concept here. So this is not going to be 

very hard at all. Here’s what I want you to do for me. 

Go ahead and start by opening a practice file called Practice Presentation 11. Go into the slide 

master and I want you to change your titles for all your slides. I want you to make the titles a 

different color, pick a font, pick a size. If you want to do anything else with them feel free.  

When you get through with that you’ll see the bullets at the bottom of that slide master and I 

want you to change your bullets. So remember I told you that if you select the placeholder that 

all five bullets will have the same picture. If you want each picture to look different then click 

inside each level and change that picture. 

Once you get through with that go ahead and close the master view and just kind of look through 

your slides and check to see that all the titles look the same, all your bulleted slides look the 

same and so forth.  

Now go back into the master view for me one more time. Then I’m going to have you click on 

the title master. You’re going to add a little clipart picture. Just pick a picture of your choosing 

and stick it on the bottom right.  

Then I’m going to have you change the background. Now if you want to start with a color and 

just go ahead and see what that looks like. And then go ahead and try one with a picture as well. 

And once you get through with that just make sure they all look the same and they look good. 

Once you’re good go ahead and save and close the file and at that point you are done. 

You rock! 

So let’s go ahead and wrap up module eleven and go into twelve and start talking about working 

with media. 
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Chapter 12 – Working with Media 

Video: Adding Video to a Presentation 

Cindy: Hi. Welcome to module twelve of PowerPoint 2016. This is Cindy and we’re talking 

about working with media in this particular module. Now we’re in section one where we’re 

going to talk about adding video to your presentation. 

When you add video your users have a little bit more interest than if you actually had written text 

on a slide. So using video can be a very effective way to keep your audience interested in your 

topic. So let me go ahead and flip over and show you how you would add video to your 

presentation. 

I’m on slide one and what I’d like to do is go ahead and add a new slide. I’ll use the blank layout. 

Now what I want to do on this blank slide here I want to go ahead and add a quick little funny 

video, something to kind of break the eyes and get the students introduced to college.  

I’m going to go to the Insert tab and I’m going all the way to the right under the Media grouping 

and here’s our video options. Now when I click on Video I can do this a couple of different 

ways. I can use the online video option or video from my PC. If you use video from My PC then 

you have to have that video already on your computer. It’s not connected to the internet so that 

file is not linked in any way. A lot of people prefer this because they don’t want to get into a 

presentation and take the chance the internet’s not working and that sort of thing. But we’re 

going to use online video. 

Now I can insert my video a couple of ways. I can use YouTube or I can insert it from a video 

embedded code. Now let me show you the YouTube option which is really kind of neat. 

What I can do is I can type in here whatever I’m looking for and it’ll bring up any videos related 

to that particular subject. So I’m going to hit the Enter key and it’s just like if I was working out 

on YouTube. 

Now let’s say that I’m looking through my videos and I like this one. I’ll go ahead and choose it 

and I’ll click Insert and there’s my video.  

Now I want to make it a little bit larger so I’m going to just size it a little bit. Now if I want to 

actually watch the video, I’m going to double click on it and when you double click what 

happens is you get the YouTube arrow that you see here and by clicking there that’s going to run 

the video.  

Video: (Music) Welcome to college. You have four semesters to declare your major. Your major 

is also known as your future. Good luck. (Music) 
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Cindy: I’ll go ahead and stop it there. So now you see how to run your video. 

Now a couple of things you can do with the actual video itself. Notice that you have a Video 

Tools contextual tab and you’ve got a Format tab and a Playback tab you can pick options from.  

So first of all let’s look at the Video Styles.  

So I’m going to go ahead and choose this one. And it just looks a little nicer that way.  

Now a couple things you could do over here on the left. Here’s where you could preview their 

video. You can also work with the color corrections if you need it to be a little bit brighter, for 

example, or if you need to actually change the colors. 

Now let me also mention what this poster frame option is for. If you have a particular frame in 

your video that you would like to be the one that’s showing up when the video is not currently 

running then you would run the video, pause it at that particular frame and then come in and 

choose Current Frame here.  

Also over on the right here’s some options as far as would you like the video to take on the shape 

of one of your objects? You could actually work at the border of the video and all the effects that 

we’ve previously talked about with other objects. 

Now under the Playback tab a couple things I want to mention here. Here again is a way to 

preview my video. Do you notice that a lot of these options are grayed out and I can’t use them? 

And that’s because if you have an embedded video or one that’s linked back to the internet you 

can’t use these options. The video has to be a straight video that you’ve got on your computer. 

Now I will say this. There are some add-in programs that you can go and download, a couple of 

them you can download for free. And what they do is they basically what we call rip. They rip 

out the video and actually allow you save it as a file on your computer. So just kind of know that. 

The other thing that you want to just make note of is this start option here. If you want your 

video to start automatically when you get to this particular slide, if you leave it on automatically, 

other than that you can say On Click. 

Now let me just show you real quick if you were going to put in an embedded video how you 

would do that.  

So just for a moment I’m going to delete this one. Now I’m going to flip over to YouTube 

because I’ve already got the video I want to use queued up. So let me flip over there real quick. 

In YouTube when you’re on the video that you’d like to get the embedded code for just scroll 

down until you see this Share option and then you can click on Embed which will select the 

embedded code here. Now just copy it and paste it back over into PowerPoint.  
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Here’s where you’re going to paste it. You’re going to go back to Insert. You’re going to go back 

over to Video Option, Online Video, and paste it right here where it says Paste embedded code. 

And then you just hit the Enter key and it pops your video in there.  

Now it does take a minute. And when you do it this way you get this black screen. So this is 

where you may choose to use the poster frame option that we mentioned. But you’ll notice that if 

you actually run the slideshow down at the bottom and then go ahead and wait just a minute 

there you’ll see your arrow that appears and you can play your video if you want. 

So I’m going to go ahead and hit Escape here and that’s how that works.  

What I want to do is now that you know how to put video in let’s go over to section two and talk 

about adding audio to your presentation as well. 
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Video: Adding Audio to a Presentation 

Cindy: Hey there. We’re working in module twelve and we’re talking about media in this 

particular module.  

Now we’ve already talked about how to add video to a presentation so let’s go ahead and talk a 

little bit in this second section about adding audio to your presentation. 

I want to go over to slide four here and this is the slide where we had a couple of bulleted items 

related to campus life benefits. I want to record some audio that will actually expand a little bit 

on these different benefits. 

Audio is great if you want to actually record it and then actually send this file to someone then 

you would have the audio already recorded and they could listen to it. It’s also great if you want 

to sit back and just kind of let it flow by itself so you don’t have to talk. But let me show you 

how to insert audio either way. 

I’m going to click on the Insert tab and come all the way to the Media grouping where I see 

Audio here. And notice that you have two choices. You can insert audio that’s already on your 

PC. So that would be maybe a WAV file you got from the internet or record your own audio like 

I was mentioning a second ago. So I’ll go ahead and record audio. 

When you record audio you have to give your recording a name. So I’m going to call this one 

Campus Life. Now the red circle is how you’re going to start the recording. When you’re 

finished and you want to stop it this is a blue square you can click on here. So I’m going to click 

on the red dot and start recording. 

I wanted to tell you a little bit more about campus life here. We have some new modern co-ed 

dorms that we’ve just recently renovated this year and we really think you’re going to like them 

a lot. We’ve also got some of the best food from around the world. We went out and got some of 

the top chefs, brought them here so we could actually give you guys a well-rounded menu to be 

able to pick from and help cultivate your dining experience. Also you don’t need a car here 

which is great. That’ll save you a lot of money because there’s easy walking to parks and 

anything else you need to get to. 

I’m going to click the blue square and now it’s done. Now if I wanted to listen to it I could click 

this right here and listen to my recording. But I’m going to go ahead and click OK.  

Now you’re going to see this icon here that represents your recording. And what you want to do 

is just move it somewhere on the screen where it’s not interfering with any graphics or texts you 

might already have. So I like to put mine in the bottom right because I usually don’t have 

anything here. If you’ve got sound on multiple slides try to put the icon in the same place and 

that way it doesn’t look too out of place. 
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Now a couple of quick things I want to show you about the look of this icon. If you notice now 

that I clicked on I have my Audio Tools contextual tab and I can choose the Playback or the 

Format tab. And on the Format tab, you’re familiar with all of this but I want to just show you 

that you could use some of these options if you wanted just to make it look a little bit nicer. So 

see how this one it really stands out because it’s got some black around it now? Now when 

you’re ready to run this all you’re going to do is either click here to play or pause it or you can 

click right on it when you’re running the slideshow. 

Now let me go to the Playback tab because there’s a couple of things here you probably want to 

know. 

First of all another way to play this audio would be to click right here on Play. But I want you to 

notice you can also do things like trim the audio. If you have audio and it’s a little too much and 

you want to cut it down maybe you can actually drag the slider left or right to tell it where to 

start the audio or where to stop the audio. And that lets you do what we call trimming, where 

you’re cutting out pieces of it. And you can listen to it down here once you’ve done that. So I’ll 

cancel that. 

You can also have sounds fade in or out right here. And you can set the timing on that if you 

like. And then also the volume. You can have it set on low, medium, high, or you can mute it if 

you needed to. 

Right now it’s going to actually start with you click the mouse like I mentioned. You may decide 

you want this to play across all of your slides. And if that’s the case you want to choose this 

option. The loop option means that once the audio plays and gets to the end it’ll wrap back 

around and start again. So that’s really good if you’re going to have your laptop sitting on a table 

at a conference, for example, where you don’t want to stand over it but you want them to have 

some audio. 

You’ve got some other options over here. You can hide it when you’re running your slideshow 

or rewind it after you play it. We can also have your audio play in the background.  

So those are just some quick options you have when it comes to working with audio. 

Let’s go ahead and wrap up module twelve, Working with Media. I do have an exercise I want 

you to do so go ahead and flip over to the exercise and I’m going to have you put in some video 

and some audio real quick and then we’ll move on to module thirteen and talk about transitions. 
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Video: Exercise 11 

Cindy: Okay so we’re back. We’re in module twelve, Working with Media. And this is the 

exercise that I want to have you do for me.  

You’re basically just going to insert some audio and you’re going to insert a video. Really easy. 

So let me show you what I want you to do here. 

We’re going to open a practice file called Presentation 12 and I’m going to have you put a new 

slide in and I want it to be the second slide. So when you put it in just go ahead and use the blank 

layout because you’re going to insert a video here from YouTube. And when you go in to insert 

a video just type the words College Life and pop in whichever one works for you. 

You’re going to also click on number three once you get that in and name on number three 

should be “Why Choose Us?” which was previously slide two. Record some audio about the 

slide and then just go ahead and save it. And that’s really all I want to have you do here. 

Awesome sauce! You’re done with module twelve so let’s go over to module thirteen and talk 

about transitions. 
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Chapter 13 – Transitions 

Video: Applying Transitions 

Cindy: Hi. Welcome back. We’re working in module thirteen now in PowerPoint 2016 and 

we’re talking about transitions.  

Now transitions are going to be different ways that the slides actually appear when you’re 

running through your slideshow. It gives them a little animated effect. So let’s kind of go through 

and talk a little bit about how to apply them and then we’ll go to section two when we’re finished 

and talk about the options for your transitions. 

We’re back in our presentation now and what I’d like to do is just run through the slideshow real 

quick to see what my presentation would actually look like at this point. 

So I’m going to click on the Slideshow tab and I’m going to choose From Beginning. Now in 

Office 2016 they really changed how the slideshow looks when you’re running it. If you’re using 

a dual monitor setup like I am you can actually switch what they call the presenter view and the 

slide view. So let me go ahead and do that. Now this is what we call the Slideshow View. This is 

what your audience would see as you’re presenting your presentation. 

Now I can click the mouse and go back and forth between the slides but notice the slides are just 

there. If we apply a transition I can have the slides come in from the left, maybe fizzle in. I can 

give it a little animated effect so it adds a little pizazz to my presentation. So I’m going to click 

Escape and I’ll show you how to add these transitions. 

Under the Transitions tab you’ll notice here are your transitions you can choose from. Now 

whichever slide you’re clicked on is the one that you will apply that transition to. You can have 

the same transition on all the slides or a different one on each slide. 

So notice I can choose cut or I can choose fade. And you can see as you choose each one of these 

it shows you what that particular slide is going to look like when the transition appears. So I’m 

not going to click on every one of these but notice they’re grouped by subtle, then they have 

some exciting ones here. This one is new. There are several new ones now. Here’s another one, 

glitter. This one’s kind of cool. And then the last grouping they have is what they call dynamic 

content. So you can decide if you need a subtle transition or if you need a dynamic transition. So 

I’m going to go ahead and click on each one of these and just choose one. I’ll just randomly 

choose one.  

Now if you knew that you randomly wanted to choose one on all of your slides there is a random 

option here and let me show you how that would work.  
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You would select all of your slides by holding down Control and hitting the letter A. That’s your 

select all. And you can see they’re all selected. Now if you wanted you could choose random 

which is under the exciting grouping and it randomly applies a transition to each one. Now 

notice the little star to the left of each of your slides. That indicates a transition has been applied.  

Now sometimes when I’m working with transitions I would rather see them in a different view. 

So down at the very bottom if you can see where I’m pointing this is Slide Sorter View. Now I 

can see the transitions a little bit better. I can see the little star on the bottom. And when you 

click on each slide it’s going to show you the transition that was applied. In this case they were 

all random. 

Now I’m going to go click on slide one again and I’m going to run back through my slideshow. 

So I’ll go to Slideshow and choose From the beginning. Now I’m going to go ahead and swap 

my presenter view and slide view again and I’m going to run through and notice how the slides 

come in. You can see some of them come up from the bottom, from the left. Some of them have 

a little effect to them. And every slide is going to have a little effect like this. Isn’t that cool? 

Okay I’ll just hit Escape right here. You get the idea. 

Now if at any time you want to change the current transition all you’ve got to do is click on that 

slide and pick the transition that you want from the Transitions to this slide option here. 

So that’s how that’s going to work. 

So what I’d like to do now is talk to you a little bit over in the second section about some of the 

options you have when you’re working with transitions. 
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Video: Transition Options 

Cindy: Alright welcome back. This is PowerPoint 2016. We’re working in module thirteen and 

we’re talking about transitions. Now this is section two where we’re going to look at some of the 

options as far as the transitions are concerned. We talked about how to apply them in the first 

section and now let’s talk about how to enhance them with some options. 

We’re back in our presentation and we’re looking at our slides in Slide Sorter View. Remember 

we got to that down here at the bottom. Now we can tell that we have a transition applied to each 

slide because there’s a little star under the bottom right of that particular slide. But I don’t know 

if you remember when we went through our slideshow the slides were just there and then we 

applied a transition and the transition gave it a little effect, gave it a little animated effect. But we 

didn’t hear any sounds and the effect was very quick. So here’s some of the options you have 

when you’re working with your transitions. 

Now under the Transitions tab if you look over here you’ll see Sound. So you have the ability to 

apply a sound on each slide if you’d like. You just choose the particular sound you’d like to hear. 

So I’ll just put sound on a couple of these and then we’ll run through the slideshow and see if we 

can hear them here. We’ll do a typewriter and let’s say this one here we’ll do suction. Alright so 

I’m going to click on slide one and I’m going to go back to the Slideshow and I’m going to 

choose From the beginning. (Sound) Did you hear the sound? Let me go ahead and swap the 

presenter view here. Now (sound), whoa. And I’ll click for the next one, one more. (Sound) So 

you hear the sound there? So you can apply sound to the different slides. 

Now the other thing is I just mentioned that the transition happened pretty quickly when we ran 

through the slideshow. And you can see there is a duration there. So if you wanted to change the 

duration of each one of these you can have it take a little bit longer for that transition to actually 

happen. So I’ll just see the first four again just to show you this. Alright I’ll go back to slide one, 

going to Slideshow and I’m going to go from the beginning. (Sound) See it’s a little bit slower. I 

don’t know if you can tell (sound) that or not. (Sound) Alright.  

So let me go back to Transitions here. If you wanted the same sound and the same duration you 

could apply that same one to all the slides if you wanted. So just kind of know that’s an option. 

Now the other thing I wanted you to see if that currently you’re going to advance the slide on the 

mouse click. That means you have to click the mouse for the actual transition to happen, for it to 

go from one slide to the other. You can actually set it up with some timings to move to the next 

slide after so many seconds. Now a little bit later in another module we’re going to be working 

with the timings and you’ll see when we set it up to run automatically that it will record the 

timings it took on each slide right here so we don’t have to manually decide what the best time 

is. 
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Now one more thing I want to show you. I’m going to click on slide one here. We chose random 

but let’s say that I manually pick a particular transition. That allows this effect options to be 

available. So here’s what I’m going to do. I’m going to click on each one of these and I’m going 

to choose a particular transition. (Sound) I’ll just randomly pick a couple of these. I’ll do the first 

four. (Sound) Don’t you just love those sounds when you’re not looking for them? (Sound) And 

I’ll just do one more here. (Sound)  

Okay. Now that I have a couple of transitions here I can work with the Effect Options and 

depending on which transition you’ve applied you might have different effect options. So the one 

I’m on is called Doors and I could have the doors come in vertical or horizontal. So here’s 

horizontal (sound) and here is vertical (sound). Alright. On this next one I have Fly Through 

chosen. So my options are going to be would I like to fly through and use the in or the out 

option? So here’s in. (Sound) And here’s out. (Sound) Okay we’re going to try this third one 

here. So Box gives you from the right, from the bottom, from the left, from the top. (Sound) So 

you see how it just depends on which transition you’ve chosen what your different options are 

going to be for that particular transition. (Sound)  

So those are going to be your options for transitions. There’s a lot here. You just have to get in 

and play with them and it’s a lot of fun. 

So I’m going to go ahead and save this real quick and then we are going to look at the exercise 

for module thirteen. I’ll see you shortly. 
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Video: Exercise 12 

Cindy: Okay welcome back. We are in module thirteen of PowerPoint 2016 and we’re talking 

about transitions.  

Now we’re all the way at the end of this particular module. We’re in section three. And I want 

you to go through and do this quick little exercise for me. I just want to make sure that you know 

how to apply transitions and work with some of the options. So here’s what I want you to do for 

me. 

Go ahead and open a practice file called Practice Presentation 13. Click on the Slide Sorter View 

and then go ahead and choose a different transition for each slide. And if you want to practice 

with using that random option like we talked about remember Control-A is going to let you 

select all the slides and whatever you do will affect all the slides. 

If you’ve got a transition for each slide go ahead and change the Effect Options as well. So 

remember some of your transitions may be coming in a little too quickly or you may want to add 

some sound, things like that. Go ahead and kind of play with that. 

Once you think you’re comfortable with it run your slideshow and see how your presentation 

looks. If it looks good you can save and close the file.  

Looking good! 
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Chapter 14 – Animation 

Video: Animating an Object 

Cindy: Hey there and welcome back. This is Cindy. We are all the way down to module 

fourteen in PowerPoint 2016. And we’re going to spend time in this module talking a little bit 

about animation.  

So you’re going to see that you have the ability to actually animate objects. And remember an 

object might be text you’ve typed in, it could be an actual picture. So you can make all of that 

stuff move. It could be you want something like your title to look like it’s being typed in or 

bullets to come in one at a time or a picture to run across the screen. Those are all considered 

animation. So let’s go ahead and get started here in section one. 

We’re back in our presentation here and we’re on slide one. Now you have the ability to animate 

any object in your presentation. So remember an object may be a picture that you have, like this 

picture here, or it could be some text like my title here because it’s in a placeholder so it’s 

considered an object. You can animate any of that that you’d like.  

Keep in mind that you might want to limit the number of animations that you have in your 

presentation. If you have too many animations it can be very distracting to your audience. 

They’re going to spend more time trying to figure out how you did that versus listening to what 

you’re actually saying. So use them but use them wisely in your presentation. Also keep in mind 

that we have transitions in ours. So we already have somewhat of an animated effect going on 

with the slide itself. So adding too many animations to a slide can be very distracting, like I just 

said. 

Now we’re on slide one and you can animate the objects here if you want. You may not want to 

because typically slide one is the slide that’s sitting on the screen as your audience is sitting 

down grabbing their coffee, waiting to get ready for your presentation. So you may choose not to 

animate anything on slide one. That’s really up to you. So I’m going to go over to slide three. 

I’d like to animate my title here. So what I’m going to do is choose my title and select the 

placeholder. You’re going to find the animations under the tab that says Animations. When you 

first come in you’re going to see several animations you can pick from but you really need to 

come over here and click the down arrow to see more and that way you can see there are several 

additional ones that you can choose from.  

Now these are set up by category. You’ll see there is a category called Entrance. So that means if 

you choose one of these that’s how the title will actually enter the slide. Emphasis means once 

the title is actually here what do you want it to do for emphasis? Maybe grow larger or spin 

around, change colors. And Exit means when you click the mouse how do you want the title to 

exit the slide? You may not want it to exit at all. So you don’t have to pick every one of these.  
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Now you’ve also got some motion paths down at the bottom. So if you have a particular path you 

would like your animation to take then you can choose one of these and we’ll talk about this here 

in a couple of minutes. 

Now also notice the None at the top. So if you do animate something and you want to take it off 

that’s how you’re going to take it off. 

So I’m going to go ahead and put one of each on here so you can how this works. 

So starting with Entrance I’m going to choose float in and you can see it gives you a preview 

back there of float in. You noticed it just kind of came up from the bottom very slowly. That’s a 

float.  

Now if I want to add an additional animation to the same object I’m going to come over to this 

Add Animation that you see right here. Just so you’ll know in previous versions you could 

actually go over to the animations over here and choose as many as you want and would keep 

adding them to your object. But here you have to choose the Add Animation to add additional 

ones.  

So I’m going to come down to Emphasis and I’ll pick teeter. And let me choose one more. I’ll 

choose one for exit here. So I’ll come down to Exit and I’ll just say fade. You’ll notice now I 

have three animated effects on this particular object. Now I want to run the slideshow and show 

you what this one would look like. 

(Sound) Now you have to click the mouse right now for each one to actually animate. So I’ll 

click once and my title appears. See how it came up from the bottom? I’ll click a second time 

and you’ll see that it’s teetering. And I’ll click a third time and you’ll see it disappear from the 

slide. So let me go ahead and hit Escape and get back to our presentation.  

Now you can also animate bullets. So when you click on your bulleted items you’re really going 

to do the same thing. You’re going to come in and decide how you want the bullets to appear. I’ll 

say they’ll float in. Notice they’re floating up from the bottom. We’ll learn how to change that 

shortly. Notice also that’s four, five, and six and now I have six animations on this particular 

slide. 

So let’s say I’ll add another animation. I’ll say that for emphasis I want them to spin around. And 

now I’ll not put an exit on this particular one. I’ll leave them here like this.  

So let me show you how bullets animate. 

I’m going to go down to run the slideshow again. I’m going to click for the title to come in, title 

disappears and here’s my bullets one at a time. Now the neat thing about this is notice that I can 

talk about one bullet and the audience doesn’t have to see the second one until I click the mouse. 

Notice the first one stayed and then I’ll click one more time for that one to appear. 
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So that’s how it’s going to look with bullets. 

Now you’re going to see with pictures that you can actually make them slide around on the 

screen, you’re going to make them spin, all kinds of things like that. So why don’t we go over 

and look at slide number five, for example.  

I’d like to go ahead and animate all of these objects here. So I’m going to go ahead and select 

them all. And I’m going to go up here and I’ll choose Grow and Turn and there he goes. See how 

they all animated at the same time because they were all selected. I can add an additional 

animation if I’d like. So let’s say I’d like to have them color pulse and you can see they just did 

what they call color pulse back there. So again you can add as many animated effects as you’d 

like. 

Now let me mention this. I’m going to go ahead and go to slide four for just a moment. And I’ll 

select my title here. In addition to just the animated options that you see here you’ll notice down 

at the bottom of the list you have more entrance effects, more emphasis effects and more exit 

effects. Now these are going to give you some additional choices. So I’m going to click on more 

Entrance Effects.  

What they’ve done here is they’ve taken the effects and they categorized them into what they call 

basic effects, subtle, moderate. And if you scroll down you’ll see they’re exciting ones. So just to 

show you some exciting ones I’ll go ahead and pick Spiral in. And there it is. Well here’s 

Boomerang just to show you. There’s boomerang. That’s kind of neat. So just kind of notice you 

can also pick from those options as well. 

Now going back to slide three, for example. We had noticed that we animated our title and when 

we did it came up from the bottom. Now depending on which animation you’ve chosen you’re 

going to have different animation effects right here. So in this particular example let’s say I’m 

clicked on the first animation here. Notice that under Effect Options I can have it float up or float 

down. So in my case it was floating up automatically. Also notice it’s going to come in as one 

object. But also notice if I come over here and click on the number two then that’s teeter and my 

effect options will be different. So depending on which animation you’re clicked on, this one’s 

fade, you’re going to have different options as well. So just kind of know you always have 

different effect options you can choose. 

Notice over on the right that they’re currently going to start on mouse click. So when we talk 

about the timings a little bit later you’ll be able to actually set your timings here. And you can 

also do some things with moving the order of animations that we’re going to talk about shortly. 

Okay so why don’t we do this now. Let’s go ahead and look at section two and talk about the 

animation effects and the timings that we can apply. 
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Video: Effect Options 

Cindy: Hey there. Welcome back. This is Cindy again. We are still working in PowerPoint 

2016. We’re down to module fourteen where we’re talking about animation. Now this is going to 

be the second part or the second section where we look at the animation effects and the timings.  

Now we’ve already seen how to apply some different animated effects to our different objects. 

Now let’s look at some of the effects and the different options as far as how long you want to 

wait between clicks. Do you want it to run automatically? Things like that. So let’s get started. 

Okay so in section one we actually talked about applying these animations to our objects. And 

we saw that when we have a particular object selected that you can click on the animation and it 

will show you which effect you chose. And if you had any effect options you would see them 

over here. So in this particular case we saw that we could float this one up or down and also the 

sequence it would come in as one object. So I want to show you how you can actually go in and 

work with some additional effect options.  

Now I’m going to use the bullets in this particular case because there’s a couple of really cool 

things you can do with the bullets here but this would work for any object. 

Now I have my bullet selected and what I’m going to do this time is I’m going to click the arrow 

on the bottom right of my Animation grouping.  

Now the first thing that comes up is the Effect Options and I’m on the Effect tab. Now I have 

multiple animations applied so that’s why you’ll notice this one said multiple and this came up 

instead of Effect Options. If there’s just one animation applied it will have that particular name 

right here. 

Now the first thing you’ll notice is that in addition to having my bullet animate I can also have a 

sound. Now this will be way too much in this case but I could do that if I wanted to. 

After animation what do you want it to do? Well here’s what this means, for bullets specifically. 

I’m going to click for bullet number one to come in and when I click for bullet number two 

nothing is going to happen to one. I’ll just see one and two on the screen and then I’ll click and 

see three and see all three at once. I can say after I show bullet one and I click for bullet to come 

in what I want bullet one to do. Do I want it to maybe change to a different color? Do I maybe 

want it to hide? Now if you’re going to have it hide hide on the next mouse click not after 

animation. If you hide after animation it will animate and then disappear. You want it to 

disappear when you click for bullet two to come in.  

Now I’m going to go ahead and make mine a different color. I’m also going to be animating the 

text all at once. I could animate these by the word or by the letter. I’ll say by the word.  
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Now you can also change the percent of delay between your words. Be careful because five 

seconds is a long time. So you want to be careful with that. 

But let me go ahead and click OK now and just show you what we have. There is bullet one, 

clicked bullet two comes in, now bullet three. And see how the previous ones turn a different 

color. Now because there are some additional effects on these you’ll see that they’re also 

animating and doing this little number here. But let me run through the slideshow real quick and 

show you. 

(Sound) So I’m going to click once for my title to come in. My title does all its little animations 

there. Now let’s do the bullets. Here’s bullet one coming in one word at a time. Now I can talk 

for five minutes or one but when I click bullet two comes in but notice what happened to bullet 

one. It’s a different color. And now I’m going to click for bullet three to come in and the same 

thing, bullets one and two are a different color. So it kind of keeps your audience with you. So 

it’s a great way to use this for bullets. 

Now let me go back in and show you a couple of more of those effect options. 

You do have a Timing tab. So right now your bullets are going to start on the mouse click. You 

can have objects animate with other objects. So that’s what this would be. You can set the delay. 

You can also set the duration. Do you want it to go very slow? Do you want to take five 

seconds? Do you want it to go two seconds which is medium? You can also have it repeat. And 

this is how many times you want it to repeat or repeat until the next click or the end of the slide. 

And you can have it rewind when done playing so it’ll just start all over. Now we’re going to 

look at the triggers over in section four so I’ll hold that for a minute. And now you have your 

text animation. 

Now right now you’ve got group text by first level paragraphs. These are first level bullets. If 

you had a second level bullet, for example, on each one of those you could have all of the first 

level bullets animate together and all of the second levels animate together and that’s what this 

would be. See how you can have up to five levels of bullets? And they actually call them 

paragraphs. Automatically after so many seconds you can have the text animate. And also you 

can have it animate in reverse order if you want. So those are going to be your options when it 

comes to working with your effect options here. So I’m going to go ahead and click OK and you 

just saw a really good use for this with bullets.  

So what I’d like to do now is go over into section three and let’s talk a little bit about working 

with the Animation Pane. 
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Video: Working with the Animation Pane 

Cindy: Okay welcome back. This is Cindy again. We are working in PowerPoint 2016. And 

we’re working in module fourteen, Animation.  

Now we’ve gone through in section one where we talked about how to animate an object. We’ve 

gone through section two where we talked about some of the animation effects and timings. And 

now in this third section I want to talk to you about working with the Animation Pane. 

Okay let’s go ahead and click on slide three. This is the slide where we had animated these 

bullets. Here’s how you’re going to turn on the Animation Pane. You’re going to click on the 

Animations tab and you’re going to come over and click on Animation Pane.  

Now you’re going to see the Animation Pane appear on the right of your slide. All of the effects 

that you see listed here are the ones that are on this particular slide. If you went to a different 

slide you would see a different list because it has different animated effects on it.  

Now a couple of things you’ll notice when you’re looking down this list. Notice the numbers 

correspond with the numbers that you see over here. So that’s how you know which animation 

effect you’re working with. If it’s in green that means it’s an entrance effect, yellow is an 

emphasis effect and the red ones are an exit effect. 

Now you’ll notice that four, five and six here, this is a group. And so is seven, eight and nine. 

Now what I mean by group is when we actually selected our bullets to begin with we selected the 

placeholder just like this and that means there were three objects in there so all three were 

animated one after another there. So that’s why that’s called a group. They were animated as a 

group. Notice with every group there’s some arrows on the bottom left. You can click to hide the 

contents of that group or you can click to show the contents of that group, either one. 

Now you could also change the order of your animation. 

Let’s say I’m clicked on this third one here. I can either drag it up and down like this and 

wherever that red line is that’s where it’s going to be when you let go. Or notice there’s some 

arrows here where you can move these up or down one at a time in the list. 

You’ll notice next to each effect here is a down arrow. And when you click the down arrow 

you’re going to have several different choices related to this particular effect. So notice that right 

now I’m going to start each one of these on the mouse click. But I could start with previous. So 

that means if I want two and three to animate at the same time I can have them come in together. 

I could also start after the previous. So three can animate after two. And those would be 

automatic. But if you want them to start on mouse click then this has to be selected. 

Now the Effect Options and the Timing we’ve already seen but let me go ahead and click on 

Effect Options again.  
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We actually saw these options when we were working with the Effect Options here and also the 

down arrow under the Animation grouping. So this is where we talked about we could apply a 

sound if we wanted each time the effect happens. We might have options that we want to dim out 

or turn to a different color or we can animate the text all at once by the word or by the letter.  

Under the Timing tab, we’re going to be talking about triggers over in section five and a lot of 

these we can apply when we’re working with triggers. 

And the last tab we talked about is the Text Animation. So let me go ahead and just click OK and 

get out of that. 

Now I’m going to go back over and click this arrow again. You’ll also see an option to Hide 

advanced timeline. So if I click on that it looks like this. If I go back and choose it again then I 

can show the advanced timeline. So you can just hide it or show it. 

Now the last thing that was on that list I wanted to show you is the option to remove that 

particular animated effect. So that’s how you’re going to work with your animation options. 

Now notice also that you can play all and it’s going to start from the one you have selected. So 

I’ll just go ahead and stop that but that is a way to kind of go through it and see what it’s going to 

look like. 

Now when we start talking about our motion paths in section four and the triggers in section five 

you might have to come back to the Animation Pane to change a couple of options related to 

those particular features. 

So that’s how the Animation Pane works. Why don’t we move over now into section four and 

talk a little bit about motion paths. 
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Video: Motion Paths 

Cindy: Hey there. Welcome back. We’re still working in PowerPoint 2016. We’re in module 

fourteen where we’re talking about animation.  

Now we’re down to section four now where I want to show you how to work with motion paths. 

We already know how to animate an object and make it fly in from the left if we wanted but we 

might want it to follow a certain path before it stops and that’s where motion paths comes in. So 

let me show you how that works. 

Alright let’s go down to slide fourteen here. And on slide fourteen in a previous module we had 

actually added a SmartArt object. I can tell this is a SmartArt object because when I select it it 

says SmartArt Tools under the contextual tab here. 

What I want to do is go ahead and convert this to a shape and then when it becomes a shape or a 

regular object in PowerPoint I can then work with the different objects individually. So here’s 

how you convert a SmartArt object to shapes. 

I’m going to click on the Design tab and I’m going all the way over to the right where it says 

Convert and I’m going to convert to shapes. And now this is a regular object. And the reason I 

know that is when I look up here I now see Drawing Tools. So now if I want to ungroup this I’ll 

go to the Format tab, I’ll go over to Group and then I can ungroup. And now these are three 

separate objects that I can work with individually.  

Now the first thing I’m going to do is I’m going to apply some animations to each of these 

individually. And I’ll just pick float in. Currently you’ll see they’re going to float from the 

bottom up and that’s because right here it says Effect Options float up. Let me go ahead and add 

the same one to this one and the same one to this one. I’m not going to do them all at the same 

time because I want them to animate individually.  

Now right now I just showed you they’re going to float up but I’d really like when I talk about 

Apply for it to move over to the right so then I can talk about Find Money. So what I’m going to 

do is I’m going to click on the scroll bar here and you’ll see the motion paths right down here. 

Now you’ve got several just generic ones you can pick from. The first one is lines and you’ve 

got some shapes and loops and a custom path. But let’s start with lines just to show you a basic 

one. 

So currently I have a motion path called lines and you can see that it’s going to go down and then 

if I want to go back up I can make it go up. But instead I’d like it to go over to the right. So see 

how I grabbed this red circle right here and I just moved it? So let me show you what this is 

going to look like now. I’m going to run the slideshow and notice when I click the mouse Apply 

is going to slide over to the right and then I can click a second time for Find Money to appear. So 

I’m going to go ahead and apply the same one to Find Money. I’ll just go down again and pick 
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lines. Again when it come back up here I’m going to grab the circle at the bottom and I’m going 

to drag all the way over to the right like this and that one’s done. And I’ll do the third one as 

well. Same exact thing. I’m going to go back and I’m going to pick lines. When it comes back up 

I’m going to try to grab that red circle. And you might have to scroll down a little bit. Sometimes 

you have to do that so you can see the whole thing. And then I’ll pull this one over to the right 

like that and perfect.  

So let me show you how this is going to look. I’m going to run the slideshow. So I’ve talked 

about Apply and I’m going to click the mouse. Notice Apply slides over to the right. So now the 

audience knows I’m talking about Find Money. When I’m finished with that I’ll click the mouse, 

Find Money slides over to the right. And now the audience knows I’m talking about Register for 

classes. And when I’ve finished with that I can click as well and that will slide over to the right 

and then I can move on to my next slide. 

So that’s another quick way to keep your audience with you. 

Now you’re not always going to want to use the straight line. So for example, if I go back to my 

motion paths there is a custom path which will let you actually draw your own path.  

Now I wanted you to also notice the More Motion Paths down here. What you’re going to see is 

that there are three different categories that they have these listed in. They Basic, they have Line 

Curves and they have Special. So I’m going to move this over to the left a little bit. Now just to 

kind of show you some of these I’m going to choose Neutron. That’s neutron. Or I’m going to 

choose Curvy star. That’s curvy star. See that? So you can always pick some of these different 

motion paths if you like.  

Now before I do one of those I’m going to go back to the first one for a second. 

It could be that instead of having this stop over on the right I want this object to totally leave the 

slide. If that’s the case then drag your motion path all the way off of the slide. Now when you’re 

doing this you’ve got to be really careful sometimes because if you try to do it all at once your 

object might jump back on to the slide. So sometimes you have to pull a little it at a time. But 

just to show you this and I’ll do this one too. There you go. When I run the slideshow. So I’ve 

talked about Apply. Notice it leaves the slide. I’m going to click again, Find Money leaves the 

slide and now I’m on Register for classes. So remember that wherever you leave the object that’s 

where it’s going to stop. 

Now I do want to show you some other motion paths but I’m going to show you this at the same 

time I show you the triggers over in section five. So let’s go ahead and move over there and we’ll 

talk about the triggers and create some custom motion paths at the same time. 
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Video: Triggers 

Cindy: Hey. Welcome back. This is Cindy again. We are still working in PowerPoint 2016 and 

we’re working in module fourteen where we’re talking about animation. Now we’re all the way 

down on section three where I want to talk to you about triggers. 

Basically triggers add more of an interactivity to your presentation. You can have some cool 

visual effects happen when you actually click on a shape or a picture. So let me show you some 

of those neat little things you can do. 

Okay the first thing I want to do is I want to add a new slide and I want it to be slide four. So I’m 

going to go ahead and add a new slide and I’ll pick title and content. And what I’m going to do 

here is make a list of all the different degrees the college offers. So we’re going to say Degrees 

Offered In. Computer Science, the next one will say Graphic Design. We’re going to have 

Healthcare and the last one will be Human Resources.  

Now here’s what I want to do. I would like to be able to click on Computer Science and have a 

picture related to Computer Science pop up. When I click Graphic Design I want a picture 

related to Graphic Design to pop up. The only way to make that happen is to create a trigger.  

Now before I do this let me put some more spacing in here for this. So let’s go ahead and just 

change the line spacing a little bit so we have some more room. There you go.  

Now here’s what I have to do. I’m going to actually draw a box around each one of these. Now 

when I draw the box I’m going to go ahead and right click and I’ll format it so that we make it 

transparent so you can see the text through it. And then we say No Line and then it just looks like 

the text is there. And the reason we’re doing this is because when we actually put our picture in 

we’ll create an animated effect to go with it. But the trigger has to be triggering another object. 

So it has to be triggered by another object. So this has to be an object in order for this to work. 

So let me go ahead and do this with each of these. I’m just going to draw a box around each one 

just like we talked about and I’ll go ahead and say it’s transparent and no line. I’ll do another 

one. Do the same thing here. Make this transparent and no line. And one more. So go ahead and 

make this one transparent and no line. And it really doesn’t matter if you get the size exact or 

anything like that because you’re not going to see it anyway. It’s just basically so we have an 

object to trigger. 

Now what I’m going to do is I’m going to put in my first picture related to Computer Science. So 

I’m going to go up to Insert, Insert a Picture and I’ve got one called Computer Science. And I’ll 

just kind of move it over here like this.  

Now what I’m going to do is I’m going to go ahead and apply some animation to this. It doesn’t 

matter which one. I’ll just pick fly in. So we can see it’s going to fly in and it’s going to fly in 
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from the bottom. But now what we’re going to do is we’re going to say this animation is 

triggered when we click on the Computer Science object. So now what I’m going to do is I’m 

going to choose Trigger and I’m going to trigger on the click of rectangle three. Now just so you 

will know I like to do these one at a time because it doesn’t tell you that rectangle three is 

Computer Science. You just kind of have to know that. So that’s why if you do these one at a 

time you’ll be fine. 

Now let me go ahead and put in the next picture. So that one’s done. See the little lightning bolt? 

That means there’s a trigger applied.  

So I’m going to go back to Insert. I’m going to put in a picture that represents Graphic Design. 

And I’ll put this directly on top of this other one here just so it covers it up like that. Now I’m 

going to pick an animation again and I’ll pick fly in. So we know it’s going to fly in but I also 

want it triggered when I click Graphic Design. So I’m going to click on Trigger, On click of 

rectangle four.  

Now let me go ahead and do this with the last two. We’ve got Healthcare. So I’ll insert a picture 

of Healthcare. Same thing. I’ll just put it on top of this other one like this. I’ll go ahead and 

choose an animation. I’ll do fly in. And I’m also going to have a trigger on that and this will be 

when they click on rectangle five. And then I have more. Insert a Picture. We’re going to do HR 

this time, cover up the other ones there, go ahead and go back to Animations. I’ll apply fly in and 

I go ahead and put a trigger on this one. And this time it’ll be rectangle six. 

Okay so let’s go ahead and run the slideshow and see how this works. 

So I’m going to run the slideshow and notice there’s no picture. But if I click on Computer 

Science there it is. What if I come down to click on Healthcare? There’s Healthcare. What if I 

click on HR? There’s HR. See how that works? So our animation is triggered by an object that 

we have over here on the left.  

So one thing you might have noticed, it’s probably a really good idea to actually cover up each 

one like we saw back there because you don’t want to see one underneath the other. So make 

sure you really cover them up. 

Now I’ve got another really great example here. I want to put a slide at the very, very end of this. 

So I’ll make it number twenty. And I’m just going to actually put a title only on this one. And I’ll 

just kind of move it down a little bit. Now what I’d like to do this time is I want to actually say, 

“What’s Next?” Now just to give them something fun to think about I’m going to actually put in 

a picture that’s going to be triggered when I click on “What’s Next?” So I’m going to go ahead 

and insert this picture of this beach that I have. It’s a really cool picture here. And I’m going to 

make it as big as the whole slide here. Now normally what’s going to happen is let’s say I’m on 

slide nineteen and I run through the slideshow here. Notice what’s going to happen is there is my 

beach. But what happened to “What’s Next?” Well obviously it’s covering it up. 
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So what I’m going to do at this point is I’m going to go ahead and apply an animated effect to 

this picture. I’ll just pick fly in. And what I want to happen is when I actually have the picture 

come in I want it triggered by me clicking on “What’s Next?” So I don’t want to click “What’s 

Next?” and then the picture show up on the next slide. I want to click “What’s Next?” and have 

the picture show up here automatically. So I’m going to go back to the picture and let me pull it 

back up again. And I’m going to go ahead and trigger it on the click of Title 1. Now let’s see 

what happens if we run the slideshow.  

So there’s “What’s Next?” Notice if I put my mouse on top of the text there I get the hand. And 

if I click there’s my picture. Isn’t that cool? So that’s how that whole trigger and animation thing 

is going to work. 

So what I’d like to do now is go ahead and wrap up this particular module. And I’ve got a quick 

exercise I’m going to have you do for me. So go ahead and go over to the last section there and I 

will tell you what I need you to do and then we’ll be good with animation. 
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Video: Exercise 13 

Cindy: Okay welcome back. We’re working in module fourteen of PowerPoint 2016. And this is 

where we’ve been talking about all the animation. 

Now we’re down on section six which is the exercise that I’m going to have you do. So I want to 

make sure that you’re okay with working with some of those animated effects that we’ve been 

talking about. The motion paths and those sort of things as well. So let me show you what I want 

you to do for me. 

Go ahead and open a practice file called Practice Presentation 14. When you get in there I want 

you to go to slide three and select the title for me. Go ahead and play with entrance and emphasis 

effects. And if you want to add and exit feel free. I just want to make sure you know how to add 

those effects. 

We’re also going to add some effects to the bullets in slide number three. So make sure you 

choose the placeholder. When you get that done choose the option to change the previous bullet 

to a different color on mouse click. 

Open the Animation Pane after that and rearrange slides two and three for me. And then go to 

slide six and animate the title. Once you get that done I want you to play with the motion paths. 

So just go ahead and pick the motion path of your choosing and when you’re done with that and 

you think you’re okay with everything save and close the file. 

So awesome as usual and I will see you over in module fifteen. 
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Chapter 15 – Hyperlinks and Action Buttons 

Video: Working with Action Buttons 

Cindy: Welcome back. We are making our way down to module fifteen of PowerPoint 2016. 

Now in this particular module we are going to talk about Action Buttons and Hyperlinks.  

Now this is section one where we’re going to talk first of all about the action buttons. And all an 

action button is is a button that you can add to any slide that will allow you to complete an action 

when you click on it. The action may be something like have it go over and open an Excel file. It 

could be jump to a particular slide in the presentation. It might be open a whole different 

presentation, go to a website, who knows. So let me show you how the action buttons work. 

Okay I’m going to click on slide four here. This is the slide where we’re talking about the 

different degrees that the college offers. Let’s say when we get to this point that I want to open 

an Excel file that has some statistics on the percentage of people that graduate in the different 

areas.  

Now normally I’d have to minimize PowerPoint, go over and open Excel, find the file I want. 

And so what that does is leaves my audience sitting there. They’re waiting for me to open the 

file. They’re seeing screens I really don’t want them to see. So it’d be kind of nice if I had an 

action button or a hyperlink here that would just take me to that Excel file. And that’s what this 

is going to do.  

So I’m going to go up and find my shapes. So wherever your shapes are just go to the bottom 

and you’ll see the Action Buttons. 

Now there are several down here that you can draw and these already are preset up to hyperlink 

to. For example, this first one will go to the previous slide or the next slide. Then these two go to 

the beginning of your slideshow, the end of the slideshow. There’s several different ones here.  

It really doesn’t matter which one you draw because you’re going to tell it where you’d like to 

hyperlink to. I’ll just draw this house. And I’ll just stick it right down here. Now as soon as you 

draw the object you’re going to see the Action Settings pop up and you’re going to see two tabs. 

One that says Mouse Click and one that says Mouse Over. The mouse click option means that 

you have to actually click the mouse in order for it to hyperlink. The mouse over means you’re 

just going to move the mouse over your object and it will hyperlink. Now the same options are 

under both so you’re going to use one tab or the other.  

Now because I drew this particular one it wants to hyperlink to the first slide. But notice I can 

tell it I want to hyperlink to the last slide that I viewed, the end of the show. Notice I can 

hyperlink to a URL. So I can go to a website if I want. I can hyperlink to another PowerPoint 
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presentation or other file. I’m going to choose other file and go find that file. And here it is. It’s 

called Graduation Rates. 

Now just kind of notice a couple of other things here. You can run a program if you want at this 

point. If you want to play a sound. But I’m going to go ahead and click OK and show you how 

this works. 

Now the action buttons only work while you’re running the slideshow. So I’m going to run the 

slideshow. Now when I want to open that Excel file I’m going to click on this right here. Now 

before I click just kind of notice the little screen tip that appears. And in this case it just shows 

my file name and path for the Excel file. So I’m going to go ahead and click on it and it’s going 

to open that Excel file. So see how quick that was? Alright let me close that. 

Now a couple of things about this. First of all it’s very tacky. So I’m going to show you how to 

actually use some other objects that look a little nicer to use these with. The other thing is notice 

I had to be on this particular slide and that’s fine if that’s what I want but if you wanted it to be 

on any slide because you’re not sure when you’ll need to open that Excel file then actually draw 

these on your master. 

So I’m going to go ahead and hit Escape here and show you a couple of those things I just 

mentioned. I’m going to delete this one. 

Now I’m going to go ahead and put mine on the master. So I’m actually going to go back and go 

to the View tab and I’m going to go to my slide master. 

Now this time what I’m going to do is I’m actually going to draw it here. So I’m going to go 

ahead and grab my shapes again and again it won’t matter which one I draw. And let’s say I do 

something like this. Maybe if I put it in, let’s put it in the bottom right of every slide like this. 

That way it’s not quite so conspicuous. Now I’m going to hyperlink again to other file. I’ll go to 

that same graduation rates and I’ll click OK. Now I’ll need to go back to my Slide Master tab. 

I’m going to close the master view and notice you see it on each slide. Now the ones that you 

don’t see it on those are ones where we took the background graphics off. So just kind of know 

that. Or it could be a different layout. So you’d want to go in and put it on every layout that 

you’re using in your presentation. So remember to do that in your master. 

So that’s a little bit about how those action buttons actually work. Now what I want to do now is 

let’s take this a little bit further because like I said those buttons are ugly. So you’ll want to 

actually use maybe some funny pictures or something that looks like it belongs on the slide. And 

we’ll use hyperlinks to actually come up with the same exact end result. So I will see you over in 

section two where we talk about working with hyperlinks. 
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Video: Working with Hyperlinks 

Cindy: Okay welcome back. Hey it’s Cindy again. We’re in PowerPoint 2016 and we just got 

through talking about how to work with those action buttons. So what I want to do now is take it 

a step further and talk to you a little bit about how the hyperlinks work. So let’s go ahead and go 

over to our exercise and I’ll show you how that works. 

So here’s what I want to do. Instead of using these action buttons that we had picked from our 

shapes earlier we’re going to delete that and we’re going to put in an actual picture that looks 

like it belongs on the slide. So remember that that action button is actually on the master like I 

said. So we’re going to have to go back to the view and we’re going to have to go back to the 

slide master. 

Now I’m going to come down and just delete it like this. Now I want to insert a different picture. 

So I’m going to go to Insert. I’m going to insert a picture. And if I go back to my desktop. Let’s 

see I have a folder called My Files and there it is right there. Now let’s say that I want to put this. 

I’m going to make it really tiny like this. And I’m going to put it right up here to the left of each 

of the titles. As a matter of fact I can make it a little bit bigger than that. So if you do this it’s 

going to look like it belongs here. Now I’m going to copy that because we need to put that on 

several different layouts. Remember? So how about the title layout I’ll go ahead and put it there. 

And you may not want it on the title layout. Not everyone does but let’s just put it there anyway. 

Let’s also put it on this one and I think we have another layout. We don’t have that one. Okay. 

So I’ll go ahead and close the master view. 

Now let’s go back and look at this. Starting with slide one. 

So first of all you’ll notice that I don’t have it on slide one but if I go down and start looking at 

my slides you’re going to see it to the left of each of the titles here. So some of these like slide 

six doesn’t have a title so there’s not one. But look at slide seven, for example. So it looks like it 

kind of belongs there.  

Now the only thing is we just put a picture there. We didn’t actually create a hyperlink so it’s not 

going to do anything at this point. So let’s go back into the master. So we’ll go back View, Slide 

Master. Now we’re going to actually create a hyperlink. So here’s how this works. 

If you actually right click on your object you’re going to see Hyperlink. Now when you 

hyperlink you can hyperlink to a file. So if you were going to hyperlink to a file you would want 

to go find that file. You could hyperlink to a website. So there’s different places you can 

hyperlink to. Now I’ll go to Recent Files and let’s say that we hyperlink to the Graduation Rates 

file right there. So I’m going to click OK and now let me close the master view and let’s see if 

this is going to work. 
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Now remember that it only works while you’re running the slideshow. So I’m going to come 

down and run my slideshow. And notice if I put my mouse there there’s the screen tip. Now if I 

click let’s see if it goes to that Excel file. And it does. Now I should be able to be on several 

different slides and I would be able to do that.  

Now one more thing you’ll probably want to change. That screen tip. It’s a little tacky. So let’s 

go back to View. We’ll go back to the slide master. I’m going to right click on my object again 

so that I can hyperlink and I’ll edit it this time. 

Now right up here is where the screen tip is. And this allows you to type any text you’d like in 

here. So if you want to put something in here like Graduation Rates you can. You can put 

whatever text you want in here. Now just click OK. Now I’m going to click OK again and let’s 

make sure that all of our layouts have that same hyperlink. So I’m going to scroll back up and 

you know what? We didn’t even have this one here so let’s go fix it. There you go. I’m going to 

right click and I’m going to hyperlink again, screen tip, Graduation Rates, and I’m going to click 

OK. 

Now let me go ahead and make sure that I’ve got our file chosen which is Awards. I’m going to 

go ahead and make sure the screen tips are in there and it is and I’m going to click OK. Now I’m 

going to close the master view and I’m going to try it out.  

So I’m going to go up here and click on slide four is a good one. I’ll run the slideshow. Now 

notice when I point to it it says Graduation Rate instead of that ugly looking file name and path 

we had earlier.  

So let me go ahead and hit Escape here and that’s how that’s going to work. So you can always 

take any object, add it to any slide whether you put it on the master or on an individual slide, and 

then you can create hyperlinks like I said to websites, to other files, etcetera. 

So that’s pretty much how the action buttons and the hyperlinks work. So let’s go ahead and 

wrap up module fifteen here. There’s an exercise I’m going to have you do. So go ahead and flip 

over to the exercise in section three and I’ll get you started. 
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Video: Exercise 14 

Cindy: Welcome back. We’re in PowerPoint 2016 and we’re down to module fifteen where 

we’ve been talking about action buttons and hyperlinks.  

We’re getting ready to do this exercise here which is going to be super simple because I just 

want to know that you know how to put in an action button and have it link to maybe another file 

or another slide on your presentation. Also how to take an existing object or either add one and 

make it a hyperlink. So let me show you what I’m going to have you do for me. 

I want you to open a practice file called Practice Presentation 15. Go ahead and click on slide six 

for this exercise and add an action button that will hyperlink to slide eight for me. Once you’ve 

done that go ahead and click on the table. You can use that as your object. I want you to have it 

hyperlinked to an Excel file called Graduation Rates. Now if you can do those two things you’ll 

be good to go. Just save and close the file for me and then that’s going to be it. 

As usual, great job and I will see you over in module sixteen. 
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Chapter 16 – Slideshow Options 

Video: Onscreen Presentation Options 

Cindy: Welcome back. This is Cindy. We are working in PowerPoint 2016 and we have made 

our way all the way down to module sixteen, Preparing a Presentation for Delivery. 

Now this is the first section where we’re going to talk about how do you review that presentation 

and make those changes that you might want to make before you actually present it to your 

audience. So let’s go ahead and see how to run through that slideshow real quick. 

When you get your presentation ready to go one of the things you’ll want to do is go through it 

just as if you were the audience looking at the presentation. You don’t want to show the 

presentation in this view because your audience is just seeing PowerPoint. It’s not very 

professional that way. So you want your audience to see what’s called the slideshow. 

There are a couple ways to get into the slideshow. First of all if you look at your views down at 

the bottom the last one will launch you into your slideshow. Now if you do it this way whichever 

slide is on the screen is the one it will start with. So just kind of know that. It’s not going to start 

from slide one automatically.  

Now the other way is if you go up to Slideshow you can use these options right here. This one 

will actually start from the beginning, meaning slide one. This one will actually start from the 

current slide, whichever one you have up on the screen. Notice also this Present Online option 

which is really kind of cool because this allows you to actually for free put your actual 

presentation out on the web and then people can view it in whatever browser they happen to be 

using.  

We’re going to be looking at custom slideshows set up over in module seventeen. So I just 

wanted you to know where those options were as far as starting to run your slideshow. 

Now notice one more quick thing. See this little checkbox, Use Presenter View. That means that 

when I tell it to run the slideshow I’m going to have this new view in Office 2016 called the 

Presenter View. And it’s kind of neat the way they have it set up. So let me show you what it 

looks like. 

I’m going to choose From beginning and this is presenter view. Now the advantage you have for 

using this is more and more people nowadays are using two monitors. So you can actually see all 

of this information and the audience doesn’t see this. They actually see just the slideshow. Matter 

of fact you have the ability if you come up here where it says Display Settings to swap the 

presenter view and the slideshow. So it’s basically going to swap the monitors. But this is what 

the audience sees right here. This is your slideshow. 
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Now I’m going to go ahead and hit Escape and I’m going to go back into it again because I want 

to show you some things in presenter view. 

So first of all notice the timing right here. This is telling you how long it’s taking you on this 

particular slide. If this bothers you you can pause it right here and you can restart it if you want 

to. The other thing is you can actually totally reset the timer and it’ll go back to zero and start 

over again. 

This is showing you the current time. So if you know that you need to be finished by a certain 

time you can have the clock right there so you can see this.  

Over on the right you’re seeing the next slide that’s coming up. So that just kind of gives you a 

preview real quick so you’ll know what to say. And then down here are any speaker notes that 

you might have. So if you have speaker notes here and they’re too small or they’re too large go 

ahead and use you’re A at the bottom to make it smaller or the large A to make it bigger like this. 

You have a couple of options underneath your slide here. One is to work with the pen and the 

laser pointer tools. Here’s where you can see all of your slides. So if you’re on slide one and you 

know you’d like to show slide sixteen, for example, you can go over there, double click on slide 

sixteen and then you didn’t have to show the audience all the slides in between. So that’s really 

kind of cool how that works. 

Now you can also if you wanted to go back to slide one you can click back on it again and go 

back to slide one.  

This next one will zoom into the slide. So what it does is when you click on it notice your mouse 

has this little box. And when you click you can zoom in or out on the slide. Now if I click on it 

again then I’ll zoom back out. 

Here’s how I black out the screen. So if I’m trying to get my audience’s attention I can black it 

out temporarily and then click back on it when I want to show the screen again. 

These little ellipses that you see right here, what these do is they let you view the last slide. So if 

you happen to be on sixteen and you wanted to come back to number one this is another way to 

do it. You can hide the presenter view. You can also show your screen in black or white. And we 

just saw how to black it out down here. And you can also end your slideshow here.  

Now at the very bottom you have these arrows that take you back and forth between the slides. 

So that is one way to kind of move back and forth. 

So like I said, you have a distinct advantage by using this presenter view here. Now I’m going to 

come up and end the slideshow. If I uncheck Use Presenter View and I run the slideshow again 

it’s going to launch you directly into the slideshow. Now if you have it up on two monitors 
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you’re going to see it on the other monitor. So just kind of know that. Okay? But that’s how the 

slideshow works. 

So let’s go ahead and do this. Let’s move over into the second section and I want to show you 

how to hide slides. 
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Video: Hiding Slides 

Cindy: Welcome back. We’re working in PowerPoint 2016 and this is module sixteen, Preparing 

Your Presentation for Delivery. 

Now we’ve already gone through in section one our slideshow and we talked about how to 

preview that presentation. Sometimes when you’re presenting a presentation you’ll want to have 

some slides that are hidden, meaning they don’t show up when you’re running through the 

slideshow. So some reasons for that might be what if you’re going to give your audience a test 

and maybe you have the answers on a slide that you want to show whenever you choose to and 

not necessarily in a particular order. There’s a lot of different reasons for hiding a slide. So let 

me show you how that whole process works. 

Let’s say in our example that slide two, I’m going to click on it. This is where we had that little 

video and let’s say that we want to save that video just in case our audience happens to get really 

bored with our presentation or I can tell they’re not paying attention. I could then just pop it up 

whenever I want to because it’s a funny little graphic and it’ll catch their attention. 

So here’s how it’s going to work.  

The slide that you want to hide you need to have it selected and under the Slideshow tab you’re 

going to choose Hide Slide. Now you can see that slide is hidden because the two has a little 

cross through it or a little mark. And also that slide is gray. So what that means is that when I run 

through the slideshow it’s going to skip from slide one to three and it’s like two doesn’t even 

exist. So notice I clicked on slide one. I’m going to run the slideshow from the beginning. 

So I’m on slide one. I’ll come down here and click my arrow and it’ll take me to slide three. 

Now notice it didn’t change the number of slides I have. It’s just it went from one to three 

because two is hidden.  

So let me show you how to show that hidden slide.  

All I’m going to do is go to my slide sorter view again. I’m going to find slide two and double 

click on it and that will show that particular slide. So remember the audience doesn’t see your 

presenter view. So they never saw that you did that. So then if you decide you want to go back to 

slide one you can go back to slide sorter and back to slide one or whichever slide you wanted to 

go to.  

So that’s really all there is to it. You just hide your slide, go through your slideshow and then 

unhide it if you choose to using that slide sorter option. 

Okay I’m going to end the slideshow and that takes care of hiding slides. So why don’t we go to 

section three and talk very quickly about how to change the order of your slides. 
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Video: Changing the Order of Slides 

Cindy: Okay welcome back. We’re working in PowerPoint 2016. This is module sixteen where 

we’re talking about preparing a presentation for delivery. 

Now we’re in section three and we’re going to talk very quickly about how to change the order 

of your slides. It’s super simple to do so let me show you how to do it. 

Okay back in our presentation. Let’s say that we scroll down and work with slide nine. Now I’ve 

got a picture of a diploma here and I’d really like it to be the last slide in my presentation. So 

what I’m going to do is I’m going to right click and I’m going to cut it out and I’m just going to 

slide all the way down where I’d like to put it and I’m going to make sure I have this little line 

that you see here. And I’m going to right click and paste it in. And I’ll just use the very first 

paste to paste. And there it is. So super simple. 

Now let’s do this. Let’s say that I wanted to change the order of slides fourteen and fifteen. Well 

I really don’t want to spend the time to cut and paste so I’m just going to drag. So I’m going to 

take slide fourteen and click on it and just drag it underneath slide fifteen like this and drop it off. 

See how easy that is?  

Now one more way I could have done this. If I’m working in slide sorter view at the bottom here 

where I’m seeing all of my slides then I can go ahead and take a particular slide that I like to 

move and just drag it wherever I’d like it to be. So it works the same way. It’s just I’m going to 

drag that particular slide.  

So super simple to change the order of the slides. That’s all you have to do. 

So let’s go ahead and look at copying slides over in section four. 
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Video: Copying Slides 

Cindy: Okay welcome back. This is Cindy again. We are still working in PowerPoint 2016. 

We’re working in module sixteen, Preparing a Presentation for Delivery. 

Now we’re down to section four where I want to show you how to copy a slide because again it’s 

super easy to copy slides. 

So let’s say that slide one, I’d like to make a copy of that slide because I’d also like it to be my 

ending slide as well. 

So what I’m going to do is I’m going to right click on slide one over on the left and I’m going to 

copy and I’m going to go all the way down to the bottom here. I’m going to click where I want it 

and right click and paste it in. It’s that simple. 

Now let me flip to slide sorter view for a moment and just talk to you a little bit about copying 

slides in this view. Now I’m going to delete slide nineteen, that one I just copied.  

So let’s say again that I want to copy slide one. The little trick for copy is hold down the Control 

key when you drag the slide. So if I hold Control the whole time and I just drag the slide I’m 

going to drag it to the very end and let go of the mouse first. And when I let go I’ve got an exact 

copy. If you let go of Control first you end up moving it. So be careful with that. But now slide 

one and my ending slide are the same exact slide. 

So I told you it was super simple to copy a slide and there it is. 

So let’s go ahead and go into section five and talk about some of the different options you have 

when you’re actually on the screen giving your presentation. 
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Video: Slideshow Options 

Cindy: Hey. Welcome back. This is Cindy again. We are still working in PowerPoint 2016. 

We’re talking here in module sixteen about preparing a presentation for delivery.  

Now this is section five where I want to show you some of the slideshow options. These are 

going to be things that you can do while you’re actually presenting your presentation just to keep 

your readers attention and to point out certain things you might be talking about. So let’s get 

started. 

Okay so we’re back in our presentation and what we need to do now is run our slideshow. So I’m 

going to click on Slideshow tab and I’m going to choose From the beginning. Now remember 

I’ve been launched into the presenter view right now. And we’ve talked about these options right 

down here but I want to talk real quick a little bit more about the pen and laser pointer tools.  

When you click on that you have the option to change your mouse to any one of these options 

here. So starting with a laser point. It looks just like if you had a laser pointer in your hand and 

you wanted to point to something.  

I can also change my mouse to a pen. Now the pen option will allow me to circle something if I 

like, maybe put a checkmark next to something, maybe write something, whatever I’d like to do.  

I can also change my mouse to a highlighter. And this would be just like if you had a yellow 

highlighter on your desk and you want to actually highlight something with that you could. 

Now I’ve got all this scribble on my screen and I could keep it but let’s say that I want to 

actually erase some of this. There is an eraser here that you can click on. And you drag across 

whatever you’d like to erase and it will be gone.  

Now if I go back down I can turn my mouse back to an arrow by choosing the arrow options and 

I can make it automatic.  

Now before we leave this option I could have chosen to change the ink color and that would be 

for any of these. So if I wanted to change the ink color to green, for example, then if I wanted to 

circle something or put a checkmark or write something it would be in green. So just know that 

you do have the ability to change your ink annotations as they’re called if you like. You also can 

erase all the ink on your slide by hitting this right here. So I’m going to go ahead and erase them 

all for now. 

Now I want to go ahead and launch the slideshow. So I’m going to go up to the Display Settings 

and I’m going to swap my presenter view and the slideshow view so you can see these. 

Now I’m going to show you some options you can do as far as using the pen, blacking out the 

screen whiting out the screen, things like that, while you’re running your slideshow. Now before 
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I that let me just you where you can find all of these options if you want to find them for 

yourself.  

If you’re running the slideshow and this is the only time this will work. If you’re running the 

slideshow you can hit F1 on your keyboard and you’ll pull up Slideshow Help. So I’m going to 

go through these and show you how some of these work because they’re quick, easy ways to 

grab your audience’s attention and keep them paying attention to you. 

So first thing is let’s say that you’re running through your presentation and you want to black out 

the screen or white out the screen. You can hit B for black and nice any key on your keyboard to 

come back. Or W for white. Either one and as soon as you hit any key on the keyboard you’ll be 

back where you started. 

Now the next thing is we talked about all those pen options. I could go to the bottom of my 

screen down here and you can see where I’m pointing. Here’s those same pen options we had 

seen earlier. But let’s say I don’t want to use that. I really just want to go through my 

presentation and turn the mouse into a pen or a laser automatically. So Control-L turns your 

moue to the laser pointer like we talked about earlier. That’s Control and the letter L. Any time 

you want to turn the mouse back to an arrow hold Control and hit the letter A. Control-A stands 

for arrow. Now let’s say I wanted to turn my mouse into a pen. Control-P will turn that mouse 

into a pen. So if you wanted to circle something you could. And remember if you want to erase it 

Control and the letter E for erase will turn your mouse to an eraser. Now the highlighter that’s 

going to be Control and the letter I. So Control-I is going to turn your mouse to a highlighter.  

Now we haven’t yet talked about printing our slides. We’ll do that a little bit later but if you’re 

running through your slideshow and you know you want to go to slide nine, for example, all you 

have to do is hit nine on your keyboard and hit the Enter key and you’ll go to slide nine. To go 

back to slide one you would hit one and the Enter key and you’ll be back on slide one. 

Now if you knew the next slide was a hidden slide and you want to pull it up you can always hit 

H for hidden or you can hit two and Enter because you know it’s slide two. And again to go back 

to number one you would hit one and Enter. 

Now there’s also going to be some options for running through your timings and things like that. 

So if you hit F1 again I’ll show those to you. Rehearsing and recording. We’re going to be doing 

that shortly in the next module but I just wanted to show you that there are some options for 

turning on your time here, just hitting T on the keyboard will let you use new timings. You can 

see these options here.  

Also for the media. If you had a video you wanted to play automatically or if you wanted to stop 

it, things like that. Here’s your Alt-P to play or pause your media. Alt-Q is going to do the stop, 

playback. And you can go to the next previous bookmarks and things like that by just using these 

options here.  
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We did go through the ink/laser pointer options. So there are those. And then now if you have a 

touchscreen you can actually use these options to swipe forward or to swipe backwards or to 

pinch just like you’re familiar with on your smartphone or on your tablet.  

So I just wanted you to know that you can do some of those things while you’re running through 

your slideshow. Remember F1 will launch you into the options so you can see what they are. 

And then that’s how that’s going to work. 

So we’re going to go ahead and wrap this up and let’s go ahead and do the exercise for module 

sixteen and just make sure you’re comfortable with going ahead and presenting your 

presentation. I’ll see you shortly. 
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Video: Exercise 15 

Cindy: Hey there. We’ve made it all the way down to the exercise for module sixteen. Now we 

didn’t do anything really hard in this particular module. We just did some basic things like we 

talked about how to move the slides, how to rearrange them, how to do some things when you’re 

actually running through the slideshow like make ink annotations or if you need to hide a slide, 

things like that. So let me tell you what I want you to do here just to make sure you’re good. 

We’re going to start off by opening a file called Practice Module 16. And then I want you to run 

this slideshow and just kind of view it and see what it looks like currently. When you get through 

looking at it go ahead and hide slide two for me. And then run the slideshow again and notice 

that slide two is actually hidden. And then you can go back and show slide two again.  

I’m going to have you rearrange some slides. So remember to do that you need to get out of the 

slideshow. Just hit Escape to get out of it or go all the way to the end and it’ll take you out of it. 

But go ahead and rearrange slides ten and eleven and maybe if you want to practice a few more 

that’s good too. 

Make a copy of slide one and put it at the end of your presentation. Remember you’ll want to do 

that so that you know what the last slide is when you’re going through and actually presenting 

your presentation.  

Run the slideshow one more time. Use some of those keyboard shortcuts we talked about to 

change your mouse to a pen, for example, so you can add those ink annotations. Or if you want 

to use the laser pointer or the highlighter.  

Once you go through and play with that then you can go ahead and get out of your slideshow and 

save and close the file for me. And then that’s all you need to how to do for this particular 

module. 

Awesome. So you are good to go. Go ahead and do all of that and then I will see you over in the 

next module. 
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Chapter 17 – Preparing a Presentation for Delivery 

Video: Rehearse Timings 

Cindy: Okay so we’ve made it down to module seventeen. Welcome back. This is Cindy again 

and we’re working in PowerPoint 2016. And in this particular module we’re going talk about 

working with some of the slideshow options that PowerPoint has. 

Now we’re in section one where we’re going to talk in this section about recording or rehearsing 

your timings. Now you want to go ahead and see how long it will take you to actually go through 

your presentation once you’ve completed it. Some reasons for doing that would be what if 

you’ve been given twenty minutes to talk about your particular subject? If you talk for an hour 

they’re either going to cut you off or someone’s going to be kind of made at you for taking up so 

much time. The flipside could also be true. What if you only talk for five minutes when you’ve 

been allotted twenty? Then you open yourself up for questions you may not be prepared to 

answer. Or it may be way too much time and people are finding things to talk about. So you want 

to get right in there and get your timing to be just right so that you’re not going to have any of 

those situations happen. So let me show you how to go ahead and rehearse those timings. 

Okay so what we’re going to do is we’re going to go ahead and click on the Slideshow tab and 

here you’re going to see Rehearse timings. Now before we click on that I just want to show you 

one quick thing. 

Since we’ve been running through our presentation we’ve had this Use Presenter View option 

on. And remember when we’d actually go and tell it to run the slideshow from the beginning it 

starts in the presenter view. We could have taken that off. But I wanted to show you this monitor 

option up here as well. 

If you’re working on a dual monitor system like I am then you can tell it that you want your 

primary monitor to be the one that shows up automatically when you launch the slideshow. So 

I’m going to change that. Now watch what happens when I hit Rehearse Timings. It actually 

launches you into the slideshow. 

Now if you notice in the top left there’s a recorder that’s going on and it’s recording exactly how 

long it takes per slide to go through the presentation. So I’ll start it but I’m not going to talk 

about every slide here.  

Welcome new students. Let me give you a quick overview of campus life. Why choose us? We 

have a beautiful campus, we have experienced professors and low cost for attendance. 

Now I’m just going to click through the rest of the slides but you get the idea. You would 

actually talk as if you were recording your presentation. Now when I get all the way to the end 

what you’re going to see is that it’s going to tell me the total that it took for me to go through the 
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entire presentation. See how it says the total time was 48 seconds? And it asks me do I want to 

save the new slide timings? Now here’s why you would or would not want to save them. 

It took me 48 seconds and I had twenty minutes for this presentation so obviously I have a lot 

more content to put in this presentation. So I would not want to save my timings. What if I see 

that I’m very close here but there might be a slide or two I want to change some of the timings 

on? I’ll show you how to change those on individual slides. So that might be an instance for 

saving this.  

Now if you do keep your timings then you’re going to be able to launch the slideshow and sit 

back and watch it run all by itself. Now that’s perfect for a situation like if you’re visiting a 

tradeshow, for example, and you have your laptop sitting there and you want it to run through the 

presentation. That’s perfect. It’ll run all by itself. But it’s not so perfect if you’re actually 

presenting at a presentation where people will be asking questions because then the presentation 

will get ahead of you. So there’s different reasons for leaving the timings on or off. I’m just 

going to say yes for now so you can see this. 

Now I want to show you how to see the timings that are on each slide. So I’m going to go down 

to the slide sorter view at the bottom and click on it and now you’ll notice that underneath each 

slide it tells you how long it took to run through that particular slide. So you can see this first one 

took 22 seconds, this one was hidden, 9 seconds, and so on and so forth.  

Now if you’re looking through here and you say you know 22 seconds is really too long for that 

first slide you can change the timings on each individual slide.  

So the way you’re going to do that is you’re going to the Transitions tab and remember this is 

where we applied all those transitions and we talked about sound and we mentioned the timings. 

So over here is where I can manually adjust the timing. So I can move this down to let’s just say 

seven seconds for now. And you’ll want to uncheck this so that it will run automatically. Now 

that I’ve done that I can click on the first slide and I’m going to run my slideshow.  

So I’m going to go back to the Slideshow tab and choose From the beginning. Now the 

slideshow is going to run all by itself. Now when you’re waiting on that first slide it seems like 

seven seconds is a long time but you can see it’s running by itself. I am not clicking the mouse at 

all. So this is a good way to see if you’re right in your timings there. 

Now I’m just going to go ahead and let it finish here since it’s pretty quick and then we’re going 

to get out of this because I want to show you a little bit more about how to actually record your 

presentation if you’ve decided that the timings are perfect. 

So let’s go ahead and go to section two because I want to show you how to record a presentation. 
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Video: Recording a Presentation 

Cindy: Hey there. Welcome back. This is Cindy again. We are in PowerPoint 2016 and we’ve 

made our way down to module seventeen, Working with the Slideshow. 

Now we’ve already talked a little bit about rehearsing our timings so let me just talk very quickly 

about some of the options when you’re recording a presentation. 

To record your slideshow you’re going to click on the Slideshow tab and notice here’s the 

Rehearse Timings. Now we rehearsed our timings in the first section here and the reason we 

wanted to do that was because we wanted to make sure we had our talking points in. We wanted 

to make sure we had enough timing setup per slide. We decided also that since it told us how 

much time it would take per slide that we could choose to keep those timings or not. That was 

totally up to us. So even if you don’t keep the timings you can still go through and record the 

slideshow so that you can actually send this to others if you want. 

So I’m going to go ahead and click on Record Slideshow and notice I can start recording from 

the beginning or from the current slide. I’m going to click on From beginning.  

Now it will ask me if I’d like to record the animation, timings, the ink, the narration, the laser 

pointer, all of that stuff that I added. So if I didn’t want one of these I could uncheck it. But I’m 

going to start recording. 

Now notice that it is recording my time up here so I’m going to go ahead and click all the way to 

the end. Normally you would take the time you needed to go through each slide. So it’s going to 

tell me up in the little recording at the top when I’m finished how long it took but it’s not going 

to stop at the very end and actually say exactly how long it took. That’s what it does when you’re 

rehearsing. So here what you’re going to see is when it’s finished it goes right back to this screen 

here. That’s why it’s a good idea to have a slide at the very end so you know it’s the last slide. 

Sometimes people have a slide that’ll say Questions or they might reiterate the first slide. 

However you want to do it that’s certainly okay. But it’s just recorded my timings now.  

When I go back to Record Slideshow now notice that I can clear the timings on the current slide 

or all the slides. I can also clear any narration that I might have on all the slides.  

So that’s how the recording is going to work here. It’s all there is to it.  

Now I want to take you over to the next section, section three, and show you a little bit about the 

slideshow settings that are available. 
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Video: Slideshow Settings 

Cindy: Hey there. Welcome back. We’re still in module seventeen, Working with the 

Slideshow. We’re all the way down to section three where I want to take just a couple minutes 

and show you some of the different slideshow settings that you have that will help enhance your 

presentation when you’re running through the slideshow. 

I’m going to click on the Slideshow tab and let’s talk about this right here. Let’s talk about 

setting up the slideshow.  

So first of all when I click on Setup Slideshow these are some advanced options you have. So if 

you wanted to actually switch your monitors or have it loop, things like that.  

So going down this list here. First of all yours is presented by a speaker, that’s full screen, but 

you can have it also browse by an individual window if you wanted. You can also have it browse 

at kiosk which is like a full screen view. So any of these are just different types that you can set 

up. Down here you can have it loop continuously until Escape. That means that once the 

slideshow reaches the end it’ll loop back to the beginning. Now obviously you would use that 

option if you had saved your timings. So a good example would be if you’re at the tradeshow 

and you have the laptop sitting on the desk, you want it to run by itself. You can show it with or 

without any narration you might have. And also if there’s any hardware graphics that you want 

to disable in there you can go ahead and do that.  

You might have noticed that when we used the pen and the laser they were red automatically. 

That’s because this option is chosen here. So you can actually change these to any color that 

you’d like it to automatically be.  

Over on the right if you’re going to let this run by itself then you may not want all the slides to 

run for whatever reason. Maybe you want to go from one to three and then have it look back 

around. You can specify here which slides you want it to actually show.  

You can also if you have a custom show you would see it here and you can click on the 

dropdown to get to it. 

Ours have timings on them right now but again you know you can manually run the slides. You 

know how to do that. And then down here if you’re working with multiple monitors then you can 

specify that one is the primary and then one is your secondary if you have more than one. 

That’s a little bit about the slideshow options there. So let me click OK. 

Now I also wanted to just mention a couple of other things. Over here where it says Monitor we 

just talked about the fact that you can have it automatically use one of your monitors as the 

primary and one as the secondary. But you could also do it here per presentation if you wanted 

to. So just kind of know that as well. 
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And then we talked a little bit about the presenter view as we went through there. So these are all 

your slideshow options right here that you may want to change. 

So I want to go ahead and go over into section four and show you how to create a custom 

slideshow. 
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Video: Creating a Custom Slideshow 

Cindy: Hey there. Welcome back. It’s Cindy again. We are in module seventeen, Working with 

the Slideshow. And we’re all the way down to section four where I want to talk to you briefly 

about creating a custom slideshow. 

Let me go ahead and flip over to our exercise and I’ll show you a little bit about what a custom 

show is. 

When you’re presenting to an audience it’s always a good idea to know who is in the audience 

because depending on who’s in the audience that might mean that you show certain slides or not 

show certain slides. For example, in this exercise here if I’m presenting to potential students I 

may not want them to actually see all the information about the board of directors because they 

really don’t care. The same might be true for the board of directors. They may not really need to 

see some of the other slides in this presentation. Instead of actually saving several different 

versions of this presentation I can have this one presentation saved and create a custom show 

where I show certain slides.  

So I’m going to click on Custom Slideshow and Custom Shows. Now I don’t currently have any 

so I’ll click on New. And I’m going to give my show a name. I’m going to call this first one 

Students.  

Now this is a listing of all the slides that are in my presentation currently and all I’m going to do 

is check off the ones that I do want to put in this particular presentation. So you can see as I go 

down this list that I’m not going to choose certain slides. So let’s say I don’t choose the board of 

directors and maybe for whatever reason I don’t want to see student advisory board. So I’ll go 

ahead and just choose the rest of these. And then let’s go ahead and add. And now when I click 

OK these are the slides that will show in the presentation related to students. 

Now if I wanted to create another one I just click on New and I might call this one, I’ll just call it 

Board. Now in this one let’s say I just show a couple of slides. I’ll show all these and then let’s 

say I go down and show just the board of directors here and then a couple down at the bottom 

we’ll show and I’ll add those. So now you can see that when I click OK I have two different 

custom shows.  

Now if I wanted to actually edited any one of these I can choose that show and say Edit right 

here or I can remove one from this list. Notice I can copy one. But let’s go ahead and just show 

one. I’m going to click on the Board and show that one.  

Now when I run through here notice there’s only going to be a couple of slides. The ones that I 

did not check are not going to be on the list. So there you go. You see there were only about five 

slides there. So you can always create a custom show within your presentation. 
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Now this is going to wrap up module seventeen. So we’re going to go ahead and do the exercise 

real quick and get you out of here. 
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Video: Exercise 16 

Cindy: Okay welcome back. We are in module seventeen and this is the exercise. I know you’re 

glad to be through this module. So I want to make sure that you can do a couple of quick things.  

You need to know how to put the audio in and you need to know how to put in video. So let me 

tell you what I want you to do here. 

Go ahead and open the file for me called Practice Presentation 17. I want you to go through this 

presentation and rehearse the show for me, making sure you have all the talking points you need 

and you’ve got all the pictures in the right place, everything you need. Notice the timings as you 

go along because I want you to keep those timings when you’re done and then run the slideshow. 

And when you run the slideshow make sure not to click the mouse because it’s going to run all 

by itself if you keep those timings. 

Also when you get through I want you to go ahead and record the presentation. Then I want you 

to create two custom slideshows for me. Create one for the students and another for the board of 

directors. And if you know how to do all that you are good to go for everything we talked about 

in module seventeen. Go ahead and save and close that file for me and then awesome. You are 

on your way to being an expert here. 

So let’s go ahead and wrap this up and I’ll see you over in the next module. 
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Chapter 18 – Other PowerPoint Features 

Video: Exporting Options 

Cindy Hey. Welcome back. It’s Cindy again. We are in PowerPoint 2016 and we’re all the way 

down to module eighteen. So we’re almost done. But we’re going to talk in this module about 

some of the other features that PowerPoint has. So I wanted to go ahead and start in this first 

section which is the exporting options and talk to you about some of the different things you can 

export.  

It could be that you want to export your file into a Word document. That way if you wanted to 

expand on some of the topics you had in your presentation you could do that and it wouldn’t 

affect PowerPoint. It might be that you’d like to export this to a video. So let me show you some 

of the different ways you can export your presentation. 

What we’re going to do if we want to export this is we’re going to click on our File tab which 

takes us to the Backstage View and we’re going to come down to Export. 

Now there are several different ways I can export this file. I can start off by creating a PDF or an 

XPS document. And all an XPS document is is Microsoft’s version of a PDF file. That’s it. So 

all you would do is create the PDF and it works just like any other PDF file. You see it saves it 

automatically as a PDF. You give it a name and then that’s what you have and no one will be 

able to change it. 

Alright I’m going to go back to the File tab and back to Export. The next thing you can export is 

where it says Create a Video. If I wanted my presentation to be able to be uploaded to the web or 

maybe I’d like to actually burn it to a CD or a flash drive or something like that then I can 

actually go ahead and do that here. Now I have a couple of choices with the internet quality. I 

can save it as a presentation quality of 1920 x 1080 which is the largest file size and this is what 

most of the widescreen monitors today use. Notice I could also use the internet quality 

considered medium or the smallest file size that I’d like.  

Also when I’m saving this I can save it with or without the timings and the narrations that I 

might have setup in the file. All we did at that point is make sure that I have the timings that I 

want on each slide set correctly and create the video. And what’ll happen is when you create it 

it’s actually going to allow you to give it a name and you can save it. It’ll save it automatically as 

an MP4 file and you can just stick it on your desktop or wherever you’d like and then open it 

whenever you choose. 

Your next option down is Package Presentation for CD. Now just to tell you what this option is, 

there are a lot of people who don’t have PowerPoint that might still want to be able to watch this 

presentation. So what this lets you do is pack up your presentation, put it on a CD or a flash drive 

and then someone else can watch it. If you have any linked or embedded files, maybe any videos, 
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things like that those are automatically going to be packaged up. So that’s how you create a 

package presentation for a CD. 

Now here’s where you export handouts and I want to show you a couple of these. I’m going to 

click on Create Handouts. When you create handouts you can actually send these over to 

Microsoft Word. When you do this you have several different formats you can choose from. You 

can send it over where there’s two slides and any notes next to each one. There’s two slides and 

then blank lines, one and one, and then the outline.  

So let me just show you real quick, I’ll do the blank lines next to slides and just show you this 

one real quick. So it’s going to open Microsoft Word. It’s going to send the slides over there. 

There will be two on a page and to the right will be blank lines so that you can actually write 

index to each slide. So you can see it’s actually putting it in a table format. There’s my slide and 

there’s my blank lines to the right of it. And there’s my next one and so on and so forth. 

Now I’m not going to wait for it to put all of these in here so I’ll go ahead and close this. 

Now I do want to show you the other one. If I go back to File and go back to my Export, let me 

go back to Create Handouts very quickly and show you the outline only. And the outline only 

looks like an outline. So since it’s now in Microsoft Word if I wanted to expand on any of these 

topics I could type anything I want here and it does not affect PowerPoint. So it’s really great 

when you’re wanting to give your audience an extra note on one of your slides. 

Just a little FYI. You have the ability in Microsoft Word to do the same thing, to send this over 

to PowerPoint. So the trick with this though is based on the style that you’ve used that’s how it’s 

going to know whether you have a heading or if you have bulleted items, those types of things. 

So you really kind of have to set it up correctly to begin with. But if you didn’t have your 

PowerPoint presentation at all you could actually send this over and it would create it for you. 

So let me go ahead and close that and I’m not going to save it.  

And one more option when you go to Export you had Change File Type. So if you wanted to 

change it to an Office 97 through 2003 type or maybe to a template or a PowerPoint show as it’s 

called then you have the ability to save it as one of these types and then you can hit the Save As 

and it’ll save it for you. 

So those are your options when it comes to exporting. 

I’m going to go ahead and go back to my presentation and then that’s going to wrap up section 

one. 

So what I want to do now is take you over to section two and show you how to work with the 

Backstage View and some of the customization options that PowerPoint has. I’ll see you shortly. 
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Video: Working with the Backstage View and Customization Options 

Cindy: Alright welcome back. This is Cindy again. We are in module eighteen of PowerPoint 

2016 and we’re just looking at these other features that PowerPoint has. We’re in section two 

now where I’m going to show you the Backstage View and also some customization options you 

may want to change. 

So when you’re looking at your file in PowerPoint if you decided you’d like to create a new file 

you might think that you have to close this one and then go create a new one or open as the same 

thing. Well you don’t have to really do that anymore because all of the Microsoft Office products 

have built in something called the Backstage View. Here’s how you get to the Backstage View. 

You’re going to click on the File tab. So you’ve seen this throughout these series of videos. 

We’ve clicked on this several different times. But I want to show you what kind of information 

you can get from the Backstage View.  

Now I’m under the Info option to begin with and this is all of the information about the file I 

happen to be clicked on. So you’re going to be able to see things over here like the size of the 

file, how many slides are in the file, if there’s any hidden ones. You can see how many notes, 

comments. You’re going to be able to see which theme was used. If it’s in widescreen format. So 

all the different things about this file. When it was created, who the owner is, the manager, those 

types of things. Also if you have any links in this file you can edit them right from here. So 

you’ve got all kinds of information you can see right from here if you’re under the Info option. 

Now a lot of these you’re familiar with already like your New and your Open. One thing I want 

to show you real quick. If you’re under Open, for example, remember that when Office 2013 

came out you now have this new extra screen. So in previous versions to Office 13 it would 

actually take you right into a blank presentation. Well now you can go into this one. But if you 

don’t want to show that then I’ll show you how to turn it off here in a second. 

So you’re familiar with Save and Save As, your Print. Share is going to allow you to share this 

with other users that might be on a SharePoint server. You might also want to share this through 

email. You might want to also go and present this online. We kind of talked a little bit about that 

before. You can save it to the Cloud if you have a OneDrive location. We talked about Export.  

So let me just mention the Options. So here are your Options. And you have these in all of the 

Office products but these are specific to PowerPoint. Going down the list several different things 

that you’re probably already familiar with. Showing the mini toolbar on selection. That means 

when you select something a little toolbar shows up right above your selection. The live preview. 

A good example is when you choose a font and you can see what the fonts going to look like.  
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But I really want to show you this one right here. Show the startup screen when this application 

starts. That’s why when you click on Open you get that extra screen that you didn’t always have 

before. So that’s how you would turn it off. 

Also going down the list I want to talk to you about customizing the ribbon. So we’re going to 

talk about that over in the next little section. 

And then you have your Quick Access Toolbar, your Add-ins and your Trust Center. So go back 

and go through these and just see if there’s any options there that you might want to change to 

work with your PowerPoint a little bit easier. 

So I’m just going to click OK right here and get out of that. And then let’s go talk a little bit 

about customizing your ribbon. I’ll see you over in section three. 
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Video: Customizing the Ribbon 

Cindy: Okay welcome back. We’re in module eighteen and we’re talking about the other 

features that PowerPoint has. We’re down to section three now where I want to talk to you about 

customizing the ribbon. There are options that you might want to put on the ribbon that aren’t 

currently there and you can go in and actually add those and also create new tabs if you want that 

can hold individual buttons. So let me show you how that works.  

I’m going to click on the File tab and I’m going to go down to the Options. In the Options 

window on the left I’m going to click on Customize Ribbon and here’s where you can actually 

pick buttons or you can work with the tabs if you like over on the right. 

So let’s start with the tabs over on the right. Let me just show you the correlation and then I’ll 

show you how to add one. 

So if you notice the tabs are the main ones here that you see. Home, Insert, Draw, Design. Just 

like up here. Home, Insert, Design, and so forth. If I click the plus sign next to a tab then I’m 

going to see the groupings that are on that tab. If I click the plus sign next to a grouping I’ll see 

the buttons on that grouping that are on that tab. I’d like to actually add a tab. 

Let’s say that you would like to add a tab for bulleted options. And on there you’d like to add 

some buttons that allow you to promote and demote. So I’m just going to come down to the 

bottom and click on the last one and I’m going to choose New Tab.  

So notice it names it New Tab and also the group is called New Group. I’m going to click on the 

new tab and choose Rename. Now I’m going to call this one Bullets and I’ll just click OK and 

there you go. Now if I wanted to name the group as well I could rename that grouping to 

anything I wanted. I could also pick a picture here if I’d like. So any of these pictures can 

represent my bullets. Alright? Let met change that there. Okay.  

So now we have a new tab and a new grouping on that tab. Now that I have that then I can talk 

about adding some buttons to my new tab. The buttons are over on the left here and you’ll notice 

I’m looking at the category called Popular Commands. If I choose the down arrow I can also 

pick Commands not on the ribbon. Before I do that just notice the other options. I can look at all 

the commands, I can look at what they call the macros, just all kinds of things here. So I’m going 

to choose Commands not on the ribbon. Now I’m going to go down the list and I’m looking for 

promote and demote. So let’s see if I can find demote first. And so what you’re going to notice is 

that, let’s see where it is, there it is right there. And I’m going to click on Add. Notice I’m 

clicked on the group I wanted to add it on. Now let me go find promote real quick. Go see the 

same thing it’s going to happen. Arrow pointing the other way on this one. So you can see that 

here’s promote and I’m going to add that one as well.  

Now let me go ahead and click OK and show you what it looks like.  
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So here’s my new tab bullets. Now notice I have a group called promote and demote and I’ve got 

two new buttons for promote and demote. So let’s see if they work.  

I’m going to go to slide three and let’s say that I want to demote my second bullet here. I’m just 

going to click there and choose demote. Perfect. Now let’s say I want to promote it again. I’m 

going to hit promote and there you go. It works fine. So you can always add any buttons you’d 

like. You can create a tab and a group to put those buttons on.  

That’s pretty much how customizing the ribbon works. You can go through and customize it any 

way you like. 

So now that we’ve finished this part let’s go ahead and go over to the next little part which is 

going to be section four and let’s talk about printing this presentation. 
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Video: Printing a Presentation 

Cindy: Welcome back. We’re working in module eighteen of PowerPoint 2016 which is where 

we’re talking about the other PowerPoint features. Now we’re down in section four where we’re 

going to talk about printing a presentation. 

Now there’s a couple of things you might want to print. What if you want to print an outline of 

your presentation so that you know what to say when you’re talking about a specific slide or a 

particular topic? It could be that you want to print handouts for your audience so that they know 

where you are at any given time and they have something to touch. People like to touch 

something when they’re in a presentation. So lots of different ways you can actually print. So let 

me show you how the printing option works. 

What you’re going to do is you’re going to click on your File tab and you’re going to go down to 

the Print option. Now the first thing you’ll notice is that you see a copy of your slide and if you 

wanted to go through each individual slide notice at the bottom of your screen you can click the 

right or left arrows to go to the next or previous page and preview your presentation.  

Now let’s go from the bottom up and just look at our options here.  

First of all we have an option to edit the header and footer. I can include on my slide the date and 

time if I’d like. If I choose that option I can have it update automatically or have a fixed date. 

Update automatically means that whenever you open the file it’s going to have that date. Fixed is 

whatever date you type in there.  

I can choose to put the slide number on my slides if I’d like and also if I wanted to add a footer I 

could put some text in here and that would be at the bottom of each of my slides.  

Now if you see this little checkbox here, Don’t show on title slide, that will allow you to not 

have your footer show up on your title slide or a header if you had that in here. Now in this case 

we only have one title slide, that’s slide number one, but it would really refer to any title layout. 

So just remember that.  

I also have the same options for notes and handouts if I’d like. Then I would apply to all and I 

would save my choices.  

The next option you’re going to see is the color option. If you currently print your slides and you 

don’t change this you’re going to see every slide printed in color and that takes a lot of ink. So if 

you’re going to print handouts then go ahead and print them in gray scale or pure black and 

white. Gray scale will give you shades of gray and pure black and white is pure black and pure 

white. 

The collated option is next and this is going to allow it to sort the copies when it prints. And you 

can tell it you’d like to collate or have it uncollated.  
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Also you’re going to print on one side currently. Some new options you have now is to print on 

both sides. Now if you do this you can choose to flip the pages on the long edge or the short 

edge. I will say that if you choose the print one sided option that you can still print on the front 

and back of the paper but that’s more of a printer option at that point.  

Full page slides. That means I’m going to print one slide on one piece of paper. I can choose to 

print the notes pages which looks like this. There’s the slide at the top and any notes down at the 

bottom.  

I might also choose the outline view that I mentioned a few moments ago and you can see this is 

your presentation in an outline format. These ones that don’t have anything next to them, those 

are slides that did not have a title. Those are the ones we actually just had some graphics on. 

I can also choose to print handouts. If I choose to print handouts I can specify how many slides 

I’d like to see on a page, two, three, you can see it goes all the way up to nine. Six is a very 

common option. Also, four is a very common option as well but you can choose any of these that 

you like. 

Right now I’m going to print all the slides in the entire presentation. If I wanted to print specific 

slides, let’s say one and three, I would type 1, 3 like that. If I was going to print one, two and 

three I would type 1-3 like this and that way I’ve got slides one, two and three.  

Now also if I take that out I have the option to print just a selection. So if I’m on a particular 

slide and there’s something I want to print I can choose to print just that. I can also print just the 

current slide if I want. And then the range is what we were just typing a few moments ago where 

we said 1, 3.  

Here’s the printer you’d like to print to. And if you only have one printer in your office you don’t 

have to worry about changing this but some people have multiple printers. 

Here’s how many copies I’d like. And once I’ve chosen all of my options here then I can choose 

the print.  

So pretty easy to print and that’s pretty standard across the board in all the Office products. 

So I’m going to go ahead and hit my back option and that’s pretty much how printing works. 

So this is going to wrap up module eighteen. I do have a quick exercise I want you to do over in 

section five. So why don’t you go ahead and go over to the exercise now and I will meet you 

there. 
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Video: Exercise 17 

Cindy: Alright. We are on the last exercise for the last module. I know you are glad. 

So we did a couple quick things in this particular module like printing, for example. We also 

talked a little bit about customizing the ribbon. And we also talked a little bit about some of 

those exporting options, if you wanted to export some of this presentation to Microsoft Word. So 

let’s see how much of this you can remember. So let me show you what I’m going to have you 

do here. 

Okay. So go ahead and open the last practice file called Practice Presentation 18. 

The first thing I’m going to have you do is export your presentation to Microsoft Word. Go 

ahead and choose the option Blank lines next to slides and when you get done I think you can go 

ahead and close Microsoft Word. You don’t need to save it unless you really want to for some 

reason. 

The next thing you’re going to do is customize the ribbon. First you’re going to create a new tab 

and you’re going to call that tab My Tab. Then look for buttons you would like to add from the 

popular commands list and add them to the new tab you just created. 

Once you’re done with that print the presentation. Choose the option to print all the slides and go 

ahead and print six slides horizontal on a page. Once you’ve done that go ahead and save the file 

and then that is it. You are done and you are now a PowerPoint expert. Yay! 

So I’ve got one more quick thing I just want to say to you before we wrap this up. So if you’ll go 

ahead and move over to module nineteen and watch the quick conclusion then we will be done 

with PowerPoint. Remember if you have any questions or anything you need any help with just 

let us know. We’re always there to help. Thanks a bunch. 
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Chapter 19 - Conclusion 

Video: Conclusion 

Cindy: Okay. Hey there. This is Cindy and this is the last module in this PowerPoint 2016 

training. So I just wanted to take a few moments and kind of wrap things up and tell you thank 

you so much for spending your time with me going through PowerPoint. You know at this point 

you ought to be able to create a blank presentation, you ought to be able to put in pictures and 

backgrounds and just anything you can think of related to PowerPoint. Use your imagination 

because that’s what’s going to make it really unique. So again I just want to say thank you and 

hopefully I’ll see you in some of the other training videos that we’ve got. If you need anything 

make sure you ask because we’re always here to help. 

Thanks a bunch. See you later. 
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